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1 Introduction 

With the Project module for CAS genesisWorld, all data, planning and activities are clearly 

structured in your project from acquisition to completion. 

When an opportunity yields an order, you transfer it into a project with a single click. The 

product items will appear in the project's order view. With the Easy Invoice module, you 

also create receipts for items here such as quotes, confirmations of order and invoices. 

In the tree view and interactive Gantt chart, you design your project in a flexible job 

hierarchy. With Project, milestones, predecessors/successors of jobs, resources and 

working time, as well as risks and goals are also available here. 

With the integrated resource planning, time records, expenses and external services, 

you plan and enter costs and turnover for addresses, projects and jobs. 

Reports keep you updated constantly about the status of your projects and jobs. 

You can exchange project plans with Microsoft Project and Open Workbench. 

Templates for projects and jobs as well as automatic workflows support the unified 

application and refinement of project management methods. 

For scheduling, you also have access to team planning views in the Desktop Client and 

Web Client as well as the timeline view and board view in the Web Client. 

1.1 Feature Overview 

 Order processing which may be combined with Easy Invoice for creating receipts 

 E-mail templates with attachments for company contacts and individual contacts 

 Project planning in the tree view with integrated Gantt visualization, project phases, 

milestones, predecessor/successor dependencies and resource planning 

 Exchange of structure, schedule and resource plans with Microsoft Project or Open 

Workbench 

 Control workflows with process templates and extend them when the status changes. 

 Time record with hourly rates by user and activity (Type) 

 Record of per diem costs, trip expenses, expense lump-sums and expense receipts 

 Reports for time records, expenses, external services and resource plans 

 Team planning views (Desktop Client and Web Client), timeline view (Web Client) and 

board view (Web Client) 

 Web Client integration; please note that features described in this manual are available 

in the Desktop Client only unless indicated otherwise. 
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1.2 Specifics with modules and integrations 

When using Project, you have to consider certain specific characteristics in combination 

with other modules and integrations. 

The most important features and limitations are described where they apply in this user 

guide, especially specifics when using CAS genesisWorld Web. 

For an overview, see the Project page under Working with several modules on the 

English version of hilfe.cas.de. 

1.3 Note on receipt items 

If you are using Project with Easy Invoice, various features for receipt items are available. 

Please note that if you have already been using CAS genesisWorld for some time, receipt 

items may still be called "document items" in your database. 

https://hilfe.cas.de/CgW/en/Mehrere_Module_einsetzen/index.htm#mme_project_und_andere.htm
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2 Quote and order 

The following sections describe the features for transferring items from opportunities to 

projects as well as the features for project items. 

 2.1 Creating a project for an opportunity (page 9) 

 2.2 Adding other opportunities to the project (page 11) 

 2.3 Order tab and project items (page 14) 

 2.4 Creating documents for items (page 33) 

 2.5 Products, prices and discounts (page 35) 

2.1 Creating a project for an opportunity 

When an opportunity yields an order, you create a project for it. 

This feature requires the Insert right for the Items data record type. 

 Click on the Create project button in the opportunity's Product items tab. 

 

First, the selection of project templates will open. Select the desired template or click 

Continue without a template to create the project without a template (see chapter "6 

Using project and job templates" on page 77).  

The opportunity will be closed and a new project will be created. 
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The project will adopt the opportunity's Subject. The Person responsible for the 

opportunity will be transferred to the project's Responsible (comm.) field, which is 

displayed in the Details tab. These field values will also be adopted from the opportunity 

when a project template is used. 

The opportunity's customer will be adopted as the project's primary address. 

The customer and project will also be entered as the opportunity's primary links. This way 

it will appear in the associated tree views. 

The items adopted from the opportunity will be listed in the project's Order tab. 

The current date will automatically be entered as the date of the new order items. 
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2.2 Adding other opportunities to the project 

In the project phase, you create other opportunities resulting from the project directly for 

that project. 

Like the initial conversion of an opportunity into a project, this feature requires the Insert 

right for the Items data record type. 

Opportunities you create for a project via the Action menu will receive primary links to the 

customer and project. These links will be displayed in the opportunity's General tab under 

Parent. The primary links effectively display the opportunity, in addition to the customer's  

and project's Dossier, in the respective Tree views, accessible via the Tree tabs. 

 

If the opportunity's Parent field doesn't display the desired primary link, you can enter it 

via the associated buttons. 

You can adopt to the project the items of any opportunity with a primary link to that 

project. 

 To do this, click on the Adopt to project button in the opportunity's Product items 

tab. 
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The project will be opened. All items of the opportunity will be added to the items that 

already exist in the project. 

The current date will be entered as date of the new items. 

The Order tab will display any items transferred so far. 
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Note 

When you click on the Adopt to project button in the opportunity, all of the 

opportunity's items will always be added to the project, whether they have already been 

adopted previously or not. The opportunity's items will not be matched against the 

project's items before adopting them. 

For example, the Adopt to project feature will also be available in the first opportunity 

once you have created a project for it. 

Now if you add items to the opportunity and then click Adopt to project, in addition to 

the new items, the items that have already been adopted will be transferred anew. 

We therefore suggest that you create a new opportunity for the project for each follow-

up order, as described above. 
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2.3 Order tab and project items 

In the Order tab of the data record window for projects, you can see and edit the list of 

quote or order items. 

 

With Project, quote and order items are available in CAS genesisWorld as a new data 

record type. The following sections describe views and features for items, the associated 

data record window as well as the associated features in the project's Order tab: 

 2.3.1 Views and features for items (page 15) 

 2.3.2 The data record window for items (page 16) 

 2.3.3 Working with items in the Order tab (page 23) 

 2.3.4 Assigning orders (with Easy Invoice) (page 27) 

Notes 

The Order tab can be extended with Form Designer like the General and Details tabs. 

Fields and other control elements inserted with Form Designer will appear avove the 

item list. 

With the Easy Invoice module, features are available for assigning orders to projects and 

for matching order items with project items (see "2.3.4 Assigning orders (with Easy 

Invoice)" on page 27). 

This requires selecting one or more receipt types as order types in the Management 

Console, in the Easy Invoice area, under General (see "9.1.1 Receipt types for orders" 

on page 187).  
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2.3.1 Views and features for items 

The following standard features are available for items. 

 Data record window with General, Details, Tree, Change log and Dossier tabs 

 Currency 

System base currency or user's default currency (if assigned) by default 

The first project item defines the project currency, which can then no longer be 

changed for additional project items. 

The project currency may be converted via the Tools menu of the project's data 

record window if this feature has been enabled in the Miscellaneous area of the 

Management Console under Products (see "9.2.4 Products" on page 192). 

 Primary links to address, project and job, displayed in the tree view and in analyses 

(with Report module) 

 General links to any other data records 

 Creation in the New menu, in the toolbar of data record windows and list views, in the 

tree view, in the Order tab of the data record window for projects as well as via project 

and job templates 

 Global search in all fields such as Description, Date and Product number. 

Configurable via Settings > Search; search toolbar abbreviation IT 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 
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2.3.2 The data record window for items 

The following sections describe fields and features of the data record window for items. 

General 

 

 Number of items and Interval between items: You can create multiple items at once 

at given intervals, for example to split a project into tranches. You specify the interval in 

days, weeks, months or years. Any further information is transferred to each of the new 

items. Once the items are created, you can edit each item in its own window. 

 Date: Enter the planned billing date here. When you create an item from a project, the 

current date is entered here. 

 Product number and Product: Select a product by entering a part of its Number in 

the Product number field or a part of its Subject in the Product field. Use the percent 

character "%" as a placeholder. Select the desired product from the list of suggestions. 

When you select a product, its Number (> Product number), Subject (>Product), 

Unit and Description will be adopted. The valid Price, Contribution margin, a granted 

Discount (if applicable) and the resulting Quoted price will also be entered. 
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Once a product has been entered, the quick search via the Product number and 

Product fields will no longer be available. However, you may change the product via 

the Search window by clicking on the magnifier icon. 

Note 

The quick search via the Product number and Product fields as well as the product 

selection via the Search window will only find products matching the associated filter. 

By default, these are all products for which the Active option has been selected in the 

General tab. You can change the associated filter condition in the Management Console 

under Miscellaneous > Products (see "9.2.4 Products" on page 192). 

 

Once you have selected a product, you may freely edit the product name in the item's 

Product field. Changes don't apply to the product itself but only to the item. 

If you are using the Easy Invoice module with the associated default print templates to  

create receipts like quotes, order confirmations or invoices for product items, the item 

will be listed in such receipts under this name. 

 Find product: Here you select a product in the Search window. If a product has 

already been entered, the Search window will open with this product as a search 

result in order to select it with one click. Alternatively, you select a different product 

in the Search window. 

When you enter a product via the Search window, the Number, Subject, Unit, 

Description (if empty or equal to the description of the previously entered product), 

Price, Contribution margin will be updated. If applicable, the Discount will also be 

updated along with the resulting Quoted price. 

 Open product: If a product was entered, you open it its data record window here. 

 Alternative description: When you select a product with alternative descriptions, these 

will be available for selection here in addition to the Standard description. 

Selecting an alternative Description will also enter the associated Quantity unit.  

 Alternative description preselection: The first item for a project will adopt the 

preselection entered for the current user in the Management Console, if applicable 

(see "9.5 Settings in the User Management area" on page 218). 

All additional items will adopt the selection made for the first item. 

 Description: When a product is entered, its Description will also be entered if the 

associated item field is empty or identical to the description of the previous product. 

Alternative descriptions will be entered when selected (see "Alternative description" 

on page 17). 
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 Quantity / Unit: Here you enter the quantity and unit. Entering a product will also 

enter its Unit. Selecting an alternative description (translation), will also enter the 

associated Unit (see "Alternative description" on page 17). 

The Quantity modifies the price or discount if special conditions for the entered 

product were assigned to the primary address of the item via a price or discount list. 

Therefore, when the quantity is changed, the price or discount will be updated if a 

different price or discount has been entered for the new quantity in the price or 

discount list assigned to the customer. 

Because individual prices and discounts don't depend on quantity, they are only 

adopted once when the product is entered and will not be updated automatically if 

they should change. 

 Price: When you enter a product, the associated Price will be transferred to the item. 

If prices for a product have been entered in multiple currencies, the price and purchase 

price for the currency selected in the item will be applied. If there is no price in the 

selected currency for the selected product, no price will be applied. 

Prices assigned to the primary address via a price list or as individual prices will be 

considered (see "2.5 Products, prices and discounts” on page 35). 

The valid price will be determined as follows: 

 If an individual price for the selected product and Currency has been assigned to 

the item's primary address, it will be used preferably. 

 If a list price for the selected product, Currency and Quantity has been assigned to 

the item's primary address, it will be used if there is no valid individual price. 

 If there is no valid individual or list price, the default sales prices of the product in 

the selected Currency will be used. 

You may manually edit the price for an item after it has been determined automatically.  

Please note that changing the product or quantity may overwrite manual changes. 

 Currency: The first item created for a project will determine the project's currency. You 

can create no additional items with another currency for that project. 

You can, however, convert the currency via the project's Tools menu, if this feature has 

been activated for projects (see "Convert currency" below). 

You may change the currency of the first item as long as the project has no other items. 

 Default currency: For the first item created for a project, the currency will default to 

the base currency or to the current user's default currency if he has been assigned a 

default currency other than the base currency (see "9.5 Settings in the User 

Management area" on page 218).  

 Price: If a price in the selected currency exists for the selected product (individual 

price, list price or default price), it will be applied. 
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When you select a product for which no price has been entered in the selected 

curreny, the project item will retain the project currency. Prices entered for the 

product will not be applied to the item in this case.  

 Discount: A discount specified for the selected product and the customer will still be 

adopted, even if no price is available for the selected product and currency. 

 Convert currency: You can convert the currency of a project and associated items 

via Change currency in the Tools menu of the project's data record window. Please 

note that this feature must be activated for projects in the Miscellaneous area of 

the Management Console under Products (see "9.2.4 Products" on page 192). 

Select the target currency and, if desired, specify a conversion rate. Alternatively, you 

may keep the currency field values or set them to zero.  

Once the project and associated items have been converted, you may edit the 

currency fields. Via the magnifier, you can reenter the product to update the Price, 

Contribution margin and, if applicable, the Discount and Quoted price. 

Note 

As for projects without items, the currency is undetermined for projects with items 

having different currencies. This can be the case with projects that have been imported 

from another system as well as with migrated projects that have been created with an 

earlier version of CAS genesisWorld (because the currency was previously not checked). 

You can not create any more items for projects with a mixed currency. 

You can also not change the currency of existing items for such projects. 

Please note that the calculations of totals in the Order tab as well as the Project items 

variable available in associated documents (see "2.4 Creating documents for items" on 

page 33) are not capable to handle more than one currency. 

To resolve the conflict, convert the project's currency via the Tools menu (see above) or 

split the project by creating one new project per additional currency and assigning the 

items with that currency to that project. 

 

 Quoted price and discount: The Quoted price field applies the granted discount in 

addition to list prices and individual prices. 

When you enter a product for which an individual or list discount is assigned to the 

address, that discount will be entered in the item (see "2.5 Products, prices and 

discounts” on page 35). 

The valid discount will be determined as follows: 

 If an individual discount for the selected product and Currency has been assigned 

to the item's primary address, it will be used preferably. 
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 A list discount assigned to the item's primary address for the selected product, 

Currency and Quantity will be used when there is no valid individual discount. 

A granted discount will be stored as a ratio in the field Discount relative (%) and as an 

absolute value in the Discount field. 

You can edit each of the Quoted price, Discount relativ (%) and Discount fields. 

When you change any of these fields, the other two will be recalculated. 

Note 

The quoted price, as displayed, is rounded to two decimals. 

Multiplying the quoted price with the quantity does therefore not always yield the 

item's total sum, because the sum is calculated with the unrounded quoted price. 

 

 Contribution margin: When you enter a product, the contribution margin per piece 

will be calculated from the Quoted price less the Purchase price stored with the 

product: 

 cm (contribution margin per piece) = Quoted price – Purchase price 

The contribution margin per piece, multiplied with the Quantity, yields the item's total 

Contribution margin which is specified in the field of this name: 

 CM (total contribution margin) = cm * Quantity 

You can modify the specified contribution margin by entering the desired value in the 

associated field. The Contribution margin relative (%) field will update automatically. 

 Contribution margin relative (%): The relative contribution margin indicates the 

Contribution margin's proportion of the Sum in most cases. 

It indicates otherwise only if the item's sum is null or negative. 

 Sum = 0: When the item's sum equals null, the relative contribution margin only 

indicates whether the Contribution margin field's value is equal to null (0%), 

positive (100%) or negative (-100%). 

 Sum negative: When the item's sum is negative, the relative contribution margin 

indicates the contribution margin's proportion of the absolute value of the sum (see 

example). 

Manually changing this value will recalculate the Contribution margin field. 

Example 

Sum = -100, Contribution margin = 50  

 Contribution margin relative (%) = 50 / |-100| = 50/100 = 50% 
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 Sum: The Quantity multiplied by the Quoted price yields the item's Sum. 

 Status: The status is adopted from the project when an item is created. You may assign 

a different status to each item. All status options for the type of the associated project 

are available for selection here. 

 Invoiced and Receipt number: Enter the date of invoicing here and receipt number 

here. When you create an invoice (receipt with statistic factor 1) for the item via the 

Order tab of the associated project with Easy Invoice (see "Create receipt" on page 25) 

and generate a print document for it, these fields will be entered automatically. Please 

note that read rights for receipts are required to display the receipt link. 

 Parent: Here you see and change the primary links of the item. An item must have 

primary links to an address and a project in order to save it. Each item can also be 

assigned to a job. 

When you change an item's primary address, the Price, Quoted price, Discount 

relative (%) and Discount fields will be updated if other conditions are valid for the 

new primary address. 

When you create a job for an item via the Create menu in the project's Order menu, 

the item will be associated with the new job via a primary link. In the Tree view, an item 

assigned to a job via a primary link will be displayed under its primary job. By dragging 

and dropping it in this view, you can assign the item to a different job. 

 Notes: Here you enter notes for the item. 
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Details 

Here you can see and change item links to a product use and appointment, which you can 

also create for multiple items in a project's Order tab. Jobs created for the item there will 

use the job template selected here under Workflow. 

 

 Product use (with Helpdesk): Here you can see and change the product use for the 

item. Product uses are available with Helpdesk and are used for recording details of a 

customer's product use. 

For items without a product use, you can create one by clicking on the associated icon.  

 Appointment: Here you can see and change the appointment for the item. Create an 

appointment for an item or assign an appointment to it to schedule associated services.  

For items without an appointment, click on the associated icon to create one. 

 Workflow: Here you can select a job template. This will be used when a job is created 

for the item via the associated project's Order tab. 

For details about creating data records for multiple items via a project's Order tab, see 

"Create" on page 23. 

Notes about duplicating items 

When you duplicate an item, the new item’s price and discount will be reset. 

This way, applicable conditions valid at that point of time that have been entered for the 

customer via a price or discount list or via individual prices or discounts will be applied. 

This is done intentionally because prices and discount are usually subject to change and 

may differ depending on the customer. 
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2.3.3 Working with items in the Order tab 

The following features are available in the item list in a project for creating and modifying 

items. Some features depend on additional modules, which is indicated where it applies. 

 Total and Contribution margin: Below the item list, the sums of the order size (Total) 

and the Contribution margin of selected items are displayed. When no items have 

been selected, the sums are calculated for all items. 

 Open: By double-clicking on an item you open it for editing. 

 New > Item: Here you create a new item at the selected list position. 

 New > Group: Here you insert a new top level item group. For item groups, only the 

Description, Parent and Notes fields are available. The Details tab is not displayed for 

item groups. Select a group and click New to insert an item into that group. 

 New > Subgroup: Here you insert a subgroup in the selected group. 

 Duplicate: Here you duplicate the item currently selected in the list. The status of any 

new items created this way is adopted from the project. 

 Split: Here you split the item selected in the list, for example for the purposes of only 

partially billing the item in the current month. The Split items window opens. Here you 

enter the date as well as the quantity or volume ratio of the new partial item. 

 Change order and structure: Use the arrow buttons to change the order of items. 

With item groups, you can also move items in and out of groups via these buttons. 

 Delete: Here you delete all selected items. Before the items are deleted you are asked 

for confirmation. 

 Refresh: Here you apply changes made to displayed items while the view was open. 

 Create: Here you create jobs, appointments and product uses for items. 

Jobs and appointments created this way will adopt the following item fields. 

 Date: The item date is taken over as the start or end date of the job or appointment. 

 Number and Product: The item's Product field is adopted as the job's or 

appointment's subject. Optionally, the item number may be added to the subject. 

 Duration: The item's Quantity determines the job's or appointment's duration. The 

Unit is configured for the item's product in the Management Console. The item's 

unit is ignored. The unit defaults to Days when not configured. With unit Hours, 

jobs last one full day per started person day. 

 Type: Each product can be assigned to a job or appointment type which will then be 

applied to jobs and appointments created for associated items. 

 Resource plan: Resource plans created for jobs amount to the item's Quantity of 

person days or hours. The Unit is specified for the product in the Management 

Console. The item's unit is ignored. The unit defaults to Days when not configured. 
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Please also note sections "Items for jobs" on page 197 and "Items for appointments" on 

page 198 on the configuration in the Management Console.  

 Jobs for items can be used for resource planning and to record working time. 

Here you create a job and resource plan for each selected item not yet assigned to a 

job.  

A primary link to the job will be entered, which you can see and change in the item's 

General tab under Parent. 

 At first, the Select participants window opens. Select the participant of the jobs 

and resource plans here. 

 Each item gets a primary link to its job. An appointment assigned to an item in its 

Details tab or in the project's Order tab also gets a primary link to the same job.  

 Jobs created for items with a job template selected under Details > Workflow 

will be created along with any data records selected in that template.  

 Items in a job: In the job's dossier and tree views, as well as in the Resources 

and items tab, you can see associated items. 

If a product has been entered for at least one job type in the Project area of the 

Management Console under Orders > Items for jobs, the Create item button 

will be displayed in the toolbar of the data record window for a job (see "Items 

for jobs" on page 197). 

Click this to create new items for jobs with a primary project. 

Appointments for items can be used for scheduling. Select this to create an 

appointment for each selected item not already assigned to an appointment. 

You can see and change the appointment in the item's Details tab. 

Alternatively, you can create an appointment for an item or assign an existing 

appointment to it in its Details tab. 

 Item in an appointment: the appointment's dossier displays associated 

items. 

If a product has been entered for at least one appoinment type in the Project 

area of the Management Console under Orders > Items for appointments, the 

Create item button will be displayed in the toolbar of the data record window for 

an appointment (see "Items for appointments" on page 198). 

Click this to create new items for appointments with a primary project. 

 Transfer items to a new job: Here you create a shared job and resource plan for all 

selected items. 

 At first, the Select participants window opens. Select the participant of the jobs 

and resource plans here. 
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 The items get primary links to the new job. Appointments assigned to items in 

their Details tabs or in the project's Order tab also get primary links to the job.  

 Product uses for items (with Helpdesk): Here you create a new product use for 

each selected item. The project's primary address will be entered as Customer of the 

new product uses. The Date of each item will be transferred to the Delivery on and 

Start of maintenance fields of the product use created for it. Each product use also 

adopts the Product, Product number and Quantity of the associated item. 

If there is a service agreement with matching currency for the company of the 

project's primary address, the product uses will automatically be assigned to it. If 

multiple such service agreements exist, you will be prompted to select one. 

Whenever product uses created for items are assigned to a service agreement this 

way, the service agreement will be opened to display the new product uses. When 

there is no service agreement the new product uses can be assigned to, they will still 

be created for the project's primary address but they won't be displayed. 

 Create receipt (with Easy Invoice): With Easy Invoice, you can create receipts like 

order confirmations and invoices in CAS genesisWorld via the item list. 

 Select the desired items. 

 Open the Create receipt menu and select the desired receipt type. 

For invoices and other receipts with the statistic factor 1, after creating the receipt 

document and saving the receipt, the previously selected project items get the receipt 

date in the Invoiced field and the receipt number in the Receipt number field. 

 Create Document: Here you create documents like quotes for the selected items. To 

do this, the template selection for documents opens first. The features available here 

are described in section "2.4 Creating documents for items" on page 33. 

 Options (without Easy Invoice): 

 Hide billed items: Here you hide invoiced items, leaving only items in view in which 

no Invoiced on date has yet been entered. 

 Sort items by date: Here you hide all groups and sort the items by date. Whenever 

you create a new group, this option is automatically deactivated. 

 Select view (with Easy Invoice): Here you select whether items will be displayed 

sorted by group or by date. You may also display or hide order items here (see section 

"2.3.4 Assigning orders (with Easy Invoice)" on page 27). 

 Hide billed items (with Easy Invoice): Here you hide all items with an Invoiced 

date.  

Click this again to display invoiced items once more. 

 Invoice: Here you enter the current date in the Invoiced field of each selected item. 
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 Undo invoicing: If you have only selected invoiced items, click this to undo invoicing 

for the selected items by clearing the Invoiced on field.  

 Apply date: Here you open the date selection in order to change the date for all items 

selected in the list. 

 Assign items to order (with Easy Invoice): Here you assign selected items to exactly 

one order item (see section "2.3.4 Assigning orders (with Easy Invoice)" on page 27). 

 Export: Here you export all of the project's items to Microsoft Excel. Select items first to 

export only selected ones. Additionally, the following project fields are exported. 

 Subject 

 Number 

 Person responsible (Sales) 

 Primary link 

 Person responsible ("Contact") 
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2.3.4 Assigning orders (with Easy Invoice) 

The following features for assigning orders to projects and for assigning order items to 

project items are available in the project's item list with Easy Invoice. Users don't need to 

be assigned an Easy Invoice license to use these features; it is sufficient to have an Easy 

Invoice license entered in the system. 

 Marking a receipt type as order: the features for managing orders will be available in 

the CAS genesisWorld Desktop Client after at least one receipt type has been marked 

as Order in the associated configuration in the Easy Invoice area of the Management 

Console under General. Also assign number ranges to the new receipt types under 

Number assignment. See "9.1.1 Receipt types for orders" on page 187 for details.  

 Creating orders: you can create orders for selected project items via the Create 

receipt menu. For each selected project item, an order item will be created. Each 

project item will be assigned to the associated order item. 

The order will also have a primary link to the project, assigning it to that project.  

For project items created later, you may create additional orders this way or assign 

them to existing order items in the Orders view (see below).  

 Assigning orders: all receipts with an order receipt type and a primary link to the 

current project will be displayed in the Project items and order items view. 

To assign an order to a project, enter that project as the primary project of the order. 

You can enter the link in the Parent field in the General tab of the order, or via the 

Link with feature available for the project and order, and selection of Primary link. 

Please note that, when the primary project of an order is changed, project items of the 

previous primary project that have already been assigned to that order will lose their 

assignment. 
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 Displaying orders and order items: via the Select view button, you may select one of 

three views: Sort items by hierarchy (structure created via groups), Sort items by 

date and Display project items and order items. 

 

Orders, order items and assigned project items will only be displayed in the Display 

project items and order items view: 
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 Assigning project items to order items: with the Aassign items to order button in 

the view's toolbar, you assign project items to exactly one order item: 

 

 Undo assignment: in order to undo the assignment of one or more project items, 

select the Unassigned items option under Order: 

 

 Creating project items: you may create new project items, assigned to an order item 

or unassigned, in this view via the New button (first icon from the left) in the toolbar.  

Select an order item first to create the project item for that order item. The product, 

price, discount and contribution margin will be adopted from the order item. The 

quantity will be preset to match the open balance of the order item (see below). 

Click New without selecting an order item first to create an unassigned project item. 

 Duplicating project items: you may duplicate existing project items, assigned to an 

order item or unassigned, in this view via the Duplicate button (second icon from the 

left) in the toolbar. 
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 Splitting project items: you may split a selected project item, assigned to an order 

item or unassigned, in this view via the Split button (third icon from the left) in the 

toolbar. 

 Deleting project items: you may delete selected project items, assigned to an order 

item or unassigned, in this view via the Delete button (red cross icon) in the toolbar. 

 Balance: in the row of an order item to which one or more project items have been 

assigned, you can see an overview of the ordered and already supplied quantity. In the 

following example, two out of five days of work have already been done, such that a 

balance of three days remains: 

 

When the project item total exceeds the order item total, the balance row will turn red. 

 Features with and without order items: depending on the view mode selected via the 

eye icon, different features will be available in the view and the associated toolbar. The 

following features are only available in the default views for project items without order 

items: 

 The pull-down menu for the New button to create item groups is only available 

without order items. The item groups will only be displayed in the hierarchical view 

mode. In the mode sorted by date, the hierarchical structure will be visible in the 

numbering of the items. No hierarchy will be displayed in the mixed mode. 
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The New button for creating individual project items is available in all three view 

modes. 

 The arrows for modifying the sequence of items are only available in the hierarchical 

view. In the other views, project items are sorted by date or grouped by the 

associated order item. 

 The features for creating jobs, appointments and product uses via the Create menu 

are only available in the modes without order items. 

 The Create document feature for passing selected items to a document are only 

available in the modes without order items. 

 The Hide billed items (list filter), Invoice/Undo invoicing (enter current date in the 

Invoiced field) and Apply date (select a date and enter it in the Date field) features 

are only available in the modes without order items. 

 The Excel export is only available in the modes without order items. 

All other features of the toolbar are also available with order items. 

 Order item in the project item: for each project item assigned to an order item, that 

order item is displayed in the General tab: 
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 Assignment of project and order items to an invoice: when an invoice is created for 

project items, each invoice item will be assigned the associated project item and order 

item. 

 Analysis of the created links: the links can be analyzed with the Report module.  

 

The following links are available: 

 1:n Receipt items [Order items] – Items [Project items]: link between order items 

and items of the associated primary project. Any number of project items can be 

assigned to any one order item (cardinality1:n). 

 1:n Receipt items [Order items] – Receipt items [Invoice items]: link between 

order items and the receipt items of associated invoices created for project items via 

the Order tab of the project. Any number of invoice items can be created for any 

one order item (cardinality1:n). 
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2.4 Creating documents for items 

In order to create a document, such as a quote or an invoice, for all or a selection of 

project items, select the desired items in the project's Order tab and click on the 

unlabelled Create document button in the item list's toolbar. 

Note 

Please note that items will only be available in Microsoft Word if you first select them 

and then create the document via the unlabelled Create document button in the item 

list's toolbar. 

Additionally, the transfer of items to Microsoft Word must have been activated for the 

document's Type (see "9.2.3 Documents" on page 191).  

 

With Project, the Project items variable category is available in Microsoft Word.  

 

 Project description: Formatted text from items. 

 The item groups will be adopted as structure. 

 Each item's Product (Subject) will be adopted as headline. 

 Each item's Description will be adopted as text. 

 Project items: Formatted item list 

 Number, Product, Quantity, Unit, Price, Sum 
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Modifying the field variables for items 

Partners can modify the selection and processing of data via the files in the Infoblocks 

directory in the server. 

The following files are used: 

 Projektbeschreibung.xml 

 Produktbeschreibungen.xsl 

 Projektpositionen.xml 

 Produktpositionen.xsl 

Please note that the xsl files are also used for the field variables of the same names for 

documents for opportunities (e.g., quotes) and changes will also affect those. 

The modification of Infoblocks files is decribed in the current SDK documentation. 
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2.5 Products, prices and discounts 

The following fields and features for products are relevant for the Project module: 

 

 Prices 

 Price and purchase price (default base currency prices): These will be applied to 

project items when this product and the base currency are selected there. 

 Differing price information (foreign currency prices and purchase prices): These 

will be applied to project items when this product and the respective currency are 

selected there. This feature is not available by default and must first be activated in 

the Management Console (see "9.2.4 Products" on page 192).  

 List prices: Varying sales prices depending on the quantity can also be entered in a 

price list for any currency. Differing purchase prices are not supported in price lists; 

the default purchase price for the respective currency will be applied. 

In project items for addresses to which a price list has been assigned, the list price 

for the respective quantity will be applied if available in the price list for the selected 

product and currency (see "Price and discount lists" on page 37). 

 Individual prices: You may also enter individual sales prices (without a differing 

purchase price) for specific addresses. 
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If an individual price exists for the product, currency and associated address, it will 

be applied instead of the default price and any list prices. (see "Price and discount in 

addresses" on page 38).  

 Quantity unit and description: These information will be applied to project items for 

this product by default. 

 Alternative descriptions (and quantity units): Here you enter individual descriptions 

and suiting quantity units in foreign languages. If you select a product with alternative 

descriptions and quantity units in a project item, these will be available there. 

This feature is not available by default and must first be activated in the Management 

Console (see "9.2.4 Products" on page 192).  

 Active: Here you determine by default whether the product will be available for 

selection in project items. You may change the associated filter condition (default 

Active is identical with true) in the Management Console (see "9.2.4 Products" on 

page 192). 

 Billing type: Default item type for the billing preparation (see "Expenses, external 

services and time record lump sums" and "Time records by hourly rates" on page 149) 

and for vendor credit notes (see "Time record billing type configuration for products" 

on page 160). 
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2.5.1 Price and discount lists 

You can see list and customer prices entered for a product in the new Price lists tab. List 

discounts and customer discounts are displayed under Discount lists. 

 

 Create new price or discount: Here you create a new price or discount for the product 

in an existing price or discount list. You have to select a price or discount list in order to 

save the price or discount. 

You define price and discount lists in the Management Console under Project > Orders 

(see "Price lists and Discount Lists" on page 195.)  
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2.5.2 Price and discount in addresses 

In the Details tab of the data record window for companies and individual contacts, you 

can see and change the assigned lists under Prices and Discounts. Here you also create 

individual prices and discounts, valid only for that specific customer. 

With the Easy Invoice module, these features are available in the Billing tab. 

 

 Assign price or discount list: The Price list and Discount list fields display the 

selected lists. 

 Display price or discount list: Here you open the list of special prices or discounts. 

 Create new price or discount: Here you create an individual price or discount. 

Individual prices and discounts override prices and discounts from lists. Individual 

prices and discounts cannot be scaled by quantity. 

 Display individual prices or discounts: Here you open the list of individual prices 

or discounts. 

 Individual prices and discounts in the Management Console: In the Price lists and 

Discount lists tabs, you can see all individual prices and discounts currently stored in 

the Customer prices and Customer discounts tabs. 
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3 Project details 

With Project, different features are available in the Details tab of the data record window 

for projects than those available there by default. 

 

The calculation displayed here by default is dropped, since reports based on time records, 

expenses, external services and resource plans are available in the Report menu with the 

Project module. 

The following features supplement the Details tab with Project. 

 Project management 

 Project status / Explanation: The project status is available in the General tab 

without Project as well with CAS genesisWorld Premium. With the Project module, 

the project status is also displayed in the Details tab. Here you can also store a 

comment about the project status in the Explanation field. 

 Lock for time recording: When this option is selected, no additional time records 

can be created for the project and the Actual field in existing time records for the 

project can no longer be modified. 

 Project manager (customer): Link the customer company's project manager here. 

 Responsible (comm.): Sales executive. When creating receipts for the project with 

Easy Invoice, this person will be transferred to the receipt field of the same name. 

 Project directory: Directory for documents or other additional information for the 

project. You can display this directory in the project's tree view. 
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 Last contact 

 Last contact on / Contact person / Last contacted via: These fields are available 

here without Project as well with CAS genesisWorld Premium. The information is 

updated when certain appointments, phone calls, e-mails and documents are 

created for the project. In the Management Console, under Miscellaneous > Last 

contact, you specify in which cases a contact is recorded.  

 Expenses 

 Expenses mode: By working time, Lump-sum or Inclusive billing mode. 

Select By working time here to bill expenses externally by working time. The Bill 

expenses externally option will be set. Any expenses created for the project will be 

billed externally by default. 

Select Lump-sum when a lump-sum has been agreed on for expenses. Create an 

expenses item of the Lump-sum type for each appointment to which the lump-sum 

applies. The entered lump-sum will be entered in that expenses item and it will be 

billed externally only. The Bill expenses externally option will be deactivated. Any 

other expenses created for the project will not be billed externally by default. 

Select Inclusive if expenses are included in the agreed price. The Bill expenses 

externally option will be deactivated. Any expenses created for the project will not 

be billed externally by default. 

 Lump-sum: When you select the Lump-sum expenses mode, the field of the same 

name will be available here. This amount will be transferred to all expense records of 

the Lump sum type you create for the project. 

 Km to be billed: When you select the By working time expenses mode, the Km to 

be billed field will be available here. This value will be transferred to all expense 

records of the Travel costs type you create for the project. 

Notes on the kilometer fields 

All kilometer fields may be renamed to use any other unit, such as miles. 

 

 Bill expenses externally: with this setting, the Bill externally option will 

automatically be selected for all new expenses you create for the project. This way 

the recorded net costs are transferred to the Turnover field.  

 Billing: Here you may enter a reference number, a reference mark and a different 

invoice address. With Easy Invoice, these data will be transferred to any receipts you 

create for this project. 

 Export: Here you export the project's work breakdown structure, resource planning 

included, to Microsoft Project or Open Workbench or import a previcusly exported 

project structure. For details about this feature, see section "5.2.4 Exchange with 

Microsoft Project and Open Workbench" on page 49. 
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4 Using e-mail templates 

E-mail templates are available for company contacts and for individual contacts. You 

embed fields of the address and link documents which will be added as attachments. 

Note 

The e-mail template selection for addresses offers any E-mail campaign documents 

with the E-mail template and Ticket e-mail template categories. 

Document templates will not be available. 

 

 Via the E-mail templates button in the toolbar of a contact person's or individual 

contact's data record window you open the selection of templates. 

The e-mail will be generated from the selected template, addressed to the desired 

recipient and opened. You may now edit or extend it, send it and archive it as you wish. 

Creating e-mail templates 

You create e-mail templates as documents using the E-mail campaign template. 

The E-mail template category in the document marks it as an e-mail template and makes 

it available in the e-mail template selection. 

 Select New > Document from the File menu or select Document from the New menu 

in the main window to create a new document. 

 Select the E-mail campaign default template and click OK to confirm. 

 The data record window for e-mail campaigns will open. 
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 Subject: The document's subject is displayed in the template list. 

 E-mail subject: Enter the subject for the e-mails to create from the template here. 

 Body: Use the CAS genesisWorld text editor to create the e-mail body. 

 Insert variables: Click on the arrow button at the lower right to access address fields 

and document field variables. 

 Insert address fields in the e-mail subject or body via the Recipient list. 

 Insert document field variables in the e-mail body via the Field variables list. 

 Add attachments: Click on the arrow button at the lower left to display the attachment 

list. Then click on the Attachments button next to that list to edit it. 

 Click Add attachment to access the document archive via the global search.  

 Click Add new attachment to create a new document and add it to the e-mail 

template as an attachment. 

 Click Remove attachment to remove the selected attachment. 

 Data in the Advanced tab: In e-mail campaign templates, nearly all fields that you 

usually edit in the General tab can be found in the Advanced tab. 

 Mark as e-mail template: Switch to the Advanced tab and select the E-mail template 

category to add the document to the selection of e-mail templates. 
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5 Project and resource planning in the tree view 

The following sections describe project and resource planning features of the tree view in 

the Desktop Client and in the Web Client. 

 5.1 Project planning basics (page 43) 

 5.2 Project planning in the Desktop Client (page 44) 

 5.3 Project planning in the Web Client (page 55) 

 5.4 Resource planning basics (page 57) 

 5.5 Resource planning in the Desktop Client (page 59) 

 5.6 Resource planning in the Web Client (page 71) 

5.1 Project planning basics 

Project planning is based on the Job data record type. 

The following features are available both in the Desktop Client and in the Web Client: 

 For scheduling, a tree view of project phases, jobs and milestones with an integrated 

interactive Gantt chart is available. 

 You may assign any number of jobs to a project in a hierarchical structure with an 

unlimited depth of job levels. A job containing other jobs is called a project phase.  

 You may insert milestones on any level. 

 A milestone represents an important step toward the goal of a project.  

 Technically, a milestone is a job scheduled for a single day. 

 Because milestones are jobs, they appear in job lists and when searching jobs. 

 In the Desktop Client, assign the milestone type to any job to make it a milestone.  

 In the Web Client, insert milestones via the radial menu for the project and jobs. 

 You may insert resource plans to jobs that are not project phases. 

 For details, see the sections about resource planning on page 57 and following. 

The following additional features are available in the Desktop Client only: 

 Predecessor-successor links and auto-scheduler 

 Export to and import from Microsoft Project and Open Workbench 

 Risks and targets for addresses, projects and job 
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5.2 Project planning in the Desktop Client 

The following project planning features are available in the Desktop Client. 

 5.2.1 The Gantt chart (page 44) 

 5.2.2 Milestones (page 46) 

 5.2.3 Predecessor and successor (page 47) 

 5.2.4 Exchange with Microsoft Project and Open Workbench (page 49) 

 5.2.5 Risks (page 51) 

 5.2.6 Targets (page 53) 

5.2.1 The Gantt chart 

With the Project module, a Gantt chart is available in the tree view for visual planning. 

 

 Show or hide Gantt chart: Here you show or hide the Gantt chart. In the Gantt chart, 

two additional toolbars are available in which you make settings for the view. 

 Start date, period and zoom: In the upper left area in the toolbar, you can see and 

edit the view’s start date. Use the two menus below to set the period and zoom level. 

 Select start date: Enter the start date or click on the little arrow in the associated 

field in order to select a date in the calendar. 

 Select period of time: As periods of time for scaling the Gantt chart, days, weeks, 

months, quarters and years are available. 

 Select zoom level: Via the zoom level you adjust the scaling. Values of 10-150% 

(steps of 5) and of 150-750% (steps of 10) are available. 

 Previous period: Here you set the start date to the previous period. 
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 Next period: Here you set the start date to the next period. 

 To current day: Here you set the start date to the current day. 

 Align selected data record at left border: Here you adjust the start date, so that 

the start date of the selected data record is displayed to the left of the view. 

 Center selected data record: Here you adjust the start date, so that the selected 

data record is displayed in the middle of the view. 

 Align selected data record at right border: Here you adjust the start date, so that 

the start date of the selected data record is displayed to the right of the view. 

 Adopt to current period: Here you extend any jobs in the selected sub-tree to the 

currently selected period, e.g. the current week if you have selected weeks as period.  

If the project is selected, it is extended together with any associated jobs. 

 Edit schedule: Using the mouse, you edit the duration of the displayed projects, jobs 

and appointments and the deadlines of tasks via drag-and-drop. 

 Edit duration at start: In order to edit the start and duration at the same time in a 

data record, leaving the end unchanged, click at the left border of the associated 

bar, hold the mouse button and move the border to the desired place. 

 Edit duration at end: In order to edit the end and duration at the same time in a 

data record, leaving the start unchanged, click at the right border of the associated 

bar, hold the mouse button and move the border to the desired place. 

 Move: In order to move a data record, leaving the duration unchanged, click at the 

bar in the middle and drag it to the desired place. 

You can move data records of a smaller duration by pressing the [Alt] key first 

and holding it while you are moving the data record. 

 Detail level during moving: The step width during moving depends on the period 

setting. Hold [Alt]+[V] in order to adjust data records in smaller steps. 

Days, weeks: 1 day; with [Alt]+[V] 1 hour. 

Months, quarters, years: 1 week; with [Alt]+[V] 1 day. 

Note 

Please note that it is not possible to edit appointments in the Gantt view if you are using 

the Exchange sync module. 
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 Settings for Gantt view: In the settings for the tree view, you specify whether the 

Gantt chart is displayed when the view opens. 

 

 Here you open the Settings for Gantt view window in order to edit the Gantt 

chart's presettings for date, period and zoom level. 

In the project planning view in the Web Client, a project Gantt chart is also available (see 

"5.3 Project planning in the Web Client" on page 55). 

5.2.2 Milestones 

You can include milestones in your planning as jobs. 

 Milestones are jobs of a specific type. You specify the type for milestones in the 

Management Console under Project > General (see "Settings" on page 194). 

 You can open and edit milestones in the data record window for jobs. 

 When the milestone type is assigned to a job, its duration will be set to null. The end 

date cannot be modified as long as the job has the milestone type. 

 Milestones are displayed as a black diamond in the tree view and in the Gantt chart. 

Proceed as follows to create a milestone in the tree view. 

 Use the mouse to select the desired project. 

 Press the [Ins] key in order to create a new job in the project, name the job and 

confirm by clicking OK. 

 By right-clicking on the job, open the associated context menu. In its Type sub-menu, 

select the milestone type. 

 Via drag-and-drop in the tree view, you can move the new miletone to the sub-tree of 

another job. 

 Via drag-and-drop in the Gantt chart, you can move the milestone to the desired date. 

In the project planning view in the Web Client, you can also see and edit milestones (see 

"5.3 Project planning in the Web Client" on page 55). 
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5.2.3 Predecessor and successor 

In the data record window for jobs as well as in the Gantt chart in the tree view, you can 

see and edit four kinds of dependencies between jobs. In this way, you define the 

sequence in which the jobs must be completed. In addition, you can specify a minimum 

interval between jobs in work days. 

 Predecessor Start-Start: B may not begin before A has begun. 

 Predecessor Start-End: B may not end before A has begun. 

 Predecessor End-Start: B may not begin before A has ended. 

 Predecessor End-End: B may not end before A has ended. 

You may adopt time relations from project and job templates as predecessor/successor 

links (see "6.2 Editing a template" on page 79). 

In the Web Client, predecessor and successor links are not available. 

Note 

A job will only be selectable as another job's predecessor if both jobs share the same 

primary project. 

Predecessor and successor in a job 

The Predecessor tab in the data record window for jobs displays any jobs that the current 

job depends on. 

 

 Refresh: Here you reload the view in order to apply changes made at a different 

workplace or in the tree view. 

 Create new link: Here you create a new link to a job on which the current job should 

depend as the other job's successor. You select the link type, job and minimum interval 

in work days. 

 Edit link: Here you edit the minimum interval in work days for the selected link. 

 Delete link: Here you delete the selected link. 
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Predecessor and successor in the Gantt view 

In the Gantt view, the dependencies between jobs are displayed through arrows. 

Note 

Predecessor/successor links are only displayed in the Gantt view when both linked jobs 

are visible. If a linked job is outside the visible date range, no line is displayed for it. 

 

 Set predecessor/successor relation in the Gantt chart: In the Gantt view, you set 

dependencies of the Predecessor End-Start type via drag-and-drop using your mouse. 

Proceed as follows. 

 Move the mouse pointer over the inner right border of the desired predecessor until 

the mouse pointer switches to the predecessor/successor mode. 

Hold the [Ctrl] key in order to link short jobs in this fashion. 

 Click on the end of the desired predecessor and hold the mouse button until the 

End-Start relation overlay box appears. 

 Holding the mouse button, move the mouse pointer to the desired successor. 

 Hold the mouse button until the successor's subject appears in the overlay. 

 Release the mouse button in order to set the link. 

You can see and edit the link in the Predecessor tab in the data record window of the 

successor, i.e. the second job. Here you can specify a minimum interval between both 

jobs. 

 Display and correction of insconsistencies: If the condition of a link is not satisfied, 

the corresponding arrow is displayed in red. 

 Right-click anywhere in the tree view and select Update project plan from the 

context menu in order to correct any inconsistencies. 

 Right-click a job in the tree view and select Update project plan from here on from 

the context menu in order to correct insonsistencies in jobs directly or indirectly 

dependent on the job on which you clicked. 
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5.2.4 Exchange with Microsoft Project and Open Workbench 

With the permission to import and export data, you can import and export project plans. 

Note 

You may grant users the Import and Export permissions in the User Management area 

of the Management Console, in the Other rights tab of the user's Properties view. 

 

 Source & target systems 

 Microsoft Project 

 Open Workbench 

 Transferred data and limitations 

 Project structure and schedule: In Project and Open Workbench, projects and 

project phases start with the first associated job and end with the last associated job. 

If this should not be the case in an imported project, the start and end of the project 

and of all project phases are adjusted accordingly. 

 Milestones 

 Predecessor/successor relations between jobs: When you export projects to 

Microsoft Project, only predecessor/successor dependencies between jobs and 

project phases of the same hiearchy level will be transferred. 

 Resources and completion grades 

Features in the context menu of the project list 

 Import from Microsoft Project or Open Workbench: Here you import a project plan 

that was saved in the XML format in Microsoft Project or Open Workbench. If the 

project was previously exported from CAS genesisWorld, you can either update the 

corresponding project or create a new project. 

 Update: Any changes made to jobs will be transferred. Any changes made to the 

jobs in CAS genesisWorld in the meantime will be overwritten. New jobs will be 

created. Deletions will not be adopted. 

 Create new: A new project is created with all associated jobs. 

 Export > Export to Microsoft Project/Open Workbench: Here you export a project 

plan in the XML format of the target systems. This way you can export only one project 

at a time. If the target system is installed, it is started and the exported project plan is 

opened. 
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Features in the Details tab of the project record 

 Export and check out: When you export a project in the Details tab of the associated 

project, it will be checked out. This way, other users can see that it has been exported 

to be processed in another application. 

 Your user name is written in the Checked out by field. 

 The date and time are written in the Checked out on field. 

 The target system and the target file are stored with the project. 

 Export to Microsoft Project: By clicking on the button you export the project plan 

in the XML format of Microsoft Project. The project plan will be opened in Microsoft 

Project if the application is installed. 

 Export to Open Workbench: By clicking on the little arrow to the right of the 

export button, open the associated menu and select Export to Open Workbench to 

export the project plan in the XML format of Open Workbench. The project plan will 

be opened in Open Workbench if the application is installed. 

 Import: Here you import a project plan from Microsoft Project or Open Workbench. 

 Check in and update: If you have previously checked out the project, it will be 

checked in again and the project plan will be updated. 

The Checked out by and Checked out on fields as well as the stored target system 

and target file will be reset. 

All changes made to jobs will be adopted. Changes that you have made to the jobs 

in CAS genesisWorld in the meantime will be overwritten. New jobs will be created. 

Deletions will not be adopted. 

 Create new: If you import a project plan into a project from which you haven't 

checked out that project plan, the structure will be created anew in the target 

project. 
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5.2.5 Risks 

You record risks for addresses, projects and jobs. You schedule counteractions as tasks 

that are linked to the risk and adopt its primary links. 

Views and features for risks 

The following standard features are available for risks. 

 Data record window with General, Tree, Change log and Dossier tabs 

 Type and Status for unambiguous labelling 

 Primary links to address, project and job, displayed in the tree view and in analyses 

(with Report module) 

 General links to any other data records 

 Creation in the New menu, in the toolbar of data record windows and list views and in 

the tree view 

 Global search in all fields such as Subject, Indicators and Notes. Configurable via 

Settings > Search; search toolbar abbreviation RI 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 

The data record window for risks 

 

 Subject: You may freely modify the subject as in any data record. 

 Indicators: Specify here what evidence can be used to measure the risk's dimension. 
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 Response: Here you can see and modify the list of counteractions that you create as 

tasks linked to the risk. All tasks linked to a risk are treated as counteractions regardless 

of the link type. 

 Create new counteraction: Click on the Follow-up action button at the very left of 

the lower toolbar in the data record window of the risk in order to create a new 

counteraction. 

 Select a counteraction by searching: Here you open the search window to select a 

task. Mark the desired task in the list and enter it by clicking Accept & Close. 

 Open list: Here you open a list of all counteractions recorded for the risk. You can 

also see a list of all counteractions recorded for the risk in the Dossier tab. 

 Delete links: Here you delete the links to all displayed counteractions. You remove 

single counteractions in the dossier. 

 Person responsible: Specify the person responsible for the risk here. 

 Probability: Specify the probability for the risk's occurence. In the default setting, the 

High, Medium, and Low options are available for selection here.  

 Impact: Specify the risk's severity here. In the default setting, the High, Medium, and 

Low options are available for selection here. 

 Type and Status: For classifying risks via type and status, the following input helps are 

available. 

 Type: technical, personell, unforeseen circumstances, availability of resources 

 Status: open, closed 

For every type, the Open and Closed status options are available. 

 Parent: Here you can see and alter the primary links as in other data records. 

 Notes: Here you enter notes for the risk. 
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5.2.6 Targets 

You record targets for addresses, projects and jobs. 

Views and features for targets 

The following standard features are available for targets. 

 Data record window with General, Tree, Change log and Dossier tabs 

 Type and Status for unambiguous labelling 

 Primary links to address, project and job, displayed in the tree view and in analyses 

(with Report module) 

 General links to any other data records 

 Creation in the New menu, in the toolbar of data record windows and list views and in 

the tree view 

 Global search in all fields such as Subject, Description and Notes. Configurable via 

Settings > Search; search toolbar abbreviation TARG 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 

The data record window for targets 

 

 Subject: You may freely modify the subject as in any data record.  

 Description: Use the description to supplement the subject. 



Project   Project and resource planning in the tree view 

54 

 Nominal: Enter the nominal value here that consitutes the target to be achieved. 

 Actual: Update the actual value here whenever it changes. 

 Unit: Select one of the units Duration, Currency, Percent or Number here. 

The display mode of the Nominal and Actual fields and the behavior when entries are 

made adapt to the selected unit. 

The % achieved field is updated automatically, when entries are made in the Actual 

field. It always displays the proportion of the Actual value in the Nominal value. 

 Set on: Enter the date on which the target was set here. 

 Set for: Enter the date on which the target should be achieved here. 

 Person responsible: Specify the person responsible for achieving the target here. 

 Type and Status: For classifying targets via type and status, the following input helps 

are available for the Type field in the default setting. 

 Project target, business objectives, personal goal, internal target, acquisition target 

No input helps are supplied for the Status field in the default setting. 

 Parent: Here you can see and alter the primary links as in other data records. 

 Notes: Here you enter notes for the target. 
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5.3 Project planning in the Web Client 

In the Web Client, you can open the Project planning view via Display project planning 

in the radial menu or action menu for a project. 

 

The Project planning view includes a tree view, Gantt chart and overview of planned 

workload. 

 

 Using the radial menu for the project, jobs and employees in the tree view … 

 … you can edit the displayed structure, … 

 … define milestones, … 
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 … assign new workload …  

 … and distribute existing workloads. For this action, you specify the portion of the 

workload (ETC) to distribute and the User to distribute it to.  

The other planning values of the resource plan are split in the same proportion.  

 Click on the slider icon to open the view’s settings and configure the number of periods 

and the resource plan fields for workload key figures to display as columns: 

 Total estimate: Current planning of recorded working time Actual plus ETC. 

 Actual: Recorded working time. 

 ETC: Currently planned ETC For manual planning, the sum of working time per 

interval. 

 Employee's ETC: Where appropriate, this is the deviating estimate for ETC, 

estimated by the respective employee. 

 Time budget remaining: Time budget minus any accountable Value. 

 Value: Externally accountable recorded working time. 

 Time budget: Customer's authorized working time 

 Deviating working time: Originally Planned working time minus the current Total 

estimate. Differences are due to time records exceeding values planned for the 

associated week or month or additionally cleared workload (ETC). 

 Planned working time: Originally planned working time.  

 In the interactive Gantt chart, you can see: 

 Project and job durations and milestone dates 

 ETC for the project, each job and each resource plan per week or month 

You may edit the schedule via drag and drop. 

 The colored workload charts at the bottom right display availability, global utilization, 

remaining availability and overload of project members, including: 

 Open resource plans 

 Appointments for which the Nominal costs option has been selected. 

 Holidays 

Click on a chart segment to display the associated figures. 

Click on the question mark at the top right to open the online help pages for more details. 
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5.4 Resource planning basics 

Resource planning is based on the Resource plan data record type. 

Please note that the information on completion grades and completion of jobs described 

on the following page applies to the Desktop Client only. 

All other information listed below applies to both the Desktop Client and the Web Client. 

 A resource plan allocates working time in a job to a user. 

 The working time is given in person days (PD). By default, a person day lasts 8 hours. 

You determine the duration of a person day in the Management Console under 

Time record > General (see "9.4.1 General" on page 210). 

 The working time is entered as externally billable Time budget and automatically 

transferred to the ETC field in new resource plans. 

Also see "5.5.3 The data record window for resource plans" on page 62. 

 Workloads are first distributed equally over the working time during the job's 

remaining duration by week. Decreasing the duration will increase the workload per 

week and vice versa. 

 With version x11.1.7, an optional manual planning mode has become available (see 

„10.5 New features and fields in Project x11.1.7“ on page 223 for details). 

 When using the manual mode, workloads will initally still be distributed evenly over 

the working time during the job’s remaining duration by week. 

 Once you enter workload for a job in the Resource planning app in the Web Client, 

the manual planning replaces the initial automatic plan. Changing the task duration 

will then no longer redistribute the workload for this job.  

 In the detail view of a plan (of a job and associated resource plan), you can find a 

button for resetting the manual distribution. The total workload entered as ETC will 

be retained, but will automatically be distributed evenly once more. 

For more details, see „5.6 Resource planning in the Web Client“ on page 71. 

 In time records for a job in which the user has a resource plan, the following values 

from the resource plan are displayed. 

 ETC (estimate to complete): Remaining working time according to the current 

planning. If it becomes null, it is only possible to record more time for the resource 

plan when overbooking is permitted unless additional ETC is cleared (see "Booking 

of time recordings" on page 206). 

Clearing additional ETC by raising the value of the resource plan's ETC field requires 

the Resource planning right (see "Rights" on page 58). 

 Actual: Total of recorded actual hours from all the user's time records in the job 

which are relevant to accounting. 
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 Time budget remaining: Time budget minus total of recorded charged hours. 

 Charged: Total of recorded charged hours from all the user's time records in the job 

which are relevant to accounting. 

With manual planning, each time record not only reduces the ETC total but also the 

planned hours in the associated week or month. 

You will find more about recording time for resource plans under "Job" on page 92. 

 Relevance to accounting: A time record's relevance to accounting depends on its 

type. To create time records for resource plans, you must configure types which are 

relevant to accounting in the Management Console (see "Booking settings for all 

time recording types" on page 207). 

For each time record type relevant to accounting, you also specify whether the Actual 

hours of each time record should automatically be entered as Charged as long as the 

total of Charged hours in the resource plan does not exceed the Time budget. 

 Completion grade and completion of jobs: Jobs have a completion grade which can 

be modified in the Resources and items tab, in the Gantt chart and in time records.  

If the completion grade is set to 100%, the first available completion status is 

automatically set in the job. When you assign a completion status to a job, the 

completion grade will automatically set to 100%. All associated resource plans will 

receive the same completion status. You will be asked whether the resource plans' ETC 

should be set to null. 

In the Management Console, you select the status options which mark the completion 

of a resource plan or job. Here, you also specify whether remaining time budget will be 

added to the Charged value of the last time record that was relevant to accounting if 

time was already recorded for the resource plan ("Externally bill remaining time 

budget when completing a job"). This setting also applies if you specify that 

remaining ETC should not be set to null. 

 Rights: The Resource planning right is required for resource planning. You can assign 

it in the Management Console under User Management in the Other rights tab of the 

user Properties view. Only with this right can users create, open and edit resource 

plans as well as modify a resource plan's ETC value in resource planning views without 

opening that resource plan. Users without this right can record time for their own 

resource plans. To record time for resource plans, writing permissions for the fields 

Total estimate, ETC, Actual, Time budget remaining and Charged are required. 



Project   Project and resource planning in the tree view 

59 

5.5 Resource planning in the Desktop Client 

This section describes the resource planning features in the Desktop Client. 

 5.5.1 Views and features for resource plans (page 59) 

 5.5.2 Resources and items in a job (page 60) 

 5.5.3 The data record window for resource plans (page 62) 

 5.5.4 Resource planning in the tree view (page 64) 

 5.5.5 Settings for resource planning in the tree view (page 66) 

 5.5.6 Resource planning for multiple projects (page 68) 

 5.5.7 Completion grade in the Gantt chart (page 70) 

5.5.1 Views and features for resource plans 

The following standard features are available for resource plans. 

 Data record window with General, Change log and Dossier tabs 

 Primary links to address, project and job, displayed in the tree view and in analyses 

 General links to any other data records 

 Creation in the New menu, in the toolbar of data record windows and list views, in the 

tree view, in the Resources and items tab of the data record window for jobs as well as 

via project and job templates 

 Global search in all fields such as Subject and User. Configurable via Settings > 

Search; search toolbar abbreviation RP 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 
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5.5.2 Resources and items in a job 

In the Resources and items tab of the data record window for jobs, you can see and edit 

the completion grade as well as any resource plans and items for the job. 

 

Completion grade 

You assign completion grades to jobs from 0 to 100 percent in steps of 25. 

 Completing a job: Set the completion grade to 100% or assign a completion status. 

Completing a job via the status will set the completion grade to 100%. Completing a 

job via the completion grade will assign the first available completion status.  

 All associated resource plans will receive the same completion status. 

 You will be asked whether the resource plans' ETC should be set to null. 

 With the Externally bill remaining time budget when a job is completed setting 

the Time budget remaining of each resource plan for which time has already been 

recorded will be added to the Charged hours of the last associated time record 

relevant for accounting (see "General" on page 204). 

Resources 

This list displays all resource plans in a job. 

 Open: Double-click an entry to open it in its data record window. 

 Add: Here you create a new resource plan for a job. 

 Delete: Here you delete the selected resource plan. Time records already created for 

the resource plan are not deleted in the process. 
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When a job is deleted, associated resource plans are also deleted. 

When a deleted job is restored from the recycle bin, associated resource plans will also 

be restored unless they were directly deleted. 

 Split: Here you split the selected resource plan in order to assign part of the working 

time to another user.The Split resource window opens. 

 Enter the workload to assign to the new user in the ETC new field. 

 Enter the new user in the User name new field. 

The given value is deducted from the old resource plan's ETC and transferred to the 

new resource plan as ETC.  Time budget remaining is transferred proportionally. 

 Release: Here you overwrite the ETC field with the Employee's ETC value in every 

selected resource plan in which the latter has been entered. The Employee's ETC and 

Explanation values are deleted in the process. 

 Refresh: Here you apply changes made to the resource plans while the list was opened. 

Items 

This list shows all items in the job. 

 Open: By double-clicking on an entry you open it in its data record window. 

 Refresh: Here you apply changes made to the items while the list was opened. 

Note 

Displaying the completion grade and resource plans requires reading permissions for 

resource plans. Displaying items requires reading permissions for items. 

For users without reading permissions for neither resource plans nor items, the 

Resources and items tab will not be displayed in jobs. 
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5.5.3 The data record window for resource plans 

 

 Subject: The associated project and job are automatically entered as the subject of the 

resource plan. The subject cannot be modified. 

 User: Here you specify the user or resource. A user or resource may have at most one 

resource plan per job. 

 Duration of the job and workload in the job: Alongside the duration of the job the 

remaining workload of the user in the current resource plan is displayed. 

Other resource plans of the users are not considered here. To calculate the workload, 

the ETC value is divided by the sum of the user's working hours during the job. 

 Total estimate: This value is calculated by totalling the remaining workload ETC and 

the recorded hours Actual. 

 Total estimate = ETC + Actual 

 Time budget: This value denotes the total working time negotiated with the customer. 

 ETC: This value denotes the remaining workload. 
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 With automatic planning as well as for resource plans without detailled planning, 

you can directly edit the ETC value. 

Also, in this case, changing the Time budget will adjust the ETC value as follows: 

ETC = Time budget – Actual | ETC ≥ 0 

 The resource plan’s ETC value are reduced by the Actual value of time records for 

the resource plan that are relevant to accounting (see "Relevance to accounting" 

on page 58). With manual detailled planning, the maximum that will be subtracted 

per time record is the value planned for the associated interval (week or month).  

 With automatic planning, you can also edit the ETC value in the tree view (see "5.5.4 

Resource planning in the tree view" on page 64). 

 Time budget remaining: This value is calculated by deducting the recorded order 

value Charged from the time budget. 

 Time budget remaining = Time budget - Charged 

 Actual and Charged: These values hold the total worked hours called Actual and the 

total billable order value called Charged in time records for the resource plan. 

 Only time records relevant to accounting with primary links to the resource plan's 

primary job will be considered (see "Relevance to accounting" on page 58).  

 Time records for sub-jobs of the resource plan's primary job are not considered.  

 % used: This value is calculated as the proportion of working time already recorded 

(Actual) of the time budget. 

 % used = Actual / Time budget (or 0 if time budget = 0) 

 Status: Resource plans are created with the status of their associated job. Changing the 

job's status will also change the status of all associated resource plans. 

You may assign a different status to each resource plan. All status options for the type 

of the associated job are available for selection.  

 Planned working time: Originally planned working time. 

When creating a resource plan, the ETC value is automatically entered in this field, 

adding any Actual hours already recorded for the resource plan’s user and job. 

 Deviating working time: Originally Planned working time minus the current Total 

estimate. Any difference is the result of time records exceeding the value planned for a 

week or month as well as additionally cleared ETC. 

 Estimate and explanation: A user included as a resource can enter an ETC estimate 

differing from the ETC value as well as an explanation for the difference in the data 

record window for time records. If this feature is enabled, the Employee's ETC and 

Explanation fields are displayed for resource plans. The Employee's ETC field is empty 

if no estimate has been given. 
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 Adopt employee's ETC: Here you transfer the Employee's ETC value to the ETC 

field. The contents of the Employee's ETC and Explanation fields are deleted. 

 Parent: Here you can see and alter the primary links of the resource plan as in other 

data records. A resource plan must have a primary link to a job in order to save it. 

 Notes: Here you enter notes for the resource plan. 

5.5.4 Resource planning in the tree view 

In addition to the Gantt chart, you can display a planning view. 

Note 

This feature isn’t available with manual resource planning. 

 

 

 Display resource planning: Here you display or hide the resource planning view. In 

this mode, additional features are available in the toolbar of the Gantt view. 

 Show or hide activity list: Here you display or hide the list of activities and resource 

plans by clicking in a cell of the working time overview below the Gantt chart, the 

associated data records are displayed in the list. 

 Select participants: When you activate the resource planning view, the participants 

of any displayed resource plans will be selected automatically. Here you add users 



Project   Project and resource planning in the tree view 

65 

and resources in order to budget them in resource plans. The Select team option is 

also available in the context menu for the user area to the lower left. 

 Working time in the Gantt chart: For each resource plan, the Gantt chart displays the 

workload per period, e.g., per month. In resource plans for jobs spanning multiple 

months, the hours are distributed to the individual months proportionally. 

 Total workload: Below the tree view, you can see the total workload or disposability of 

the displayed users and resources in the view's timeframe. 

In the tree view's settings, you configure the calculation and display of the workload 

(see "5.5.5 Settings for resource planning in the tree view" on page 66). 

Any activities in the view's timeframe that you have selected in the settings are 

considered, even if they are not displayed in the tree view. 

 Modify ETC: Click a resource plan selected in the tree view to modify its ETC. 

 Click on the desired tree view entry to select it. 

 Click on the entry again to modify the ETC. 

 Enter the desired value and confirm by clicking OK. 

 Budget a resource for a job: You may budget a user or resource for a job in a 

resource plan via drag-and-drop. 

 Click on the user name in the user list on the lower left and hold the mouse button. 

 Holding the mouse button, drag the user to the target job, then  

 Release the mouse button. 

 You are prompted to enter the Time budget. 

 After confirmation, the Time budget will also be entered as the resource plan's ETC. 

The resource plan is added to the job. 

 Divide hours: You may delegate all or some of the budgeted hours by dragging and 

dropping a user on a resource plan in the tree view. 

 Click a user name in the user list on the lower left and hold the mouse button. 

 Holding the mouse button, drag the user to the resource plan to be delegated. 

 Release the mouse button. 

 You are prompted to enter the workload to delegate to the user as ETC. 

Time budget remaining is transferred proportionally. 

 After confirmation, the new resource plan is created. The Time budget and ETC 

values in the old resource plan are adjusted. If no ETC hours remain and no Actual 

hours have been entered for the previous user, that user will be replaced by the new 

user instead of creating a new resource plan. 
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5.5.5 Settings for resource planning in the tree view 

In the tree view's View settings, select Display Gantt chart and Display resource 

planning to activate resource planning when the view opens: 

 

Notes 

This feature isn’t available with manual resource planning. 

Make sure the Resource plan item is selected under Data record type in addition to 

the general options for the Gantt chart and resource planning. 

The workload calculation (see following page) only includes data records for which the 

logged on user has read rights. Additionally, read rights for the Start and End fields of 

the data records are required. 

 

Use the two buttons next to the Display resource planning option to control the 

following resource planning settings: 

 Here you open the Settings for resource planning window. 
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 Include in workload: Here you specify whether appointments, tasks, jobs, projects, and 

holiday entries are considered in the calculated workload. 

 Set filter: You can enter filter conditions for any selected activity type in order to 

limit the considered activities. 

 Calculate from resource plans: Select this option to consider only the ETC values of 

resource plans associated with jobs in the workload instead of the jobs' duration. 

This option is active by default. 

 Only during working hours: With this option, only the portions of each activity's 

duration that overlap with the users' working hours are considered as workload. 

 Show included data records also in tree: Here you display data records which are 

included in the workload calculation but are not part of the tree structure at the 

bottom of the tree view and the Gantt chart. 

 Workload by activity: Here you configure the workload display. 

 Display total column: The total column displays the workload by activity per user 

and for the entire timeframe of the view. 

 Display activities as list: Here you specify whether the list of activities and resource 

plans should be displayed when the view opens. 

 Display working hours: Select this option to display the working hours entered for 

the displayed users in the Workload in hours mode. 

 Select users: When you activate the resource planning view, the participants of any 

displayed resource plans will be selected automatically. Here you add users and 

resources in order to budget them in resource plans. This option is also available in the 

toolbar for the Gantt view and in the context menu for the user area to the lower left. 
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5.5.6 Resource planning for multiple projects 

You can create tree views in your navigator to plan resources for multiple projects. 

Note 

This feature isn’t available with manual resource planning. 

 

 

The features and settings available for such views are the same as for planning resources 

for an individual project (see "5.5.4 Resource planning in the tree view" on page 64 and 

"5.5.5 Settings for resource planning in the tree view" on page 66).  

The following section shows how you create a resource plan tree view. This view displays 

all projects and jobs with open resource plans. 

If you wish to plan resources for projects and jobs that don't have associated resource 

plans yet, create a project or job tree view instead and display resource plans in the view. 

In this case, enter filter settings to make sure the view displays only projects and jobs that 

are relevant for resource planning. 



Project   Project and resource planning in the tree view 

69 

Creating a resource plan tree view 

Proceed as follows to add a resource plan tree view to your program navigator. 

 Right-click on the desired place to call up the context menu. 

 Select Create new view. The view wizard opens. 

 Select Tree view. Then click Next. 

 Select Resource planning. Then click Next. 

 Enter the desired name for the view. Then click Next. 

 At the bottom left, select at least the following data record types. 

 Addresses 

 Projects 

 Jobs 

 Resource plans 

 At the top left, select Display Gantt chart and enter associated Settings (see "Settings 

for Gantt view" on page 46). 

At the top left, select Display resource plan, enter associated Settings and select 

Users (see "5.5.5 Settings for resource planning in the tree view" on page 66). 

 At the top right, under Expand to, select the Completed option to directly display all 

resource plans when the view opens. 

 In the default settings, the tree view will initially only display addresses that have 

resource plans. To display the actual resource plans, you must first expand the 

associated addresses, projects and jobs.  

 Click Next. 

 Enter the filter condition Status – not equal – Completed. 

 This will only display open resource plans, regardless of whether ETC remains or the 

associated job is in the past. 

 With the Adopt to current periode button in the toolbar for the Gantt view, you 

can extend selected projects and jobs, such that time may once more recorded for 

associated resource plans (see page 45). 

 Alternatively, you can create jobs and resource plans to set the ETC to zero.  

 Click Finish to create the view. 
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5.5.7 Completion grade in the Gantt chart 

You assign completion grades to jobs from 0 to 100 percent in steps of 25 percent. In the 

job, you can see and modify the completion grade in the Resources and items tab. 

In the Gantt chart, the completion grade is displayed as a green filling bar in the job. You 

alter the completion grade using your mouse in the following way. 

 Move the mouse pointer over the right border of the green filling bar until it switches 

to  Completion grade mode. In jobs without a green filling bar, move the mouse 

pointer over the inner left border of the job. 

 Press the mouse button and hold it until the Completion grade overlay box appears. 

 Holding the mouse button, alter the completion grade by moving the mouse pointer 

left or right. 

 Release the mouse button in order to enter the selected Completion grade in the job. 

 Completing a job: Set the completion grade to 100% or assign the job a completion 

status in the tree view to complete it. 

The selected completion status (or if the completion grade was set to 100%, the first 

available completion status) will be set. All associated resource plans will receive the 

same status. You will be asked whether remaining ETC should be deleted. 

With the Externally bill remaining time budget when a job is completed setting, the 

Time budget remaining will be added added to the Charged value in the last time 

record relevant to accounting for each resource plan for which time has already been 

recorded (see "Completion grade and completion of jobs" on page 58). 
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5.6 Resource planning in the Web Client 

In the Web Client, resource planning apps are available under Project management. 

 5.6.1 Resource plans (page 71) 

 5.6.2 Resource planning (page 72) 

5.6.1 Resource plans 

With the Resource plans app in the Project management app group, you can see and 

edit existing resource plans as well as create new ones. 

 

 In the Resource plans app start, you have access to your resource plans and associated 

views. 

 Click on the eye icon to create a new list view for resource plans. 

 Click on a resource plan to open the detail view. You can also edit or delete the 

resource plan here. 

 Click on the plus icon [+] to create a new resource plan. 

 You can can also create resource plans directly for jobs. To do this, in the job's detail 

view, open the action menu with the three dots [...] and select Create > Resource plan. 

Resource plans assigned to a job will be displayed in the job's detail view. 

Click on the question mark at the top right to open the online help pages for more details. 
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5.6.2 Resource planning 

The Resource planning app in the Project management group displays planned 

workloads and holidays in the selected time period per employee, project and job. 

 

Open the app by clicking on the associated tile. 

 

Please note that creating and editing resource plans requires edit rights for this data 

record type and the ETC field. 

Displayed data records 

The displayed workloads and charts include:  
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 Open resource plans (with manual planning: including past open ETC values) 

 Appointments starting on or after the current day (including appointments for the 

current day that are already over) ,for which Nominal costs has been selected  

 Vacation days starting on and including the current day from holiday entries 

The app displays your own resource plans by default. Alternatively, you can open the view 

via Display planning in the radial menu for a project, job or employee. The view will then 

adopt the associated user or participants of the selected job or project. 

You may select different employees via the user selection at the top right. 

View mode and start date 

Click on the Week or Month buttons to switch view modes. 

Click on the calendar sheet button to select a start date in the calendar sheet view. 

Click on the Today button to switch to the current date. 

Select a week or month in the timeline below the view to switch to an earlier or later week 

or month (depending on your view mode). 

Number of periods and displayed columns 

Click on the slider icon to open the view’s settings and configure the number of periods 

and the resource plan fields for workload key figures to display as columns:  

 Total estimate: Current planning of recorded working time Actual plus ETC.  

 Actual: Recorded working time.  

 ETC: Currently planned ETC For manual planning, the sum of working time per period.  

 Employee's ETC: Where appropriate, this is the deviating estimate for ETC, estimated 

by the respective employee.  

 Time budget remaining: Time budget minus any accountable Value.  

 Value: Externally accountable recorded working time.  

 Time budget: Customer's authorized working time 

 Deviating working time: Originally Planned working time minus the current Total 

estimate. Differences are due to time records exceeding values planned for the 

associated week or month or additionally cleared workload (ETC).  

 Planned working time: Originally planned working time.  

Creating new plans and editing the planning 

Right-click on a project or job in the tree view to open the radial menu, where you can … 
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 … assign new workloads (Create new plan)… 

 … and distribute existing workloads (Split efforts). For this action, you specify the 

portion of the workload (ETC) to distribute and the User to distribute it to.  

The other planning values of the resource plan are split in the same proportion.  

Left-click on a job in the tree view to open the Edit planning window: 

 Here you can edit the job’s Subject, Start and End as well as the resource plan’s Time 

budget, ETC and User (if there are no associated time records yet).  

 You can also reset here the manual planning entered for the resource plan.  

Gantt chart 

In the Gantt chart you can see:  

 Duration of projects and jobs 

 Resource plan hours for projects and jobs, appointment hours and holiday hours per 

week or month 

You can’t change the duration of projects and jobs in the Gantt chart. 

You can directly edit workloads per week or month with manual distribution (see below). 

Automatic workload distribution 

Workloads are initally distributed evenly over the weeks during the associated job’s 

remaining duration with regard to employees‘ working hours and public holidays.  

Remaining ETC of a job which is completely in the past will be displayed in the last 

associated week or month, depending on your view mode. 

Manual workload distribution 

With manual resource planning, you can enter person days per week or month: 

Note 

This feature is optional in version x11 and requires the database update for version 

x11.1.7. If your database has been created with a version less recent than x11.1.7, you 

must also activate the manual distribution in the Management Console (see „10.5 New 

features and fields in Project x11.1.7“ on page 223 for details). 

 

 Click in a field to enter planned workloads.  
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 Confirm by hitting [Return] or by clicking on the check mark icon. This will select the 

next period or resource plan.  

 Cancel by hitting [Esc] or by clicking on the cross icon.  

 In the Month view, workloads you have entered per week are added up and displayed 

per month.  

When overwriting week values combined this way in the Month view, the associated 

weekly values will be replaced by the new monthly hours.  

 In the Week view, workloads you have entered per month are distributed equally over 

the weeks in each month with regard to working hours and public holidays.  

For the current month, this distribution starts in the current week.  

When overwriting distributed values in the Week view, the associated monthly values 

will be replaced by the new weekly hours.  

Remaining workload entered for a past month will be associated with and displayed for 

the last week of that month.  

 You can enter workloads outside the original job duration. 

This will extend the job as well as set zero workloads for any weeks or months between 

the job’s original and the new start or end date. 

When decreasing a job’s duration, workloads entered outside the new duration won’t 

be deleted automatically. You can manually delete such workloads by overwriting them 

with zeroes.  

 All entered workloads are saved relatively to the job’s start date. Therefore, postponing 

a job by shifting it’s start date will also shift associated workloads.  

Please note that this may spread workloads entered for one week over two, if, for 

example, you shift a job’s start date from Monday to Wednesday. 

Likewise, workloads entered for one month may be spread over two months, if, for 

example, you shift the job’s start from the first to the fifteenth of a month.  

 If you have entered workloads manually, the ETC field of the resource plan displays the 

sum of these workloads and can no longer be edited directly.  

 Click on a job in the Resource planning view to open the Edit planning window.  

Here, you can delete the manual planning for the associated resource plan.  

To do this, click on the Reset the manual distribution button next to the ETC field.  

You can then once more edit the ETC field directly. The entered value will be evenly 

distributed over the job’s remaining duration again with regard to working hours and 

public holidays. 
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Time records and overbooking 

Time records that are relevant for accounting and are entered for a job with a resource 

plan reduce the planned value in the associated week.  

With automatic or monthly planning, time records exceeding the planned value assigned 

to a week via automatic distribution reduce the resource plan’s ETC value (for automatic 

planning) or the remainder entered for the associated month (for monthly planning).  

In this case, the difference will successively be deducted from the remaining weeks 

starting with the last week of the month (for monthly planning) or the job duration (for 

automatic planning), and going backwards.  

Example: a job spans three weeks, starting with the current one. A total ETC value of 3 pd 

results in 1 pd per week. If 2.5 pd worth of time records are now entered in the first week, 

this results in a difference of 1.5 pd. This difference is first deducted from the last week (1 

pd – 1.5 pd = 0 pd, remainder 0.5 pd). The remainder of 0.5 pd is deducted from the 

second week. The resulting ETC spread over three weeks is 0 pd, 0.5 pd, 0 pd.  

The maximum amount of time subtracted from the total ETC is the amount of time 

planned for the associated week (with weekly planning), month (with monthly planning) or 

the total ETC (with automatic planning). 

Workload charts 

The right hand side colored charts in the rows displayed for users and the Team at the top 

show the availability, global utilization, remaining availability and overload of displayed 

employees according to resource plans, appointments and holidays displayed in the view. 

 For each employee, a separate chart of their availability and utilization is displayed.  

 The Team row displays the availability and utilization of all displayed employees. These 

values are summed up over the values displayed for the individual employees.  

 The availability is displayed as a horizontal green line corresponding to the working 

hours in every period. Public holidays lower the availability.  

 Workload within availability is displayed as a green column below the availability line.  

Overload is displayed as a red column above the availability line.  

Workloads include only hours displayed in the Gantt chart for resource plans, 

appointments and holidays. 

 Click on a chart segment to display the availability and utilization in the associated 

period in numbers.  

Online help 

Click on the question mark at the top right to open the online help pages for more details.  
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6 Using project and job templates 

The following sections describe the features for project and job templates: 

 6.1 Using project templates (page 77) 

 6.2 Editing a template (page 79) 

 6.3 Editing a project in the data record window (page 85) 

 6.4 Adding or continuing a workflow (page 86) 

 6.5 Using job templates (page 86) 

6.1 Using project templates 

When you create a project, the selection of project templates opens first. 

 

Under All templates, you can see all templates to which you have access. Select a folder 

in order to only display the templates it contains. 

 Continue with selection: Here you create a project from the selected template. 

 Continue without a template: Here you create a project without a template. You can 

add a template later (see "6.4 Adding or continuing a workflow" on page 86). 

 Always create projects without a template: Select this option to disable template 

selection. You can reactivate in your settings (General > Deactivated messages). 

 Cancel: Here you close the template selection without creating a project. 

In the User Management area of the Management Console, you can assign permissions 

for reading, inserting, changing and deleting of project and job templates. 
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6.1.1 Creating and editing templates 

For creating and editing templates, the following features are available here. 

 Create new template: Here you create a new template in the template editor. 

 Import project as a template: Here you open a list for selecting the project to import. 

The selected project is loaded into the template editor with its tree structure. 

 Edit template: Here you open the selected template in the template editor. When you 

click OK in the template editor, changes are saved and you get back to the template 

selection. 

 Delete template: Here you delete the selected template. The Continue workflow 

feature will then no longer be available for associated projects (see "6.4 Adding or 

continuing a workflow" on page 86). 

 Duplicate template: Here you create a copy of the selected template. 

 Change access rights for template: New templates are initially owned by the user 

who created them. Here you open the Select team window in order to set access 

permissions to the template. The Standard permission is used. 

6.1.2 Organizing templates in folders 

For organizing your templates in folders, the following features are available here. 

 Create folder: Here you create a new folder. 

 Move template to folder: Hold mouse button while dragging a template to a folder. 

 Detach template from folder: To detach a template from a folder, open the 

contraining folder and hold the mouse button while dragging the template to the All 

templates entry. 

 Rename folder: To rename a folder, select it and click it again. 

 Delete folder: Here you delete the selected folder as well as any contained folders,  

project and job templates. Please note that the same folders are used for project and 

job templates, so it's possible to delete templates not visible in the current view. 

 Change access rights for template: New folders are initially public. Here you open the 

Select team window in order to set access permissions to the folder and all subfolders. 

This permission only entitles users to see the folder structure. Separate permissions are 

distributed for the contained templates. 
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6.2 Editing a template 

In the template editor, you create and edit project and job templates. 

The template editor opens when you create a new project or job from any template in 

which the Create template directly option is not selected. 

 

 Create template directly: Select this if projects created from this template should 

open the template editor first. 

 Create predecessor/successor links: Select this to create time relations between jobs 

as predecessor/successor links (see "5.2.3 Predecessor and successor" on page 47). 

 OK: Create the project from the template (Create project window), confirm creating 

additionally selected project steps (Continue workflow window) or save changes in the 

template and get back to the template selection (Edit template window). 

 Cancel: Cancel creating or extending the project or editing the template without 

committing your changes. 
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6.2.1 Editing a project in the tree view 

The following features are available in the tree view and the associated toolbar. 

 Insert data record: Click on the symbol of a data record type to create a new data 

record of this type for the selected data record. 

 Jobs are created in the project or in another job. 

 Tasks are created in the project or in a job. 

 Appointments are created in the project or in a job. 

Note 

Creating appointments via project and job templates isn't supported when you are 

using the Exchange sync module. 

 

 Phone calls are created in the project or in a job. 

 Documents are created in the project or in a job from templates. Select a template 

and click OK. Click Edit template in the data record editor to the right in order to 

open the document template in the associated data record window. 

 Item groups are created in the project or in a job. Sub-groups for items are not 

supported in project and job templates. 

 Items are created in the project, in a job or in an item group. 

 Resource plans are created in a job. Click on the User button in the data record 

editor to the right in order to enter a user, a resource or a role (see "Using roles as 

placeholders" on page 82). 

 Exclude data records from creation: In the box next to each data record, you control 

whether the data record will be created along with the project or job. 

 Continue workflow: Data records that were excluded from creation at first can later 

be added by clicking on the Workflow button in the toolbar of the data record 

window for projects (see "6.4 Adding or continuing a workflow" on page 86). 

 Automatic creation: In the Automatic creation tab to the right of the template 

editor, you select status options whose assignment to the project causes the data 

record selected to the left to be created automatically (see "Automatic creation by 

status" on page 84). 

 Modifying links and order of data records: Via drag-and-drop, you can change a 

data record's association or the data records' order. To do this, click on the entry to 

move and, while holding the mouse button, drag it to the desired place. 

 Change association: Drag a data record on the project or on another job to change 

the association. 
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 Change order: Drag a task, an appointment, a phone call or a document to another 

data record of one of these four data record types to insert the moved data record 

after the other one. 

 Association and order of jobs: If you move one job onto another, a menu opens. 

Here you select whether the moved job should be inserted before, after or in the 

target job as its sub-job. 

 Adopt items: Here you transfer items from a project into a project template. Select the 

project in the Search window. Transfer the positions by clicking Accept & Close. 

 Deleting data records from the template: You delete the selected data record from 

the template by clicking on the Delete button in the toolbar, by pressing the [Del] 

key or via the context menu. Before deletion you are asked to confirm. As all changes 

the deletion is only applied when the template is saved. 

 Open tree: Here you expand all branches. 

 Close tree: Here you close all branches. 

 Save changes in the template: When creating or editing a template, clicking OK saves 

the template. When creating a project or job from a template, changes are not saved 

automatically. In this case, click Save changes in the template to save the changes. 

 Display/hide Gantt chart: Here you display a Gantt chart instead of the data record 

editor in the right half of the window. The current date is displayed as project start as if 

the project had just been created. All other data records are displayed according to the 

time relations entered for them (see "Entering time relations" on page 82). 

It is not possible to adjust the time relations in the Gantt chart. 

 Check time relations: Here you check the consistency of entered time relations (see 

"Entering time relations" on page 82.) Any insosistencies will be displayed. 
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6.2.2 Editing data records in the data record editor 

In the default setting, the data record editor is displayed to the right. Via the General and 

More tabs you access any preallocatable fields. 

Note 

Input helps of the Selection tree type are not fully supported in the Category field. If 

such an input help has been entered for this field, only top level items will be available 

for selection. 

 

The following sections describe special features of the data record editor. 

 Transfer participants: This is available for jobs, tasks, appointments, documents and 

phone calls. Here you assign to the selected data record the participants and resources 

as well as the Maximum external access right of its parent data record. 

 Using roles as placeholders: By clicking on the Participants button you open the 

selection of participants. In addition to users and resources, roles are available here. 

These are replaced by users and resources when the project is created. Via the list to 

the left you create roles, delete or rename existing roles. Via the Rights button you 

limit data record access for the user assigned in a role. The External access menu is 

synchronous with the Maximum external access right menu and serves for limiting 

external access rights of other users to data records of the future participant. 

 Entering time relations: When a project is created from a template, the current point 

of time is inserted as the project start. The project end results from the duration which 

you specify in the template. The project start and end may be modified in the project's 

data record window when it is created.  

When you save the project, all other data records will be created. You either specify 

associated dates as fixed dates to be entered when the project is created from the 

template or as time relations depending on the project start or end. 

 Specifying the project duration: Click on the Project end button to open the 

Enter time relation window. 
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Select Query date when creating new records if users should be prompted to 

enter the project end whenever a project is created from the template. Under 

Default value, you may also enter a default value for the project end.  

Select Enter a date in relation to a fixed time (days, months and years) in order 

to enter the project's duration instead of the project end. The Ignore weekends and 

holidays option only affects the days specified. The options for other points of 

reference are disabled when entering the project end as you can only refer to the 

project start here. 

 Specifying the start and end of other data records: Select a data record in the 

tree view. Then click on the button with the date you wish to specify in the data 

record editor. The Enter time relation window opens. 

 

Select Query date when creating new records if users should be prompted to 

enter the date whenever a project is created from the template. Under Default 

value, you may also enter a default value for the date. 

Select Enter a date in relation to a fixed time (days, months and years) in order 

to enter the date in relation to a point of reference. Like when entering the project 

end, the Ignore weekends and holidays option only affects the days specified. 

Then select the desired point of reference. 

With the Current date option, you may refer to the respective date of creation for 

data records you exclude from creation at first in order to add them later via 

Automatic creation by status or Continue workflow. 

Moreover, the beginning and end of the project as well as the beginning and end of 

any other associated data records are available for selection unless a time relation 

referring to the current record has already been entered for them. When you enter 

the end date, you may also refer to the beginning of the data record itself like when 

entering the project end. 

 Set time: For jobs, tasks, appointments and phone calls, you set the reminder time 

in relation to the data record's start or end. 

 Variables for address fields, project subject and roles: The following sections 

describe the inclusion of placeholers in data record fields. 
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 References to fields: You may refer to any fields of all parent data records in the 

Subject and Notes fields. References will be replaced when the record is created if 

the required links are present (e.g., the project has a primary address). 

The references must be of the form [Data record:Field]. 

For example, [Address:Company] will be replaced by the company name of the 

primary address. 

 Roles in text fields: Roles created in the team selection may be embedded in text 

fields (e.g., to enter the selected project manager in the Person responsible field). 

The references must be of the form #Role#Name. 

For example, #Role#Project manager will be replaced by the user selected for 

the Project manager role. 

 Automatic creation by status: Data records initially excluded from creation may be 

created automatically when the project is saved with a status for which this is intended. 

If roles are included, the user is asked to select participants and resources. 

If you have assigned a type to the project in the data record editor, the associated 

status options are available for selection for other data records in the Automatic 

creation tab. Here you select the status options whose selection in the project should 

cause the selected data record to be created automatically. 

 Create with all subordinate data records: Select this option if the automatic 

creation of a job should include the creation of its subordinate data records. 
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6.3 Editing a project in the data record window 

After selecting a template and specifying any additional information that may be required, 

the project opens in its data record window. 

 

 Adjust start and end: The current date is automatically entered as start. The end is 

defined by the duration entered in the template and may only be modified after saving. 

If you modify the start prior to saving, the end is shifted accordingly. 

 Save project: If desired, make further entries for the project. Save it in a final step by 

clicking Save or Save&Close. 

Any other data records in the template that were not excluded are now created. 
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6.4 Adding or continuing a workflow 

Using the Workflow button in the toolbar of the related data record window, you extend 

a project in the template editor. To do this, the project template that was used must still 

exist. For projects not created from a template or whose template was deleted in the 

meantime, the template selection opens first. 

The template editor opens in the Continue workflow mode in any case. 

 Data records that were already created can no longer be modified here. 

 All data records that have not yet been created or that have meanwhile been deleted 

are available for creation. 

 Data records under a job cannot be created without the associated job. The same holds 

true for items in item groups. 

 All features of the template editor are fully accessible in this view. However, changes 

made to the template cannot be saved. 

 Select the data records to create by clicking in the boxes next to them. 

 Confirm the project's extension by clicking OK. 

If you have selected data records for creation to which roles have been assigned, you are 

now asked to select the intended participants and resources. 

6.5 Using job templates 

For job templates, the same features are available as for project templates. 

6.5.1 Project and job templates 

The following segments briefly describe the interaction, differences and similarities of 

project and job templates. 

 Job templates in projects: You may use job templates in different projects regardless 

of the use of project templates. When a process changes, you only need to adjust one 

job template instead of several project templates. 

 Job templates without projects: Jobs from templates may also be used without an 

associated project. 

 Turning off the template selection: The template selection for jobs may be turned off 

independently from the template selection for projects. 

 Continue workflow: In the toolbar of the data record window for jobs, the Workflow 

button is available as it is for projects. Click this to extend a job created from a template 

or to add a template to a job which was initially created without using a template. 
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6.5.2 Specifics when using job templates 

The following specifics apply to job templates. 

 

 Template folders for projects and jobs: The same folders are used for project and job 

templates. Deleting a folder will also delete any project and job templates it contains. 

Please note that you may delete templates not currently visible this way. 

 Job is point of reference for all time relations: When you enter time relations, the 

topmost job is the point of reference for any other data records. You therefore start by 

entering the job's duration. All other data records relate to the job or to other data 

records associated to the job. 
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7 Recording and analyzing project costs 

This chapter describes the features for time records, expenses and external services as well 

as the associated reports for addresses, projects and jobs. 

Most of these features are available in both the Desktop Client and in the Web Client. 

Please note that you may access the billing features in the Desktop Client only. 

 7.1 Time records in the Desktop Client (page 88) 

 7.2 Time records in the Web Client (page 106) 

 7.3 Expenses in the Desktop Client (page 112) 

 7.4 Expenses in the Web Client (page 123) 

 7.5 External services in the Desktop Client (page 124) 

 7.6 External services in the Web Client (page 129 

 7.7 Reports for addresses, projects and jobs (page 130) 

 7.8 Billing in reports (Desktop Client only) (page 143) 

7.1 Time records in the Desktop Client 

The following sections describe the features for time records in the Desktop Client: 

 7.1.1 Views and features for time records (page 89) 

 7.1.2 Creating time records (page 89) 

 7.1.3 The data record window for time records (page 90) 

 7.1.4 Time record calendar (page 96) 

 7.1.5 Billing time records (page 101) 

 7.1.6 Defining hourly rates for addresses and projects (page 103) 

 7.1.7 Time record details in projects and jobs (page 104) 

 7.1.8 User settings for time records (page 104) 
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7.1.1 Views and features for time records 

The following standard features are available for time records in the Desktop Client. 

 Data record window with General, Tree, Change log and Dossier tabs 

 Type for unambiguous labelling 

 Status for billing and approval processes 

 Primary links to address, project and job, displayed in the tree view and in analyses 

 General links to any other data records 

 Creation in the New menu, the toolbar of data record windows and list views, in the 

tree view and in the time record calendar 

 Global search in all time record fields such as Subject, Start and End. Configurable via 

Settings > Search; search toolbar abbreviation TR 

 Views in the program navigator (list, dossier, calendar) and in the link navigator (link 

list, calendar) 

 Time zone support (Start and End fields in client time zone with Timezone module) 

7.1.2 Creating time records 

You can create time records for addresses, appointments, documents, e-mails, holiday 

entries, jobs, opportunities, phone calls, projects and tasks. 

 Create time record: To create a time record for another data record, click on the 

Create time record button in the toolbar of its data record window or a list. 

 Start recording time: To start recording time in the background, proceed as follows. 

 Open the desired data record in the data record window or mark it in a list view. 

 Click on the little arrow next to the Create time record button to open the 

associated menu. 

 Select the Start recording time option in the menu. 

The data record window for a new time record opens. The To and Actual fields are 

updated automatically. A little green man next to the clock in the tray to the bottom 

right displays that time is being recorded. 

 Exit: By clicking on this button next to the To field you stop the counter. You may 

now edit and save the time record. If you close the data record window without 

saving, the time record is dropped. 
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7.1.3 The data record window for time records 

 

 The time record's Subject will initially be transferred from the associated data record. 

As for any data record, you may modify it as desired. 

 User: Each time record has exactly one participant. When you create a time record, you 

will be entered here. After saving, the participant can no longer be changed. 

 The Type specifies the activity and determines internal and external hourly rates. 

 When you create a time record, the type of the associated data record is adopted if 

a time record type with the same exists. 

 The type may be modified as long as the time record has not been billed. 

 You may use the Status to implement billing and approval processes. 

 Start and End date: You may modify the start date as long as the time record has 

not yet been billed internally. 

The end date is adjusted automatically. You can not change it manually. 

In time records spanning two calendar days (e.g., from 6:00 PM to 2:00 AM), the end 

date is set to the following day. 

 The Actual working time, which will be billed internally, is determined by the time 

record's duration that you enter via the date and the From and To fields. 
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 Granularity and minimum: In the Management Console, you specify the time 

record granularity between 1 second and 1 hour. This is the precision of the From, 

To and Actual fields and therefore the smallest recordable period. 

 Maximum: The Actual working time to be recorded in a time record may amount to 

a maximum of 24 hours minus the granularity, spanning up to two calendar days. 

 Rounding: Time records below the specified granularity will automatically be 

corrected to the smallest admissible value. For example, with a granularity of 1 

minute, entries of 1 second will always be set to 1 minute. Above the specified 

granularity, time records are rounded commercially (e.g., with a granularity of 1 

minute, an entry of 0:01:30 will be rounded up to 2 minutes). 

 Start and end of new time records: Time records for appointments, phone calls 

and holiday entries will adopt the start and end of the associated data record. 

When you record time in the calendar, the marked interval will be adopted. 

Otherwise, the end of your previous time record will be entered as start and the 

current time will be entered as end. The first time record of the day will adopt the 

start of your working hours as start. 

 Working hours: The working hours are read from the settings provided in the 

Management Console under Time record > Working hours. 

For users that have no working hours set there, the working hours stored in the user 

settings in the Calendar tab are accounted for. 

 Person days (PD): In the default setting, a person day spans 8 hours. You may 

change this in the Management Console under Time record > General. 

 Overlap check: If overlaps with other time records are detected while trying to save 

a time record, a list of the overlapping time records is displayed. You can turn the 

overlap check off in the Management Console under Time record > General. 

 Charged: In addition to the Actual working time, each time record has an externally 

billable Charged order value. This is initially zero and may differ from the actual hours 

or be set equal to it. The order value isn't limited to 24 hours. 

 Apply Actual as Charged: Here you transfer the Actual value to the Charged field. 

 The Parent field displays as in other data records the time record's primary links. If 

desired, you modify the primary links using the associated features. 

 Internal and external description: Record here additional notes for the time record. 

The external description is provided for performance records. 

 Copy external or internal description: Here you overwrite the associated notes 

field with the content of the respective other field. 



Project   Recording and analyzing project costs 

92 

 Job: When you record time for a resource plan, the Job panel is displayed in the time 

record's data record window. 

 

 Completion grade and status: Here you see the job's completion grade and status. 

Entered values will be applied when saving, which may complete the job. 

 Complete job: Set the completion grade to 100% or select a completion status to 

complete the job when the time record is saved (see "Completion grade and 

completion of jobs" on page 58). 

 Relevant to accounting: This shows whether the time record will be added to the 

resource plan, depending on its type (see "Relevance to accounting" on page 58). 

 By working time: This shows whether the time record's primary job has the Charge by 

working time option selected. The Actual value will then be copied to the Charged 

field if this is configured for the time record's type, regardless of the time budget and 

overbooking settings (see "7.1.7 Time record details in projects and jobs" on page 104). 

This also disables the overbooking check. 

 Working time: The ETC, Time budget remaining, Actual and Charged values come 

from the resource plan. Under Job, the current time record is always considered even if 

you have not yet saved it. 
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 ETC: Here you see the total currently estimated working time to completion. This is 

reduced by time records in the planning period that are relevant to accounting. 

Time records that are relevant to accounting first reduce the ETC value in the 

associated week. With automatic or monthly planning, time records that are relevant 

to accounting and exceed the ETC value planned for the associated week then 

reduce the ETC values planned for the weeks during the remaining duration of the 

job (with automatic planning) or month (with monthly planning). 

See section „Time records and overbooking“ on page 76 for details about this. 

 Actual: Here you see the working time already recorded in the resource plan. 

 Time budget remaining: Here you see the time budget minus the order value. 

 Charged: Here you see the order value already recorded in the resource plan. 

Employee's ETC: Here you enter an estimate for the remaining working time. You 

must also enter a reason to confirm the estimate. After you have confirmed, the 

estimate will be stored with the resource plan. 

You must first activate the estimate in the Management Console under Project > 

Resource planning > Booking of time recordings. 

 Bill working time externally: In addition to the relevance for accounting, under 

Project > Resource planning > Booking of time recordings in the Management 

Console, you specify for which time record types the Actual value will automatically 

be transferred to the Charged field. 

 The Overbooking check applies when saving a time record. When active, this setting 

prevents that time records overbooking the associated resource plan can be saved. This 

is the case when the resource plan’s Actuals (including the current time record) exceed 

its Time budget and no additional ETC has been cleared. 

 In the Management Console, you can activate or deactivate this check and specify a 

percentage by which overbooking is permissible (e.g., with a 50% setting, a resource 

plan with a Time budget of 1 pd may be booked with total Actuals of up to 1.5 pd). 

You can find these settings under Project > Resource planning > Booking of time 

recordings (see "Booking of time recordings" on page 206). 

 Additional Actuals of a new or modified time record never count as overbooking if 

they don’t exceed the the resource plan's ETC before the change. 

 The Charge by working time option, if set in the associated job, disables the check 

(see "7.1.7 Time record details in projects and jobs" on page 104).  
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 Recording by duration: via the Project time recording app in CAS genesisWorld 

Web, with the other right of the same name, you can create time records by duration 

for project jobs (see "7.2.1 Project time recording" on page 106). Such time records only 

have a Duration (Actual field) and Date (Start field) instead of a start and end point. 

 

With suitable access rights, the time records will be displayed in the Desktop Client, 

e.g., in search results or reports. 

With the Project time recording other right, you have access to the following fields 

and features in the Desktop Client: 

 Subject (adopted from the associated project and job) 

 Status 

 Duration (Actual), Charged 

 Job fields (% completed, Status) 

 Internal and external billing 

 Internal and external text 

You can never edit the time records' user, type, date (start) and primary links (parent) 

for time records by duration. 

Without the Project time recording right, all fields and features are locked. 
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 To destination, from destination and break for appointments: Each user may 

activate the recording of trips to and from the destination and of a break for 

appointments (see "7.1.8 User settings for time records" on page 104.) 

 

To do this, select the respective option in the data record window. 

 To record the trip to the destination, you enter the start or duration of the trip. 

 To record the trip from the destination, you enter the end or duration of the trip. 

 If the trips to or from the destination should be billed externally, enter the billable 

period in the Charged field or apply the duration as order value by clicking on the 

Copy duration to charged time button. 

 To record a break, enter the start and end of the pause. In the default setting, the 

pause stretches from 12:30 to 13:30. 

Trips to and from the destination will be created as separate time records when you 

save the record. If available, the Travel time type will be assigned automatically. 
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If you specify a pause, two time records will be created, one before the pause and one 

after the pause. If the total of Charged hours exceeds the Actual hours of the first 

record, the remainder will be booked on the second record. 

The Internal text and External text fields as well as fields placed with Form Designer 

will be transferred to all time records created this way. 

7.1.4 Time record calendar 

You access the time record calendar via the program navigator, in the dossier and in the 

Time records tab of data record windows. 

 Program navigator and dossier: The calendar is available in both the program 

navigator's view wizard and the dossier's view wizard as Calendar for time recording. 

 Data record windows: The calendar is available in the Time records tab of the data 

record windows for addresses, projects, jobs, tasks, appointments, documents, phone 

calls and holiday entries. 

 Settings: In your user settings, you specify under Modules and Solutions whether 

the Time records tab is displayed in data record windows. Here you also specify the 

view's presettings (see "7.1.8 User settings for time records" on page 104.) 

 

 Free time and working hours: Free time and working hours are displayed with the 

same colors as in the calendar view for appointments, holidays, jobs and phone calls. 

You may change the colors in the Settings under Calendar > Colors.  

Other color settings of the default calendar won't be used.  
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If available, the current working hours as entered in the Management Console under 

Time record > Working hours are used. For users having no working hours set there, 

the working hours stored in the Settings in the Calendar tab are displayed. 

 Colors 

 Green: linked time record 

 Blue: unlinked time record 

 Red: time record for current data record (in data record windows) 

Note 

Please note that a time record's associated data record can not be changed at a later 

time if it stands below the job level. 

For example, a time record created for an appointment stays associated with that 

appointment, even if the time record's primary links change or a general link between 

the time record and another data record is created. 

Time records created for an address, a project or a job, as well as time records which 

were not created for another data record, may be assigned to another address, project 

or job by changing their primary links. 

 

 Select start date: At the top right, you select the view's start date. 

 Statistics: The statistics display information about your working hours and your time 

records in the displayed period and in the current month. 

 Working hours: your working hours in the displayed period. Below it, your total 

working hours in the selected month are given. 

 Recorded time: the total duration of your time records in the displayed period.  

Below it, the total duration of your time records in the current month is given.  

Please note that time records by duration created in the Project time recording 

app in CAS genesisWorld Web will be included in both sums (see "By working 

time" on page 92).  

Instead of a start and end time, such time records only have a date and a duration. 

They are not displayed in the time record calendar but their duration is included in 

the recorded time. 

 Time records: the number of your time records displayed in the calendar. Below it, 

the number of displayed time records without an associated data record is given.  

 Select user: Here you access other users' calendars. 

 Close shared calendar view: Here you reset the view to display your own time 

records again. 
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Creating and editing time records 

The following sections describe the features for creating and editing time records in the 

time record calendar. 

 Create new time record: Here you create a time record in the marked interval. 

Alternatively, you create a time record in the marked interval by right-clicking and 

selecting the Create new time record option in the calendar's context menu. 

 Create new time record from history: With this option in the calendar's context 

menu, you create a new time record for one of the data records for which you have 

last recorded time. Only the primary links and the type of the original time record 

are adopted. 

 Create new time record for resource plan: With this option in the calendar's 

context menu, you record time for a current resource plan. 

 Fill gaps: If you mark a period in which time records and gaps alternate and create a 

time record from history or for a resource plan, each gap in the marked period will 

be replaced by a corresponding time record. 

This also applies when overlap checks are disabled for time records. 

 Create new time record for the corresponding record: Open a time record's 

context menu and select the Create new time record for the corresponding 

record option to create a time record for the same data record. 

 Change link: You may relink time records via the history. To do this, open the context 

menu by right-clicking on the time record whose link you wish to change. Select the 

desired option in the Change link sub-menu. 

 Open corresponding record: Here you open the data record for which the time record 

was created. 

 Open time record: Here you open the selected time record. Alternatively, you open 

time records by double-clicking on them or via the context menu. 

 Delete time record: Here you delete the selected time record. Alternatively, you delete 

time records via the context menu. Before the time record is deleted you are asked for 

confirmation. 

 Record appointments: Here you record time for all appointments in the displayed 

period. If there is a time record type of the same name, the type of each appointment is 

adopted as the type of the associated time record. 

 Record phone calls: Here you record time for all appointments in the displayed period. 

If there is a time record type of the same name, the type of each phone call is adopted 

as the type of the associated time record. 

 Record holiday: Here you record time for holiday entries in the displayed period. In 

the process, a separate time record is created for each day off, spanning from start to 

end of the participant's working hours. 
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This operation will be available even if part of the holiday entry to record is farther in 

the future then time records may be created (see "Time window for the creation and 

editing of time records" on page 210) if time is to be recorded for a current holiday or a 

holiday starting on the next work day in the time record calendar. 

Note 

In the Management Console, under Time record > Calendar, you specify which 

appointment phone call and holiday types may be recorded here (see "9.4.3 Calendar" 

on page 213). If you wish to group holiday records by projects in reports, you may also 

select projects there for which leaves should be recorded. If a participant of such a 

project records his leave by clicking on Record holiday in the calendar, the holiday 

records will be automatically assigned to the project. 

 

 Print: Here you print the displayed calendar page. Please note that the Print option in 

the File menu is not supported here. Use the Print button in the view's toolbar. 

 Refresh view: Here you apply changes that were made to the time records while the 

view was open. 

 Change points of time: move time records or change the duration via drag-and-drop. 

 Move time record 

 Click on the time record's start and hold the mouse button. 

 Holding the mouse button, move the pointer to the desired start time. 

 Change duration 

 Click on the time record's end and hold the mouse button. 

 Holding the mouse button, set the desired duration by moving the mouse. 
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Creating a time record calendar in the program navigator 

You insert the view in your program navigator in the following way. 

 Right-click on the desired place to call up the context menu. 

 Select Create new view. The view wizard opens. 

 Select Calendar for time recording. Then click Next. 

 Enter the desired name for the view. Then click Next. 

 Start date 

 Today: In the default setting, the view displays the current date. 

 Previous week: With this option, the previous week will be displayed. 

 This date: With the Use current month or Use current year options, the current 

month or year is substituted. 

 Display mode: Select here whether the day or week display should be used and specify 

the desired detail level (hours, half hours, quarter hours or 5 minutes). 

 User: Select here the user whose time records should be displayed. Resources are also 

available for selection. 

 Complete the creation by clicking Finish. 
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7.1.5 Billing time records 

In a time record's data record window and in the list's context menu, you may bill time 

records internally or externally or undo billing. 

 Internal billing: When a time record is internally billed, the following information is 

written in the associated time record fields. 

 Internally billed by: user 

 Internally billed on: date and time 

 Internal hourly rate: the current internal hourly rate for the user and type 

 Actual costs: internal hourly rate times Actual; values are stored with up to 4 

decimals and displayed in lists and report views rounded to 2 decimals. 

In internally billed time records and without reading rights for the Billed internally by/ 

on fields, the Type, From, To, Actual and Start fields may no longer be edited. 

 External billing: When a time record is externally billed, the information is written in 

the associated time record fields. 

 Externally billed by: user 

 Exernally billed on: date and time 

 External hourly rate: the current external hourly rate for the user and type 

 Actual turnover: the external hourly rate times Charged; values are stored with up 

to 4 decimals and displayed in lists and report views rounded to 2 decimals. 

In externally billed time records and without reading rights for the Billed externally 

by/on fields, the Type and Charged fields may no longer be edited. 

 Billing in the time record list: In the context menu for the time record list, you 

may access the Bill sub-menu. The Apply Actual as Charged and Set Charged to Null 

options are only available with writing permissions for the Charged field. 

Additionally, reading permissions for the Actual field are required for the Apply Actual 

as Charged option.  

The options Bill externally and Reset the bill externally option are only available 

with writing permissions for the Externally billed on and Externally billed by fields. 

The options Bill internally and Reset the bill internally option are only available with 

writing permissions for the Internally billed on and Internally billed by fields. 

You also need reading permissions for all time record fields in order to bill time 

records. 

 Apply Actual as Charged: Here you overwrite the Charged field with the Actual 

value in all selected time records. 

 Set Charged to Null: Here you reset the Charged field in all selected time records. 
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 Bill internally: Here you internally bill all selected time records. 

 Reset the bill internally option: Here you cancel internal billing. 

 Bill externally: Here you externally bill all selected time records. 

 Reset the bill externally option: Here you cancel external billing. 

 Billing in the data record window: In the lower third of the data record window for a 

time record, you can see the Internally billed by, Internally billed on, Externally 

billed by and Externally billed on fields. 

 Bill internally: Here you bill the time record internally or cancel internal billing. The 

button is only available with writing permissions for the Internally billed on and 

Internally billed by fields. You also need reading rights for all time record fields. 

 Bill externally: Here you bill the time record externally or cancel external billing. The 

button is only available with writing permissions for the Externally billed on and 

Externally billed by fields. You also need reading rights for all time record fields. 

 Billing in the report view: In the Billing tab of a report view's properties, you can turn 

on the billing features in the view: 

 Display button to internally bill time records 

 Display button to externally bill time records 

You can access the billing features via the Billing menu in the report view's toolbar.  

First select the desired time records in the view. The select the desired billing action in 

the Billing menu. This works like in the time rcord list. The same restrictions also apply. 

Other features of the Billing menu are describes in section "7.8 Billing in reports 

(Desktop Client only)" on page 143. 

 Specify external billing date: With the Bill externally setting under Time records > 

General in the Management Console, you determine whether the external billing date 

may be modified. In this case, you can edit the Externally billed on field in the data 

record window and will be prompted to enter the billing date when billing time records 

externally via the time record list or report view. 
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7.1.6 Defining hourly rates for addresses and projects 

In the toolbars of the data record windows for each addresses and projects, the Hourly 

rates button is available. Here you define hourly rates for a customer and thereby for all 

associated projects or hourly rates for a project. You may specify different hourly rates for 

a company and associated contact persons. 

You may enter global hourly rates in the Time record area of the Management Console 

under Hourly rates. There, you also specify whether individual internal hourly rates may 

be entered for addresses and projects. By default, only individual external hourly rates may 

be entered for addresses and projects (see "9.4.4 Hourly rates" on page 214). 

Entering hourly rates for addresses and and projects requires the Time record: hourly 

rates right. You can assign it in the Management Console under User Management in the 

Other rights tab of the user's Properties dialog. 

Hourly rates for an address take precedence over global hourly rates. 

Hourly rates for a project take precedence over hourly rates for an address. 

 Hourly rates: Here you open the hourly rates view. 

 

 Transfer hourly rates: When internal hourly rates for addresses and projects have 

been activated in the Management Console, you may overwrite any values entered in 

the current view that are displayed in black with the respective values from the other 

view, Internal or External. This will also empty fields if the respective fields in the other 

view are empty. You may apply this change with OK or revert it with Cancel. 

 Select participants: Here you select the users and resources you wish to enter hourly 

rates for. Users and resources for which hourly rates have already been entered for the 

current address or project will be selected automatically. When entering hourly rates for 

a project, any other project participants will also be seelected. 

When you remove a participant with hourly rates entered in the current view (address 

or project) that are displayed in black, these will be deleted after confirmation. 

 Global hourly rates will be displayed in red. They are still valid for all users and types 

for which you have not specified different hourly rates. 



Project   Recording and analyzing project costs 

104 

 Hourly rates for the address will be displayed in blue when entering hourly rates for a 

project. They are valid in all projects for the address for all users and types for which 

you have not specified different hourly rates. 

 Entering hourly rates: See page 215 for details. 

 OK: Here you apply any changes you have made to the database. 

 Transferring changes made to the company to contact persons: If you change 

the hourly rates for a company, you will be asked whether the changes should also 

be transferred to the associated contact persons. In this case, the previous hourly 

rates for the contact persons will be overwritten. 

 Cancel: Here you revert any changes. 

7.1.7 Time record details in projects and jobs 

In the Details tab of the data record window for projects, you may lock the project for 

time recording (see "3 Project details" on page 39). 

In the Details tab of the data record window for jobs, you may lock the job for time 

recording. In addition, you may turn off the limitation of order value by time budget. 

 Lock for time recording: When this option is set in a project or job, time records can 

no longer be created for the project or job. The Actual field in existing time records 

assigned to locked projects or jobs can no longer be modified. 

Note 

The flexible job hierarchy is not considered here. 

Sub-tasks of locked tasks won't be locked automatically as well. 

 

 Charge by working time: If this option is selected in a job, the Actual value is 

transferred to the Charged field whenever time is recorded for a resource plan in the 

job if the Bill externally (automatically adopt Actual as Charged as long as time 

budget remains) option is set for the time record's type. 

This also disables the overbooking check for associated time records. 

7.1.8 User settings for time records 

In your Settings, you configure the time record calendar in data record windows and time 

records for appointments. These settings only affect you. 

To open your Settings, select the associated option from the Tools menu in either of the 

main or Search window or in any data record window. Then switch to the embedded Time 

records tab of the Modules and Solutions tab to edit time record settings. 
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Time record calendar in data record windows 

 

 Start date: Here you specify the start date of the time record calendar in the Time 

records tab of data record windows and in the dossier. 

 Today: In the default setting, the view displays the current date. 

 Previous week: With this option, the previous week will be displayed. 

 This date: With the Use current month or Use current year options, the current 

month or year is substituted. 

 Display mode: Select here whether the day or week display should be used and specify 

the desired detail level (hours, half hours, quarter hours or 5 minutes). 

 User: Select here the user whose time records should be displayed. Resources are also 

available for selection. 

 Show 'Time records' tab in data record windows: Here you specify whether the 

Time records tab will be displayed in the data record windows of addresses, projects, 

jobs, tasks, appointments, documents, phone calls and holiday entries. 

 For appointments, show time to and from destination: Here you specify whether 

panels for recording the time to and from your destination and a break will be 

displayed when you record time for appointments. 
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7.2 Time records in the Web Client 

These apps are available for time records in the Web Client under Project management. 

 7.2.1 Project time recording (page 106) 

 7.2.2 Time record calendar (page 109) 

 7.2.3 Time records (page 111) 

7.2.1 Project time recording 

With the Project time recording app in the Project management group, you can see 

and edit time records by duration for project jobs. 

 

You need the Project time recording other right to access the app. 

 Open the app by clicking on the associated tile. 
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 Displayed jobs 

 The app initially displays all of your project jobs with a resource plan starting in or 

before the current week. 

 Via the Settings button with the slider icon, you can create additional project jobs 

by entering filter settings. No remaining hours will be displayed for such jobs. 

 Jobs with a resource plan will only be displayed if they have a Type which is also 

available as a time record type configured as Relevant for accounting or as Only 

for resource planning under Project > Resource planning > Booking of time 

recordings in the Mangement Console. 

 Additionally, for any jobs with a Type which is als o available for time records, link 

conditions (Management Console Time record > Mandatory links) are considered 

as well. If creating a time record for a job in the app would violate such a condition, 

that job won’t be available. 

 Workloads and working hours 

 In the job rows, enter the hours worked during the displayed week. 

 The project rows display the workload per project. 

 The Time record calendar row displays other hours recorded during the displayed 

week. Please note that this may currently include hours worked for displayed jobs 

which were not entered in the app.  

 The Holiday row displays working hours on vacation days in the displayed week. 

 The Recorded row displays daily and weekly totals of all entered hours whether they 

were recorded in the app or not, plus working hours on vacation days.  

 The Working hours row displays your daily working hours.  
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 The Recorded column displays recorded times per project, job and week. 

 The ETC column displays the remaining workload entered per job for you via the 

associated resource plans for the displayed week. 

Associated time records reduce this value. If you enter more time than planned for a 

week, with automatic or monthly planning this also reduces the ETC planned for the 

remainder of the job duration or month, which affects the ETC values assigned to 

the associated weeks. 

See section „Time records and overbooking“ on page 76 for details about this. 

 Displayed period 

 Initially, the current week will be displayed. 

 Use the timeline below the view to switch to another week. 

 Alternatively, jump to a specific date or to the current date (Today) via the toolbar. 

 Entering times 

 Click in a blue field and enter worked hours. 

 Confirm by hitting [Return] or by clicking on the check mark icon. 

 Cancel by hitting [Esc] or by clicking on the cross icon. 

 Click on the pen to create the time record in the detail view. 

 Click in a red field to change or delete the associated time record.  

 Make the desired change or clear the hours to delete the time record, then 

confirm. The remaining hours will be redistributed according to the change. 

 Enter 0 to create a time record with a zero duration or to set the duration of an 

existing time record to zero.  

 Click on the pen to edit time record details. 

 Time records in the future or for jobs with an overbooked resource plan (ETC = 0 

oder Actual >= [Time budget+ Time budget * Overbooking degree], see 

"Booking of time recordings" on page 206) are not permitted. 

In these cases, the associated table fields will be gray and may not be edited. 

 Time records in the past are permitted. 

 Specifics of time records by duration 

 Time records by duration only have a date and duration. Unlike other time records, 

they don't have a specific start and end time. For more details about the specifics of 

time records by duration, see "Recording by duration" on page 94. 

Click on the question mark at the top right to open the online help pages for more details. 
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7.2.2 Time record calendar 

With the Time record calendar app in the Project management app group, you can see 

and edit time records for the current day or week. 

 

 Open the app by clicking on the associated tile. 

 

 The calendar can display time records, appointments, holiday entries and phone calls. 
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Optionally, public holidays are also displayed. 

To select the data records to display and whether public holidays are displayed, click on 

the Settings button with the slider icon. 

 The statistic, like in the Desktop Client, displays your recorded time and working hours 

in the displayed period and in the current month. 

 Select a period or click a data record to create a time record. 

 When selecting a period, a history is available. 

 You can also select from among all your open resource plans. Any resource plan 

with ETC > 0 will be displayed, even if the End of the associated job is in the past. 

 When clicking on on an out of office appointment, you can enter travel times to and 

from the destination and a break. 

 The Quick entry record past appointments, holiday entries and phone calls in the 

displayed period, including data records that are not currently displayed. 

Click on the question mark at the top right to open the online help pages for more details. 
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7.2.3 Time records 

With the Time records app in the Project management app group, you can see and edit 

existing time records as well as create new ones. 

 

 In the Time records app start, you have access to your current resource plans, time 

records and time records views. 

 Click on the eye icon to create a new time record list view. 

 Click on a resource plan or time record to open its detail view. You can also edit or 

delete it here. 

 Click on the plus [+] icon to create a new time record, which will initially not be 

associated with any other data record. 

 Via the radial menu for a resource plan, you can record time for it. 

 Additionally, you can create time records for most other data records. 

To do this, in the associated detail view, open the action menu with the three dots [...] 

and select Create > Record time. 

Alternatively, you can record time via the radial menu for a data record in a list. 

Click on the question mark at the top right to open the online help pages for more details. 
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7.3 Expenses in the Desktop Client 

The following sections describe how you record expenses in the Desktop Client: 

 7.3.1 Views and features for expenses (page 112) 

 7.3.2 Expenses in addresses, projects, jobs and appointments (page 113) 

 7.3.3 The data record window for per diem  (page 114) 

 7.3.4 The data record window for travel costs (page 117) 

 7.3.6 The data record window for lump sum expenses (page 121) 

 7.3.7 Expense settings in the project (page 122) 

 7.3.8 Billing expenses (page 122) 

7.3.1 Views and features for expenses 

The following standard features are available for expenses in the Desktop Client. 

 Data record window with General, Tree, Change log and Dossier tabs 

 Type for unambiguous labelling and distinction of Per diem, Travel costs, Expense 

receipts and Lump sums 

 Status for billing and approval processes 

 Currency, system base currency by default, may be converted via the Tools menu 

for all expense types except for Per diems 

 Primary links to address, project and job, displayed in the tree view and in analyses 

 General links to any other data records 

 Creation in the New menu, in the toolbar of data record windows and list views, in the 

tree view as well as in the Expenses tab of the data record windows for addresses, 

projects, jobs and appointments 

 Global search in all fields such as Subject, Start and End. Configurable via Settings > 

Search; search toolbar abbreviation EX 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 
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7.3.2 Expenses in addresses, projects, jobs and appointments 

You record expenses for addresses, projects, jobs and appointments in the Expenses tab 

of the respective data record window. Here you also see any expenses already recorded 

for the data record. If they all have the same currency, the total costs and turnover from 

expenses will also be displayed. 

 

 Refresh view: Here you refresh the view in order to apply changes made at other 

workplaces. Changes you enter yourself are displayed in the list immediately. 

 New per diem costs: Here you create new expenses of the Daily expenses type. 

 New km bill: Here you create new expenses of the Travel costs type. 

 New receipt for expenses: Here you create new expenses without a type. 

 New lump sum: Here you create new expenses of the Lump sum type. 
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7.3.3 The data record window for per diem costs 

The following section describes the data record window for per diem costs. 

 

 Subject: You may freely modify the subject as in any data record. When you create 

expenses, the type and associated data record will be entered here. 

 User: Each expenses record has exactly one participant. When you create expenses, you 

will be entered here. If desired, change the user to whom the expenses are due. 

 Date: Unlike travel costs and receipt records, per diem costs have a start and end date. 

The Date field displays the start date in per diem costs. 

 Number: Here you create the next free number. You modify numbering settings in the 

Management Console under Miscellaneous > Number assignment. 
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 Calculate manually: This option may be activated in the Management Console (see 

"General" on page 200) and toggles the automatic calculation. Select this to edit the 

Overnight stay, Subsistence allowance, Net costs and Turnover fields manually.  

Disable it to have these fields calculated automatically again (see "Notes on the 

automatic calculation of per diem costs" below).  

 Type and Status: When the per diem type is selected, the associated fields will be 

available. By default, the Per diem type is used. You can select another type in the 

Management Console under Project > Expenses. 

You may use the status to implement billing and approval processes. 

Notes on the automatic calculation of per diem costs 

By default, per diem costs will be calculated automatically based on the German 

regulations for business trips in Germany and from Germany to foreign countries. 

In the Project area of the Management Console, under Expenses, you may switch to a 

calculation via formulas (with the Form Designer module) or to a manual entry of per 

diem costs (see "General" on page 200). 

Please note that the following per diem field details referring to the calculation don't 

apply when per diem costs are calculated via formulas or entered manually. 

You may implement formulas for the Subsistence allowance, Net costs and Turnover 

fields. With manual entry, these and the Overnight stay field may be edited manually. 

See the German version of this manuals for more details about the default per diem 

calculation and rates. 

 

 Fields for per diem costs 

 Start and End: Via the four fields Start date, Start, End date and End you specify 

the duration of the business trip. The fields for date and time are consolidated to the 

Start date and End date fields in the list. 

Per diem costs for an appointment will adopt the appointment's start and end. 

Per diem costs not created for appoinments will adopt the current date.  

 Country: The country determines the rates used for the automatic calculation. 

In the Management Console, you can add countries or regions via the input help for 

this field and edit the rates as well as the default setting for the country (see page 

200). When you enter per diem costs for business trips to foreign countries, the 

country is adopted from the primary address, if available.  

Please note that regions like France – Paris or Switzerland - Geneva won't be 

selected automatically. For corresponding addresses, only the associated country, 

like France, or Switzerland, will be entered. In this case, select the appropriate 

region manually in the Country field to use the correct per diem rates. 
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 Overnight stay: Business trips spanning two days without an overnight stay are 

considered as one continuous activity on the calendar day with the greater absence 

duration. For such records, the Overnight stay option is initially selected. Deselect it 

to consider the absence as one continuous activity without an overnight stay. 

 Subsistence allowance: Here you see the sum to be refunded without deductions 

for breakfasts, lunches and dinners. 

 Number of breakfasts, lunches and dinners: Here you enter the number of 

breakfasts, lunches and dinners for which the participant did not need to pay. For 

each breakfast, 20% of the daily rate is deducted. For each lunch and dinner, 40% of 

the daily rate is deducted. 

The maximum deducted for each day amounts to the subsistence allowance for that 

day (for an absense above 8 hours or equal to 24 hours).  

 Net costs: To calculate the total costs, the lump sums intended by the legislator for 

the respective amounts of travel time spent each day during the trip are totalled.  

The breakfasts, lunches and dinners not paid for by the employee are deducted.  

You can see and edit the rates in the Management Console under Project > 

Expenses (see page 200). 

 Turnover: In per diem costs to be billed externally, the net costs are transferred to 

the Turnover field. Select the Bill externally checkbox next to the Turnover field to 

externally bill the expenses. In expenses for projects with the Bill expenses 

externally setting, the Bill externally checkbox will be selected automatically. 

 Currency: Determine the currency of the Subsistence allowance, Net costs and 

Turnover fields using the menu next to the Net costs field.  

New expenses have the system's base currency by default.  

You may change the currency at any time. Converting the currency via the Tools 

menu isn't supported for per diem costs. 
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7.3.4 The data record window for travel costs 

The following section describes the data record window for travel costs. 

 

 Subject: You may freely modify the subject as in any data record. When you create 

expenses, the type and associated data record will be entered here. 

 User: Each expenses record has exactly one participant. When you create expenses, you 

will be entered here. If desired, change the user to whom the expenses are due. 

 Date: When you create a travel cost record for an appointment, the start of the 

appointment will be adopted as date. Otherwise the current date will be entered. 

 Number: Here you create the next free number. You modify numbering settings in the 

Management Console under Miscellaneous > Number assignment. 

 Type and Status: When the travel costs type is selected, the associated fields will be 

available. By default, the Travel costs type is used. You can select another type in the 

Management Console under Project > Expenses. 

You may use the status to implement billing and approval processes. 
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 Fields for travel costs 

 Place of departure and Destination: The place of departure is taken from the user 

settings for the route service. You make this setting for every user in Settings > 

Addresses > Departure address for routing. 

You can change the place of departure. In this case, enter "Street, Town, Country" in 

this order and separated by commas if you want to use the place of departure for 

routing. 

The destination is adopted from the primary address. 

Execute route service: Here you open the route service for determining the 

route and distance between the place of departure and primary address. 

You must enter a primary address to use the route service for travel costs.  

Click Calculate route to determine the route and distance. 

 Vehicle: In the Database area of the Management Console, you can set up the 

selection of vehicles as an input help for the Vehicle field in expenses. If you assign 

a vehicle to a user, it will be selected whenever he or she records travel costs. You 

may access this setting in the Management Console under Project > Expenses.  

When a vehicle is entered, the kilometer count of the last travel cost record for the 

same vehicle will be adopted. 

 Private: Here you mark private trips to distinguish them from business trips. 

 Kilometer (number): Specify here the number of kilometers travelled. 

 Double distance: Here you double the distance to include the return trip. 

 Kilometer at start/end: If you keep a driver's logbook, enter the number of 

kilometers before and after the business trip. If you have specified a vehicle for 

which at least one travel cost record exists, the number of kilometers is transferred 

from the previous travel cost record. 

 Cost per km (internal/external): Here you see and modify the price per kilometer 

for the internal and external recording of travel costs. You can change the associated 

presettings in the Management Console under Project > Expenses. You can also 

modify the prices in any travel cost record. 

 Net costs: To calculate the net costs, the number of kilometers is multiplied by the 

internal kilometer price. 

 Turnover: In travel costs that are to be billed externally, the turnover is calculated by 

multiplying the number of kilometers to be billed by the external kilometer price. 

Select the Bill externally checkbox next to the Turnover field to externally bill the 

expenses. In expenses for projects with the Bill expenses externally setting, the Bill 

externally checkbox will be selected automatically. 
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 Km to be billed: Here you specify the kilometers to be billed externally. You may 

preassign this value in the project (see "Expenses" on page 40). 

 Currency: Determine the currency of the Cost per km (internal), Net costs, Cost 

per km (external), and Turnover fields using the menu next to the Net costs field. 

New expenses have the system's base currency by default.  

You may change the currency at any time. Via the Change currency option in the 

Tools menu, you may specify an exchange rate for converting the currency.  

Notes on the kilometer fields 

All kilometer fields may be renamed to use any other unit, such as miles. 

7.3.5 The data record window for expense receipts 

The following section describes the data record window for expense receipts. 

 

 Subject: You may freely modify the subject as in any data record. When you create 

expenses, the type and associated data record will be entered here. 

 User: Each expenses record has exactly one participant. When you create expenses, you 

will be entered here. If desired, change the user to whom the expenses are due. 
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 Date: When you create an expense receipt record for an appointment, the start of the 

appointment will be adopted as date. Otherwise the current date will be entered. 

 Number: Here you create the next free number. You modify numbering settings in the 

Management Console under Miscellaneous > Number assignment. 

 Type and Status: When none of the types for per diems, travel costs or lump sums are 

selected, the General tab will display the fields for expense receipts. 

The Hotel, Taxi, Train, Plane, Park, Local public transfer, Hired car and Service types 

are provided for expense receipts. 

You may use the status to implement billing and approval processes. 

 Fields for expense receipts 

 Payment method: Here you select one of the payment methods Cash, Credit card 

or Bank transfer. 

 Receipt document: Here you may link a digital copy of the receipt with the expense 

record. The receipt must be provided as a document. 

 Search document: Here you select a document in the Search window. 

 Create or open a document: Here you create a new document from a template 

or a file and link it to the expense receipt. If a document has already been 

entered, you open it in the associated data record here. 

 Open document for review: Here you open the stored file for review. 

 Delete link: Here you remove the link between the expense receipt and the 

document. The document will not be deleted in the process. 

 Gross costs, Net costs and VAT rate: When you enter the gross costs or net costs, 

the other field will be calculated with the selected VAT rate. 

The VAT rates are stored as an input help for the associated field. 

If required, you may change the VAT rates under Database in the Management 

Console. 

 Turnover: Select the Bill externally checkbox next to the Turnover field to 

externally bill the expenses. The net costs will be transferred to the Turnover field. 

In expenses for projects with the Bill expenses externally setting, the Bill 

externally checkbox will be selected automatically. 

 Currency: Determine the currency of the Gross costs, Net costs and Turnover 

fields using the menu next to the Net costs field.  

New expenses have the system's base currency by default.  

You may change the currency at any time. Via the Change currency option in the 

Tools menu, you may specify an exchange rate for converting the currency. 
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7.3.6 The data record window for lump sum expenses 

The following sections describe the data record window for lump sum expenses. 

 

 Subject: You may freely modify the subject as in any data record. When you create 

expenses, the type and associated data record will be entered here. 

 User: Each expenses record has exactly one participant. When you create expenses, you 

will be entered here. If desired, change the user to whom the expenses are due. 

 Date: When you create lump sum expenses for an appointment, the start of the 

appointment will be adopted as date. Otherwise the current date will be entered. 

 Number: Here you create the next free number. You modify numbering settings in the 

Management Console under Miscellaneous > Number assignment. 

 Type and Status: When the lump sum type is selected, the associated fields will be 

available. By default, the Lump sum type is used. You can select another type in the 

Management Console under Project > Expenses. 

You may use the status to implement billing and approval processes. 

 Fields for lump sum expenses 

 Turnover: For new expenses of the Lump sum type, the Lump sum specified in the 

project will automatically be entered as Turnover. 

 Currency: Determine the currency of the Turnover field using the menu next to it.  

New expenses have the system's base currency by default. 

You may change the currency at any time. Via the Change currency option in the 

Tools menu, you may specify an exchange rate for converting the currency. 
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7.3.7 Expense settings in the project 

In the Details tab of a project, you enter billing settings for associated expenses (see 

"Expenses" on page 40). 

7.3.8 Billing expenses 

In the data record window for expenses and in the context menu for the list, you may bill 

expenses internally or externally or undo billing. 

Billing writes your user name in the Internally/Externally billed by field and the current 

date and time in the Internally/Externally billed on field. Internal and external billing 

therefore requires writing permissions for the respective two fields. 

The Enter costs as turnover value and Set turnover to Null options will only be 

available with writing permissions for the Turnover and Bill externally fields. 

Additionally, reading permissions for the Net costs field are required for the Enter costs 

as turnover value option. 

 Billing in the expense list: In the context menu for the expense list, you may access 

the Bill sub-menu. 

 Enter costs as turnover value: Here you set the Bill externally option and 

overwrite the Turnover field with the Net costs in all selected expenses. 

 Set turnover to Null: This deselects the Bill externally option and sets the 

Turnover field to Null in all selected expenses. 

 Bill internally: Here you set the Internally billed by and Internally billed on fields 

in all selected expenses. 

 Reset the Bill internally option: Here you clear the internal billing fields. 

 Bill externally: Here you set the Externally billed by and Externally billed on 

fields in all selected expenses. 

 Reset the Bill externally option: Here you clear the external billing fields. 

 Billing in the data record window: In the lower third of the data record window for 

expenses, you may also access the billing controls. 

 Bill internally: With writing permissions for the Internally billed on and Internally 

billed by fields, you may write or reset them here. 

 Bill externally: With writing permissions for the Externally billed on and Externally 

billed by fields, you may write or reset them here. 
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7.4 Expenses in the Web Client 

In the Web Client, you have access to the Expenses app under Project management. 

Here you can see and edit existing expenses and create new ones. 

 

 In the Expenses app start, you have access to your expenses and associated views. 

 Click on the eye icon to create a new list view for expenses. 

 Click on an expense record to open the detail view. You can also edit or delete the 

expense record here. 

 Click on the plus icon [+] to create a new expense record. To do this, first select the 

expense type to create (expense allowance, per diem costs, receipt for expenses or 

travel expenses bill). The available fields depend on the expense type. 

 Additionally, you can create expenses directly for addresses, projects, jobs and 

appointments. To do this, click on the three dots [...] in the detail view of the associated 

data record to open the action menu and select the appropriate item under Create. 

 In the same way, you can create receipts for expenses directly for the associated receipt 

document and vice versa via the action menu of the associated data record. 

When you create a expense receipt for a document, the new expense receipt will adopt 

the document's primary links. The document will also be entered as receipt document 

in the expense receipt record. 

Click on the question mark at the top right to open the online help pages for more details. 
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7.5 External services in the Desktop Client 

The following sections describe how you record external services in the Desktop Client. 

 7.5.1 Views and features for external services (page 124) 

 7.5.2 The External services tab in projects and jobs (page 125) 

 7.5.3 The data record window for external services (page 126) 

 7.5.4 Billing external services (page 128) 

7.5.1 Views and features for external services 

The following standard features are available for external services in the Desktop Client. 

 Data record window with General, Tree, Change log and Dossier tabs 

 Type for assignment to a cost center 

 Currency, defaults to base currency, may be converted via the Tools menu 

 Primary links to address, project and job, displayed in the tree view and in analyses 

 General links to any other data records 

 Creation in the New menu, in the toolbar of the data record windows and list views, in 

the tree view as well as in the External services tab of the data record windows for 

projects and jobs 

 Global search in all fields such as Subject, Start and End. Configurable via Settings > 

Search; search toolbar abbreviation ES 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 
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7.5.2 The External services tab in projects and jobs 

You record external services for projects and jobs in the External services tab of the 

respective data record window. Here you also see any external services already recorded 

for the data record. If they all have the same currency, the total costs and turnover from 

external services will also be displayed. 

 

 Refresh: Here you refresh the view in order to apply changes made at other 

workplaces. Changes you enter yourself are displayed in the list immediately. 

 New: Here you create a new external service. 
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7.5.3 The data record window for external services 

The following section describes the data record window for external services. 

 

 Subject: You may freely modify the subject as in any data record. 

 Type: An external service's type specifies the associated cost center. 

The External costs, Material costs, Personnel costs and Travel costs types are 

available by default. If desired, you may create additional types as input helps for the 

external service field Type in the Database area of the Management Console. 

 Date: Enter the external service's date here. 

 Service provider: Here you specify the service provider's address. 

 Search address: Here you select an address in the Search window. 

 Open address: Here you open the entered address. 

 Delete link: Here you remove the link to the address. 

 Receipt number: Specify the receipt number here. 

 Receipt document: Here you may link a digital copy of the receipt with the external 

service. The receipt must be provided as a document. 

 Search document: Here you select a document in the Search window. 
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 Create or open a document: Here you create a new document from a template or a 

file and link it to the external service. If a document has already been entered, you 

open it in the associated data record here. 

 Open document for review: Here you open the stored file for review. 

 Delete link: Here you remove the link between the external service and the 

document. The document is not deleted in the process. 

 Gross costs, Net costs and VAT rate: Transfer the gross costs or net costs as indicated 

in the receipt into the associated field. 

The respective other field will be calculated with the selected VAT rate. 

The VAT rates are stored as an input help for the associated field. 

If required, you may change the VAT rates in Database in the Management Console. 

 Turnover: Select the Bill externally checkbox next to the Turnover field to externally 

bill the external service. The net costs are transferred to the Turnover field. 

You can manually overwrite the turnover. 

When one of the Gross costs, Net costs or VAT rate fields is changed, the Turnover 

field will automatically be overwritten with the new net costs. 

 Currency: Determine the currency of the Gross costs, Net costs and Turnover fields 

using the menu next to the Gross costs field. 

New external services have the system's base currency by default. 

You may change the currency at any time. Via the Change currency option in the 

Tools menu, you may specify an exchange rate for converting the currency. 
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7.5.4 Billing external services 

In the data record window for external services and in the context menu for the list, you 

may bill external services internally or externally or undo billing. 

Billing writes your user name in the Internally/Externally billed by field and the current 

date and time in the Internally/Externally billed on field. 

The controls for internal and external billing will only be available with writing permissions 

for both of the associated fields. 

The Enter costs as turnover value and Set turnover to Null options will only be 

available with writing permissions for the Turnover and Bill externally fields. 

Additionally, reading permissions for the Net costs field are required for the Enter costs 

as turnover value option. 

 Billing in the external service list: In the context menu for the external service list, you 

may access the Bill sub-menu. 

 Enter costs as turnover value: Here you set the Bill externally option and 

overwrite the Turnover field with the Net costs in all selected external services. 

 Set turnover to Null: This deselects the Bill externally option and sets the 

Turnover field to Null in all selected external services. 

 Bill internally: Here you set the Internally billed by and Internally billed on fields 

in all selected external services. 

 Reset the Bill internally option: Here you clear the internal billing fields. 

 Bill externally: Here you set the Externally billed by and Externally billed on 

fields in all selected external services. 

 Reset the Bill externally option: Here you clear the external billing fields. 

 Billing in the data record window: In the lower third of the data record window for 

external services, you may also access the billing controls. 

 Bill internally: With writing permissions for the Internally billed on and Internally 

billed by fields, you may write or reset them here. 

 Bill externally: With writing permissions for the Externally billed on and Externally 

billed by fields, you may write or reset them here. 
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7.6 External services in the Web Client 

In the Web Client, you may access the External services app under Project management. 

Here you can see and edit existing external services and create new ones. 

 

 In the External services app start, you have access to your external services and 

associated views. 

 Click on the eye icon to create a new list view for external services. 

 Click on an external service to open the detail view. You can also edit or delete the 

external service here. 

 Click on the plus icon [+] to create a new external service record. 

 Additionally, you can create external service records directly for addresses, projects and 

jobs. To do this, click on the three dots [...] in the detail view of the associated data 

record to open the action menu and select Create > External services. 

Click on the question mark at the top right to open the online help pages for more details. 
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7.7 Reports for addresses, projects and jobs 

With Project, you may access additional reports in the Desktop Client and Web Client. 

 7.7.1 Reports for addresses (page 130) 

 7.7.2 Reports for projects (page 134) 

 7.7.3 Time record report for jobs (page 140) 

 7.7.4 Working with reports (page 141) 

 7.7.5 Editing reports (page 141) 

The reports will be added to the favorites of all users that are licensed for the Project 

module and have been granted the required other rights for the analysis. The reports will 

then be available in the associated menu, which you open by clicking on the Report... 

button. 

 

Note 

You assign the required other rights to users and groups in the User Management area 

of the Management Console, in the Other rights tab of the user or group Properties. 

7.7.1 Reports for addresses 

The following reports are available for addresses with the Project module. 

 External services (page 131) 

 Expenses (page 132) 

 Time records (page 133) 
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Note 

The default link mode for all address reports is Overall dossier. In addition to directly 

linked records, all records linked to the same company or one of its contacts will also be 

displayed. You may change this setting (see "7.7.5 Editing reports" on page 141). 

External services 

 

 Display fields: Net costs, Turnover 

 Grouping row: Address, Project, Job, Type 

 Grouping column: Date (Years), Date (Months) 

 Crystal Reports design: List with sub-totals for the address and the project 
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Expenses 

 

 Display fields: Net costs, Turnover 

 Grouping row: Address, Project, Job, Type, User 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Bill of expenses for customers 
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Time records 

 

 Other rights: Time record: analysis 

 Display fields: Actual, Charged, Actual costs, Actual turnover 

 Grouping row: Address, Project, Job, User, Type 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Work report 
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7.7.2 Reports for projects 

The following reports are available for projects with the Project module. 

 Compare nominal/actual (page 134) 

 External services (page 136) 

 Expenses (page 137) 

 Time records (page 138) 

 Resource planning (page 139) 

Compare nominal/actual 

 

 Other rights: Resource planning, Time record: analysis 

 Display fields: Total estimate, ETC, Actual (from resource plans) 

 Grouping row: Address, Project, Job, User 

 Grouping column: (None) 

 Crystal Reports design: Work report 
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External services 

 

 Display fields: Net costs, Turnover 

 Grouping row: Address, Project, Job, Type 

 Grouping column: Date (Years), Date (Months) 

 Crystal Reports design: List with sub-totals for the address and the project 
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Expenses 

 

 Display fields: Net costs, Turnover 

 Grouping row: Address, Project, Job, Type, User 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Bill of expenses for customers 

 



Project   Recording and analyzing project costs 

138 

Time records 

 

 Other rights: Time record: analysis 

 Display fields: Actual, Charged, Actual costs, Actual turnover 

 Grouping row: Address, Project, Job, User, Type 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Work report 
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Resource planning 

 

 Other rights: Resource planning 

 Display fields:Actual, ETC (from resource plans) 

 Grouping row: User, Project, Job 

 Grouping column: Start (Years), Start (Months), Start (Weeks) 

 Crystal Reports design: Sortable list 
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7.7.3 Time record report for jobs 

With the Project module and the other right Time record: analysis, the Time records 

report is available for jobs. 

Time records 

 

 Other rights: Time record: analysis 

 Display fields: Actual, Charged, Actual costs, Actual turnover 

 Grouping row: Address, Project, Job, User, Type 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Work report 

 



Project   Recording and analyzing project costs 

141 

7.7.4 Working with reports 

In the table view, you may access nearly all features for processing your data that are 

available with a Manager license for the Report module, such as: 

 Filter via the arrow down button on the associated field 

 Add and remove display values; change the calculation function (Sum, Minimum, 

Maximum, Average) via the associated context menu 

 Add and remove grouping fields; regroup via drag-and-drop of fields 

 Change the sort order via the context menu for a grouping field (by group name or by 

display value) 

 Display as bar, area, pie or line diagram 

 Prepare for billing, billing and vendor credit notes (see "7.8 Billing in reports (Desktop 

Client only)" on page 143). 

 Export to Microsoft Excel or Microsoft Access, as an xml or html file 

 Create a report with Crystal Reports 

 

You can find details about the available features in the user guide for the Report module. 

The user guide's current version is available for download under the following URL: 

https://hilfe.cas.de/index-en.html. 

7.7.5 Editing reports 

You can edit most settings for the reports listed here. While you can't add or remove data 

record types via link queries, the following settings are editable: 

 Remove or add fields 

https://hilfe.cas.de/index-en.html
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 Reset Overall dossier mode to Normal for address reports in order to only display 

data records that have been linked directly. 

 Select more data (e.g. User data tab for time records and expenses) 

 Activate preparation for billing, vendor credit notes and billing features (Billing tab) 

 Preselect display and grouping fields (Visualization tab) 

 Select a Crystal Reports design 

 Enter Crystal Report Viewer settings for exporting and archiving created reports as 

documents in CAS genesisWorld (Crystal Reports tab) 

 

You can find details about the available features in the user guide for the Report module. 

The user guide's current version is available for download under the following URL: 

https://hilfe.cas.de/index-en.html. 

With a Report Manager license, you can duplicate the reports. The duplicates may then be 

edited freely, including adding or removing data record types via link queries. 

https://hilfe.cas.de/index-en.html
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7.8 Billing in reports (Desktop Client only) 

In reports for time records, expenses or external services, you have access to the Billing 

menu if at least one of the associated features has been cleared in the report view's 

properties (see "7.8.1 Activating the billing features" on page 144). 

With the Report module, you can activate the billing features in any report view for time 

records, expenses or external services. 

 

The following section describes the features available in the Billing menu: 

 7.8.1 Activating the billing features (page 144) 

 7.8.2 Preparing time records for billing (page 146) 

 7.8.3 Creating items (page 147) 

 7.8.4 Billed data records in the item (page 150) 

 7.8.5 Adding time records to an item (page 151) 

 7.8.6 Item in billed data records (page 154) 

 7.8.7 Project invoicing (with Easy Invoice) (page 155) 

 7.8.8 Creating vendor credits (with Easy Invoice) (page 159) 

 7.8.9 Billing time records (page 163) 
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7.8.1 Activating the billing features 

The Billing tab will be displayed when time records, expenses or external services are 

included in the analysis. Here you specify which features will be available in the Billing 

menu in the report view's toolbar and how exactly those features will operate. 

If you don't activate any features of the Billing menu here, the menu will not be available 

in the report view. 

 

 Display button to prepare time records for billing: With this setting and writing 

permissions for the time record fields Charged (externally billable working time) and 

Actual turnover, the Prepare time records for billing option will be available in the 

Billing menu. 

Here you specify a total value for one of the Charged or Actual turnover fields for all 

time records selected in the view. Once you confirm, the specified total values will be 

distributed to the selected time records in the proportion of their respective Actual 

working time. If you have specified the Actual turnover, the applicable external hourly 

rates will be considered in the distribution.  

This feature is described in greater detail in section "7.8.2 Preparing time records for 

billing" on page 146. 

 Display buttons to create items for external services, expenses and time records: 

With this setting, the Billing menu will offer options to create items for time records, 
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expenses and external services. For each data record type selected in the report view, 

time records, expenses and external services, a separate option will be available in the 

Billing menu. 

For time records, an additional option will be available for adding selected time records 

to an existing item. 

When this setting is selected, you also select the status of the items to create. In 

addition, you specify per data record type whether the data records should be billed 

internally and/or externally and whether their status should change when items are 

created for them. 

These features are described in greater detail in sections "7.8.3 Creating items" on page 

147 and "7.8.5 Adding time records to an item" on page 151. 

Note for users of Easy Invoice 

Do not bill time records, expenses and external services externally when you create 

items for them if you are using Easy Invoice and wish to create an invoice for those 

items later. You can only transfer items to an invoice if associated time records, 

expenses and external services are not billed externally. When you create a print 

document for an invoice, the data records will automatically be billed externally. 

 

 Display the button to create vendor credits: With this setting, the Create vendor 

credit option will be available in the Billing menu in the report view (see "7.8.8 

Creating vendor credits (with Easy Invoice)" on page 159).  

 Display button to internally bill time records: With this setting, the Bill time records 

internally option will be available in the Billing menu in the report view.  

Use this to internally bill the time records selected in the report view: 

The Actual working time will be multiplied with the internal hourly rate valid for the 

time record's Type and User and stored in the Actual costs field with a precision of 4 

decimals. Displayed values will be rounded to 2 decimals.  

 Display button to externally bill time records: With this setting, the Bill time 

records externally option will be available in the Billing menu in the report view.  

Use this to externally bill the time records selected in the report view: 

The Charged working time will be multiplied with the external hourly rate valid for 

the time record's Type and User and stored in the Actual turnover field with a 

precision of 4 decimals. Displayed values will be rounded to 2 decimals. 
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7.8.2 Preparing time records for billing 

Select time records that haven't been billed externally in the analysis table. Then select the 

Prepare time records for billing option in the Billing menu to enter a total value for the 

externally billable Charged working time or for the Actual turnover. 

 If you enter a total for the Charged field, it will be distributed in the proportions of the 

Actual working times of the time records once you confirm. In the process, any entries 

that have already been made in the time records' Charged field will be overwritten. 

Click on the green arrow to enter the Actual working time in the Charged field in all 

selected time records. 

Example 

You are preparing two time records for billing. Actual working times of 1h und 3h sum 

up to 4h. As total for the Charged field, you enter 1 pd (i.e., 8h). According to the 

proportion of Actual working times, the time record with Actual = 1h will receive 

Charged = 2h. The time record with Actual = 3h will receive Charged = 6h. 

 

 

 If you enter a total for the Actual turnover, it will be distributed in the proportions of 

the Actual working times of the individual time records, each multiplied with the 

External hourly rate valid for the time record's User and Type. The externally billable 

Charged working time results from its proportion of the total Actual turnover, divided 

by the External hourly rate. 

If external hourly rates have been entered for a time record's primary address or 

project, they will be regarded here. 

Only values that result from the multiplication of the Charged field with the respective 

External hourly rate can be assigned automatically. The Charged field's granularity, 

which you enter in the Management Console, in the Time record area, is regarded 

here. 

For example, with a 1 minute granularity and an hourly rate of 60€, only full euro 

amounts are possible as Actual turnover. 
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Example 

You are preparing two time records for billing. Actual working times of 1h und 3h sum 

up to 4h. External hourly rates of 150€ for the time record with Actual = 1h and 50€ for 

the time record with Actual = 3h have been entered. 

Each time record's proportion of the Actual turnover results from the Actual working 

time, multiplied with the valid External hourly rate. Therefore, each time record 

receives 150€ (1h * 150€ and 3h * 50€), corresponding to 50% of the Actual turnover. 

You now enter 900€ as billable Actual turnover. 

Corresponding to the distribution of the Actual turnover, each of both time records 

now receives 50% of the specified total of 900€ (i.e., 450€, respectively). Now if you 

divide each time record's Actual turnover by the valid External hourly rate, the time 

record with Actual = 1h will receive Charged = 3h (450€/150€) and the time record 

with Actual = 3h will receive Charged = 9h (450€/50€). 

7.8.3 Creating items 

Select time records, expenses or external services in the analysis table. Then select the 

respective option in the Billing menu to create items for the selected data records. 

Time records with Charged and therefore Actual turnover 0 will be included, such that 

they will be listed in work reports. However, such time records won't affect the turnover. 

Items for expenses or external services will only include data records with a Turnover 

greater than zero. 

 

When you create items for time records, you specify, under Item type, whether a shared 

item should be created for all time records that share the same primary project, or one 

item should be created per project and hourly rate. 
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If you distinguish by hourly rates, you also specify whether the working time is given in 

hours or (person) days. 

When you create items for expenses or external services, a shared item will always be 

created for all data records that share the same primary project. 

The current Date as well as the presetting for the Status, which you enter in the view's 

properties, will be adopted automatically. You may change both entries here. If you have 

selected data records with different project types, only their mutual status options will be 

available for selection here. 

You must also specify a Product to link with the item. To do this, a history is available 

which you open by clicking on the little button with the arrow pointing down. When you 

enter a Product this way, the Item type which was last used for the selected product 

(lump sum, hourly rates or daily rates) will also be selected automatically. 

Alternatively, you specify the desired item type in the product. You can find the associated 

selection in the General tab of the product. When you enter a product via the search, the 

item type specified in the product is automatically adopted (see "2.5 Products, prices and 

discounts" on page 35). 

You will be informed whether the selected time records, expenses or external services will 

be billed internally or externally. For time records and expenses, the target status that was 

preconfigured in the view's properties will also be displayed and may be changed here. 

Click on Create to create the item or items without review. 

Click on Create & Display to directly display the created item or items. If only one item 

was created, the associated data record will open. If more than one item was created, a list 

of the items will open. 

After the item or items have been created and before they are displayed if you have 

selected to create and display them, you will be informed about how many time records, 

expenses or external services were billed internally and/or externally. You specify whether 

the data records will be billed internally, externally or completely in the report view's 

properties (see "7.8.1 Activating the billing features" on page 144). 

Note for users of Easy Invoice 

Do not bill time records, expenses and external services externally when you create 

items for them if you are using Easy Invoice and wish to create an invoice for those 

items later. You can only transfer items to an invoice if associated time records, 

expenses and external services are not billed externally. 

When you create a print document for an invoice, the data records will automatically be 

billed externally. 

 

The following sections describe details and specifics when creating items for time records, 

expenses and external services. 
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Expenses, external services and time record lump sums 

When you create items for expenses or external services, or when you create items for 

time records and select the One item (lump sum) option as Item type, exactly one item 

with a Quantity of 1.0 will be created for each primary project. The Unit will be adopted 

from the selected product. The total Turnover of the included expenses or external 

services, or when you create a lump sum for time records, the total Actual turnover of the 

included time records will be adopted as the item's Price and Sum. 

Time records by hourly rates 

When you create items for time records and select one of the One item for each hourly 

rate (days/hours) options as Item type, one item will be created per primary project and 

per external hourly rate. As only the amount of the external hourly rate is distinguished, 

time records with different types may be billed via the same item if the valid external 

hourly rate is the same. The number of items to create will be displayed in brackets to the 

right of the Items caption. 

Depending on the selected setting, Days or Hours will be adopted as Unit. 

The total of the externally billable Charged working time of the included time records will 

be specified as the item's Quantity. The working time will be specified in person days or 

hours. A person day spans 8 hours in the default setting. You may change the duration of 

a person day in the Time record area of the Management Console. There you specify the 

duration in hours and minutes. All values between 1 and 24 hours are accepted. 

The Price of each item is equal to the external daily or hourly rate when the working time 

is itemized by hourly rates. The daily rate is determined by multiplying the external hourly 

rate with the duration of a person day. 

The Sum of each created item is equal to the total Actual turnover of the included time 

records. 

Contribution margin 

Just like for manually created items, the Contribution margin will be calculated as the 

difference between an item's Price and the Purchase price entered in the selected 

product, multiplied by the item's Quantity. 

When no purchase price has been entered in the selected product, the contribution 

margin will be equal to 100% and therefore equal to the item's Sum. 
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Prices and discounts 

The Price is not taken from the selected product when creating items for time records, 

expenses and external services. Instead it depends on the turnover entered in the 

associated data records or on the external daily or hourly rate of the associated time 

records. 

For this reason, price and discount lists as well as individual prices and discounts that have 

been entered for the selected product with one of the Sales pro or Project modules are 

ignored here. 

Currency 

You can only create items for time records, expenses and external services in the base 

currency. It is not possible to create items via the billing preparation features for projects 

with a different currency. 

You may add time records to an item with a different currency in the item's data record 

window (see "Adding time records in an item" on page 153. 

Please note that the item will still be calculated in the base currency, such that you have to 

manually enter the correct values in this case. 

7.8.4 Billed data records in the item 

The time records, expenses or external services for which an item has been created will be 

displayed in the item's data record window in the Billing tab. 

 

In items created from time records, the Total value field displays the total of Charged 

working hours of the associated time records. 
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Click on the Remove time records button to remove all selected time records from the 

item. This presupposes that the time records haven't been billed yet. 

As when creating an item for time records, you will be asked to select how the item should 

be recalculated based on the remaining time records. 

 

If the external hourly rates of the remaining time records differ, only the Lump-sum option 

will be available. With this selection, the Quantity of the item will be set to 1. The Price 

and thereby the Sum will be calculated based on the Charged working hours and the 

respective hourly rates for the individual time records. 

With either of the Item by hourly rate options, the Quantity will be set to the duration in 

days or hours. The Price then corresponds to the daily or hourly rate. 

7.8.5 Adding time records to an item 

You can also add time records to an existing items. 

To do this, use the associated option of the Billing menu in a report or the associated 

button in the item's data record window. 

Adding time records in a report 

Via Add time records to item in the Billing menu, you add a selection of time records 

sharing a common primary project to an existing item belonging to the same project. 

As when creating an item for time records, you have the choice between a Lump-sum and 

an Item by hourly rate in days or hours. 

The latter two options require that the item to which you add time records has been 

created for time records with the same option and therefore has the same daily or hourly 

rate as the selected time records. 

When you select the Add time records to item option, you will first be asked to select the 

desired item: 
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After selecting an item, an overview of the change will be displayed: 

 

Select here the desired Item type if the item was created by daily or hourly rate. The 

default setting Lump-sum is always available. 

Moreover, if desired, you can change here the date, status, product and description of the 

item as well as the status of the time records to assign to it. 
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Adding time records in an item  

Via Add time records in the toolbar of an item's data record window, you can add a 

selection of time records to that item via the search window. 

 

This way, you can only add time records that aren't externally billed and share the item's 

primary project. 

Adding time records to a foreign currency item 

As opposed to the associated option in the report's Billing menu, you can use the feature 

described in the previous section to add time records to items differing from the base 

currency. 

However, the item will still be recalculated in the base currency. The amount won't be 

converted automatically. Therefore, please calculate the price manually in this case and 

overwrite the automatically calculated price. 
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7.8.6 Item in billed data records 

In the data record windows of time records, expenses and external services for which an 

item has been created, that item will be displayed under the Parent field. 

Click on the associated button to open the linked item. 
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7.8.7 Project invoicing (with Easy Invoice) 

With Easy Invoice, you can create receipts for selected project items in the Order tab of a 

project. 

 

When you create an invoice this way, the project items will be linked to it. After creating 

the associated print document, each project item displays the invoicing date and receipt. 
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Billed data records in the receipt item 

The associated time records, expenses or external services are assigned to the associated 

receipt item and displayed in its detail view. 

 

 For time records, the Total value field shows the sum of Charged hours invoiced via 

the receipt item. 

Multiplied with the hourly rate valid for each time record, this value yields the 

associated Actual turnover, the total of which for all associated time records is the 

sum of a project or receipt item. 

 Click on Remove data records to remove selected time records, expenses or external 

services from the receipt item and reset their external billing fields. This way you can 

clear billed data records for billing again after cancelling an associated invoice without 

removing billed data records from the cancelled invoice in the process (see „Cancelling 

a project invoice“ on page 158). 

To bill the data records once more, you have to created new associated items, as 

described in section" 7.8.3 Creating items" on page 147. 

Please note that, when removing time records from a receipt item, their Charged hours 

are set to zero. In order to create another asssociated item, you therefore have to enter 

Charged hours for them again, as described in section "7.8.2 Preparing time records for 

billing" on page 146. 

 Click on Refresh to reload the list of billed data records. 
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Receipt item in billed data records 

Billed data records show the associated receipt item and outgoing invoice. 

 

You can remove this link in the receipt item’s detail view (see previous section). 

When you cancel an invoice, you also have the choice of removing all associated time 

records from the invoice and reset their external billing in order to bill them again (see 

„Cancelling a project invoice“ on the following page). 
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Cancelling a project invoice 

Via the Create receipt menu in the data record window of an invoice with a print 

document, you can cancel that invoice by creating a cancellation receipt for it. 

The cancellation receipt contains offsetting entries for all invoiced items. 

When creating a cancellation receipt for a project invoice, you will be asked what to do 

with the billed time records, expenses and external services: 

 

 Select Leave unchanged with the receipt if the data records shouldn’t be removed 

from the receipt and shouldn’t be set to zero. 

 Select Leave linked to receipt and set turnover/value to 0 if the data records 

shouldn’t be removed from the receipt but should be set to zero. 

Select this option if you can‘t invoice the data records anew later. 

 Select Remove from receipt and undo the billing to remove the data records from 

the receipt and reset the Billed externally by/on fields. 

The data records won’t be set to zero with this choice. 

Select this option to invoice the data records anew later. 

Regardless of cancellation, you can always remove billed data record from a receipt in the 

detail view of the associated receipt item (see „Billed data records in the receipt item“ on 

page 156). 
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7.8.8 Creating vendor credits (with Easy Invoice) 

You can create vendor credits via the report view with Project and Easy Invoice in order to 

credit time records and expenses to contractors in projects. 

Licenses 

This feature is available with the following licenses:  

 Easy Invoice 

 Project  

 Report Manager for cross-customer vendor credits  

Configuration in the Management Console 

To create vendor credits, you need to make some settings in the Easy Invoice area of the 

Management Console: 

 Create receipt type and select print template 

 Configure product default values 

 Assign a number range to the receipt type 

These settings are described under "9.1.2 Vendor credit settings" on page 188. 

Creditor configuration in companies or individual contacts  

Creditors are the users entered for the time records and/or expenses to bill. 

In order to create vendor credits, addresses linked to the users, i.e., employee data records 

are required. 

 In the Billing tab of the associated company, the VAT ID or Tax number as well as the 

Creditor number must be entered. 

 Vendor credits may also be created for individual contacts. As for companies, the VAT 

ID or Tax number as well as the Creditor number must be entered in the Billing tab. 
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Time record billing type configuration for products 

In the product data record for billing the time records, you determine in the Billing type 

field how time records will be billed via vendor credits: 

 

 One item (lump sum) will bill the total costs of all the time records via a common 

lump sum item.  

 One item for each hourly rate (days) will bill the costs of all time records with a 

common internal hourly rate via an item in days. 

One item will be created for each internal hourly rate. The price per unit will be equal to 

the per diem rate and the quantity will be equal to the number of days. 

 One item for each hourly rate (hours) will bill the costs of all time records with a 

common internal hourly rate via an item in hours. 

One item will be created for each internal hourly rate. The price per unit will be equal to 

the hourly rate and the quantity will be equal to the number of hours.  
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Creating vendor credits 

After all prerequisited listed here are satisfied ,the Create vendor credit button will be 

available in the Billing menu in the report view: 

 

You may select the data records to bill via the report view. In the screenshot above, all 

data records belonging to the "CAS genesisWorld for Devemit Ltd." project have been 

selected. It is also possible to select data records belonging to multiple projects. In this 

case, vendor credits will be created per selected project (see below). 

The data records that will actually be billed are the selected time records and expenses in 

any case. These data records will be billed internally via the vendor credit and time-

stamped accordingly. 

One receipt will be created per recipient (creditor, i.e., user) and project. 

A primary link will be entered between each receipt and the respective associated project, 

which is the primary project of the billed time records and expenses. 

The billed time records and expenses will be listed in the associated receipt items created 

for them. 
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Billing prerequisites 

The following prerequisites apply to billing: 

 The data records to be billed have primary projects.  

 The data records to be billed must not have been billed internally. 

 Addresses linked to users are available, i.e., they are employee data records. 

 The VAT ID or Tax number as well as the Creditor number fields must habe been 

entered in the Billing tab of the associated addresses. 

 If you only wish to bill expenses, then all the expenses must have the same currency.  

 If time records are to be billed, then any expenses billed at the same time need to have 

the base currency. 

Billed sum and currency 

The billed sum is derived from the time records and the expenses. 

 Time records: Actual costs (actual * internal hourly rate) 

 Expenses: Net costs 

Time records will always be billed in the base currency. 

If you are only billing expenses, other currencies are possible. However, all the data 

records have to have the same currency.  

Internal hourly rates 

The internal hourly rates can be defined on the following levels: 

 Global: in the Management Console under Time record > Hourly rates 

 Customer: Hourly rates button in the associated company address 

 Project: Hourly rates button in the project data record 

To enter hourly rates for a customer or project, you first need to turn on this feature in the 

Time record area of the Management Console under Hourly rates. 

Hourly rates can be equal to null. In this case, associated time records will not be included 

in the sum. However, they will be marked as billed and listed in the work report. 
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7.8.9 Billing time records 

You can bill time records selected in the view via the Billing menu if they have not already 

been billed. When you do, the current date and your user name will be written into the 

Internally/Externally billed on/by fields. Afterwards, the number of time records that 

have been selected and the number of time records that have actually been billed will be 

displayed. 

 Bill time records internally: Here you internally bill selected time records. The Actual 

working time will be multiplied with the internal hourly rate valid for the time record's 

Type and User and stored in the Actual costs field with a precision of up to 4 decimals. 

Displayed values are rounded to 2 decimals. 

 Bill time records externally: Here you externally bill the time records selected in the 

report view. The externally billable Charged working time will be multiplied with the 

external hourly rate valid for the time record's Type and User and stored in the 

Actual turnover field with a precision of up to 4 decimals. Displayed values are 

rounded to 2 decimals. 

You will find more billing features unter Billing in the time record list's context menu. 
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8 Other planning views 

The following planning views are available with Project in addition to the project and 

resource planning views described in chapter 5: 

 8.1 Team planning in the Desktop Client (page 164): With utilization and skills 

 8.2 Team planning in the Web Client (page 176): With map view 

 8.3 Timeline view in the Web Client (page 181): Chronological order of data records 

 8.4 Board view in the Web Client (page 184): Group data records by field values 

8.1 Team planning in the Desktop Client 

The following sections describe the features of the interactive planner view for team 

planning in the Desktop Client. 

 8.1.1 The Gantt view (page 164) 

 8.1.2 The workload view (page 167) 

 8.1.3 View options of the interactive planner view (page 168) 

 8.1.4 Creating an interactive planner view (page 169) 

8.1.1 The Gantt view 

The interactive planner view groups appointments, tasks, holiday entries, jobs and projects 

by users and resources. The view supports two display modes. 

The Gantt view visualizes the duration of the data records. 

 



Project   Other planning views 

165 

 Working hours: user working hours and resource availability are highlighted in white.  

If available, the working hours entered in the Management Console under Time record 

> Working hours are used.  

To apply changes made to working hours in the Mangement Console to the interactive 

planner view while it's open, click on the Refresh button in the toolbar.  

For users who have no working hours set in the Management Console, the working 

hours stored in the user settings in the Calendar tab are displayed. 

Changes made there are only applied the next time you log on.  

 Appointments, projects, jobs and holiday entries: For appointments, projects, jobs 

and holiday entries, the duration from Start to End is displayed. 

 Private and confidential appointments: In addition to your own private and 

confidential appointments, private and confidential appointments of other users and 

resources are also displayed with the respective associated icon if you have sufficient 

access rights to them. 

Private appointments of other users and resources are only displayed with their 

subject if you are also a participant. Only in this case can you open them as well. 

Confidential appointments of other users and resources are only displayed with their 

subject if you are also a participant or have external access with the Full rights, 

access to confidential level. Only in this case can you open them as well. 

 Display of residual leave from CAS teamWorks: If leave entitlement has been 

defined for you in CAS teamWorks, the interactive planner view will display the 

residual leave in each interval as availability to its left. 

The residual leave at the beginning of the scale is displayed as total availability. 

Spent or expired leave days are displayed as workload. 

Note 

Please note that it is not possible to create or edit appointments in the Gantt view if you 

are using the Exchange sync module. 

 

 Tasks: For tasks, the nominal working time entered in the Nominal field is equally 

distributed to the participants. Each participant's proportion of the working time is then 

distributed equally to his working hours during the remaining days before the deadline. 

 Overlaps are highlighted in red. 

 Open data records: Double-click a bar or list entry to open the associated data record 

in its data record window. Alternatively, you open data records via the Open sub-menu 

in the view's context menu. 
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 Create data records: Double-click on the desired start time in the associated chart row 

to create a data record. Alternatively, you create data records by right-clicking on the 

desired start time and selecting the New option from the context menu. 

 Delete data records: You may delete data records via the list or via the Delete sub-

menu in the view's context menu. 

 Edit schedule: Using the mouse, you edit the start and end of projects, jobs, 

appointments and holiday entries via drag-and-drop. 

You cannot edit the deadlines of tasks here. 

 Edit duration at start: In order to edit the start and duration at the same time in a 

data record, leaving the end unchanged, click at the left border of the associated 

bar, hold the mouse button and move the border to the desired place. 

 Edit duration at end: In order to edit the end and duration at the same time in a 

data record, leaving the start unchanged, click at the right border of the associated 

bar, hold the mouse button and move the border to the desired place. 

 Move: In order to move a data record, leaving the duration unchanged, click at the 

bar in the middle and drag it to the desired place. You can move data records of a 

smaller duration by pressing the [Alt] key first and holding it while you are 

moving the data record. 

 Detail level during moving: The step width during moving depends on the period 

setting. Hold [Alt]+[V] in order to adjust data records in smaller steps. 

Days: 1 hour; with [Alt]+[V] 15 minutes. 

Weeks: 1 day; witht [Alt]+[V] 1 hours. 

Months, quarters, years: 1 week; with [Alt]+[V] 1 day. 

 Replace appointment or job participant: Proceed as follows to replace a participant 

in an appointment or job. 

 Press and hold the [Shift] key. 

 Click on the appointment or job in the row of the user you wish to remove and hold 

the mouse button. 

 Drag the appointment or job to the associated row next to the desired new 

participant and release the mouse button. 

Note 

When you replace a participant in a resource planning job, the resource plan's 

participant will not be replaced. 
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8.1.2 The workload view 

The workload view displays the workload caused by the data records selected for display. 

 

 Working hours: The working hours are displayed per period. As in the Gantt view, the 

working hours entered in the Management Console under Time record > Working 

hours are used where available. For users who have no working hours defined there, 

the working hours are taken from the user settings. 

 Person days (PD): In the default setting, 8 hours are subsumed under one person day. 

You determine the duration of a person day in the Management Console under Time 

record > General. 

 Workload display: Either workload or availability is displayed (see "Workload mode" 

on page 168). 

 Sum display: In the view's properties, you may select a different display for the total 

sum displayed in the last sum row (see "Workload in sum rows" on page 174). 

 Signal colors: You may modify tresholds and signal colors for low workload or 

overload in the Management Console under Project > Resource planning.  

 Blue: low workload (below 50%) 

 Yellow: overload (more than 100%) 

 Red: severe overload (more than 150%) 



Project   Other planning views 

168 

8.1.3 View options of the interactive planner view 

The following view options are available in both display modes. 

 Modify start date, period and interval: You specify the view's start date in the From 

field in the top left toolbar area. 

 Today: Here you set the start date to the current day. 

Using the two menus next to the date field you select the period and interval. Days, 

weeks, months and years are available for selection. 

As a selection of weeks, months or years will alway display full weeks, months or years, 

the start date displayed in the view may differ from the selected start date in this case: 

 Weeks: Monday of the week of the selected start date 

 Months: First day of the month of the selected start date 

 Years: First day of the year of the selected start date 

The selected period, however, refers to the selected start date. Therefore, more weeks, 

months or years than selected may be displayed. 

 Select zoom level: Using the menu in the top right toolbar area you specify the Gantt 

view's zoom level. Values from 10-150% (steps of five) and from 150-750% (steps of 

ten) are available for selection. 

 Show or hide activity list: Here you show or hide the activity list. It displays all data 

records of the cell currently selected in the planner view. 

 The resource plan list: In the workload view, a resource plan list is displayed next to 

the activity list. If you have set the workload from jobs to be calculated from 

resource plans in the view's properties, the resource plan list shows associated 

resource plans when clicking on a job or sum row. 

 Show or hide activities: Press this button to hide the rows for the individual data 

record types. Data records selected for display are still shown in the sum row. 

 Show or hide appointments, tasks, projects, jobs or holiday entries: Click on the 

symbol of a data record type to show or hide the associated data records in the view. 

Data records hidden in this way are not considered in the workload. 

 Show or hide sum: Here you determine whether a sum row should be displayed for 

every user and resource. In the sum row, you see all data records selected for display 

and the subtotal. The total sum for all users and resources selected for display cannot 

be hidden. 

 Show Gantt or workload view: Here you switch between the Gantt and workload 

view. When the button is selected, the Gantt view is displayed. Regardless of the 

selected display mode, all data records selected for display are considered. 

 Workload mode: Using the four buttons to the right of the Gantt button you select 

one of four display modes for the workload. 
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 Workload in hours 

 Workload in percent (proportion of working hours) 

 Availability in hours 

 Number of activities 

 Select skills: Here you can filter the users that are displayed by skills. 

If you do, only users with at least the selected minimum level for each selected skill will 

be displayed. 

To do this, first click Display all in the Select skills window. 

Then, right-click a skill to select the desired minimum level. 

Once you confirm, only users with at least the selected level for each selected skill will 

be displayed. 

To reset the filter for a skill, right-click on the skill in the Select skills window to open 

the associated context menu and select the Rest option. 

Please note that you can preset the skill filter via the view properties. This is described 

in section "0 Skills" on page 175. There, you can also learn how you enter skills for 

employees. 

 Refresh: Here you refresh the view to reload working hours of users, availability hours 

of resources and all data records selected for display. 

 Save Gantt view as picture: Here you save the Gantt view as a picture file in the 

Windows BMP bitmap format. 

 Export workload to Excel: Here you export the workload view to Microsoft Excel. 

8.1.4 Creating an interactive planner view  

You insert the view in your program navigator in the following way. 

 Right-click on the desired place to call up the context menu. 

 Select Create new view. The view wizard opens. 

 Select Planner (interactive). Then click Next. 

 Enter the desired name for the view. Then click Next. 

 Select the desired participants and resources. Then click Next. 

 Select the desired settings as described in the following sections. Then click Finish.  
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Period 

In the Period tab, you make the following settings. 

 

 Set start date 

 With the Today option, the view starts with the current date. 

 With the This date option, you specify a date. You can have the current month 

and/or year inserted with this option. 

 With the last option, you specify a week count within the current month (1-4) and 

weekday (e.g., the first Monday of the current month.) 

 Select forecasting horizon: Here you specify over how many days, weeks, months or 

years the view stretches. 

 Display days: Here you specify whether each day should be displayed with 24 hours or 

only with the stored working hours of the employees selected for display. 

With the Show only own working hours setting, working hours of employees selected 

for display that do not overlap with the working hours of the current user are hidden. 

 Present point in time: Here you specify whether the current point in time should be 

displayed as a vertical red line. If the current point in time is not displayed in the view, 

the red line appears at the beginning of the following day. 
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Activities 

In the Activities tab, you make the following settings. 

 

 Display activities: Here you specify whether and how appointments, tasks, jobs, 

projects and holiday entries are displayed. 

 Hide activities: Press this button to hide the rows for the individual data record 

types. Data records selected for display are still shown in the sum row. 

 Show or hide appointments, tasks, projects, jobs or holiday entries: Click on the 

symbol of a data record type to show or hide the associated data records in the 

view. Data records hidden in this way are not considered in the workload. 

 Set Filter: You may enter filter conditions for every selected activity type to limit 

the activities that should be considered. 

Select view format: You may select a view format to use in the associated list for 

every selected activity type. 

 Show or hide sum: Here you determine whether a sum row should be displayed for 

every user and resource. In the sum row, you see all data records selected for display 

and the subtotal. The total sum for all users and resources selected for display can 

not be hidden. 
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 Project link filter: Here you filter by the primary projects of the data records to 

display. 

 Display activity list: Here you specify whether the activity list should be displayed 

when opening the view and how high it should be. When it was hidden and is set to be 

displayed in the view, it will also obtain the height set here. 

 Colors: Here you change the line and fill colors used in the view. For tasks, you may 

allocate different colors to each of the three priority levels. Under Fill color, you may 

also change the color used to display overlaps. 

You may allocate a different color to every available combination of type and status for 

each data record type. Data records for whose type and status no colors were defined 

here will be displayed in the default colors. 
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Workload 

In the Workload tab, you make the following settings. 

 

 Include in workload: Here you specify which data record types should be included in 

the workload to what extent. 

Note 

Hidden data records are never included in the workload. Displayed data records are 

included in the workload if they are selected here. 

 

 Workload from appointments: If appointments are displayed and included in the 

workload, each appointment's duration is added to the total workload. 

 Workload from tasks: Tasks are distinguished by priority. 

If tasks are displayed, the Nominal value from each task with a priority level to be 

included in the workload is added to the total workload. 

The working time is equally distributed to the participants. Each participant's portion 

of the working time is then distributed equally to his working hours during the 

remaining days before the deadline. 
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 Workload from jobs: Jobs may be included in the workload in two mutually 

exclusive ways. 

Calculate from resource plans: Select this option to display the remaining working 

time from associated resource plan as workload from jobs. 

For each displayed user who has a resource plan with remaining ETC in a 

displayed job, the ETC is distributed equally to his working hours during the 

remaining job duration. 

Job duration: If the Calculate from resource plans option is not selected, the 

portion of the job duration in the display period will be added to the total 

workload. 

With the Only during working hours option selected, only the portion of the job 

duration which overlaps the working hours will be added to the total workload. 

 Workload from projects: If projects are displayed and included in the workload, the 

portion of the project duration in the display period will be added to the total 

workload. 

With the Only during working hours option selected, only the portion of the 

project duration which overlaps the working hours will be added to the total 

workload. 

 Workload from holiday entries: If holiday entries are displayed and included in the 

workload, the portion of the holiday duration in the display period will be added to 

the total workload. 

With the Only during working hours option selected, only the portion of the 

holiday duration which overlaps the working hours will be added to the total 

workload. 

 Workload by activities: Here you select the display mode for the workload. It will be 

used in the sum column and in the workload view. 

 Display working hours: Here you specify whether the working hours should be 

displayed in the Workload in hours and Availability in hours modes. 

 Workload in sum rows: If the total sum in the bottommost row should be displayed 

differently, select the Different display in total line option. Then select the desired 

display mode. 

 View: Here you select the display mode when opening the planner view, Gantt view or 

Workload view. 

 Show sum colum: Here you select whether the sum column should be displayed. It 

shows the sum of the workload or availability in the display period. 
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Skills 

In the Skills tab, you filter the view by users' skills. Only user having at least all given skills 

will be displayed. 

 Right-click a skill to select the desired level. 

 Select Reset to remove the filter for a skill. 

 

 Enter skills (synchronous with CAS teamWorks): The Skills tab is displayed in 

addresses with employee links. The employee link associates an address with a user. 

You may enter or remove it with the Display/Hide employee data option in the Tools 

menu of the address's data record window.  

You define the skills available here in the Management Console under Project > Skills. 

If you are also using CAS teamWorks, the skills defined there will be adopted and may 

be edited synchronously in CAS genesisWorld. 
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8.2 Team planning in the Web Client 

The Team planning app is available in the Project management app group. 

 

The following sections describe the presentation and features of the app. 

 8.2.1 Presentation and editing of appointments (page 177) 

 8.2.2 Change display mode and focus (page 178) 

 8.2.3 Change display date (page 178) 

 8.2.4 Change view settings (page178) 

 8.2.5 Display in map (page 179) 

 8.2.6 Create appointment (page 180) 

 8.2.7 Collapse or expand user list (page 180) 
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8.2.1 Presentation and editing of appointments 

The app displays a row for each selected user. Appointments (blue) and holiday entries 

(grey) are displayed per user and day on a timeline with hourly precision. Hints display 

appointment and holiday entry details. Public holidays are displayed with red captions. 

  

 Click an appointment to open the associated editing view. 

 Drag an appointment within a row to move it on the timeline. Please note that this is 

only possible for appointments that are completely displayed. 

 Drag an appointment's left or right edge within a row to change its start or end. 

 Drag an appointment between rows to replace a participant by another one (e.g., drag 

from a placeholder resource to a user to assign that user to the appointment, see 

"Resource as placeholder" in section "8.2.4 Change view settings" on page 179). 

 Select a period to create a new appointment. Alternatively, click on the plus icon at the 

top right to create an appointment (see "8.2.6 Create appointment" on page 180). 

 Holiday entries are displayed as grey bars and can't be opened or edited in the app. 

 Overlaps are displayed as light grey bars. Click on the grey overlaps bar or the arrow at 

the left edge of the associated row to expand all overlapping appointments and 

holidays. 

 Icons displayed for appointments indicate various properties:  

 Recurring (part of a series) 

 Private 

 Confidential 

 Out of office 

 One or more external participants 

 One ore more participating groups 
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8.2.2 Change display mode and focus 

The view displays the appointments of a day, week or month. 

Click Day, Week or Month to change the view mode: 

 Day 

 The timeline displays the day above and hours below. 

 The precision for displaying and editing appointments are quarter hours.  

 Initially, the first displayed hour is focussed and displayed with a greater width. 

Click on the column header of another hour to switch the focus. 

 Week 

 The timeline displays the days of the selected week. 

 The precision for displaying and editing appointments are hours.  

 Initially, the current day (or Monday if the current week is not displayed) is focussed 

and displayed with a greater width. 

Click on the column header of another day to switch the focus. 

 Month 

 The timeline displays weeks above and days below. 

 The precision for displaying and editing appointments are days.  

 Initially, the current week (when opening the view) or the first displayed week (after 

switching the date) is focussed and displayed with a greater width. 

Click on the column header of another hour to switch the focus.  

8.2.3 Change display date 

In addition to the view mode, you can select a date via the buttons at the top left: 

 Click Today to jump to the current date. 

 Click this to select a date in the calendar. 

 Alternatively, use the timeline below the view to switch to another date. 

8.2.4 Change view settings 

Using the slider, filter and user icons, you can change various view settings. 

 Click this to change view settings: 

 Visibility of weekends 
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 Working hours to be displayed (start and end); please note that you can't drag 

appointments starting or ending outside displayed working hours. 

 User employee address filter field (via filter icon at top right, see below); requires 

users to be linked with employee addresses. 

Any fields with multiple selection (checkbox list) input help items will be available. 

 User employee address grouping field (users will be grouped by this field); requires 

users to be linked with employee addresses. 

Any fields with single selection input help items will be available. 

 Resource as placeholder (displayed in a separate row to schedule appointments not 

yet assigned to a specific user. Drag such an appointment to the desired user to 

assign that user to that appointment). 

 Color classification (select a field with a single selection input help to assign colors to 

field values. You may select the Type and Status fields individually or in 

combination. Select the Type / Status item to assign a color to each type and each 

type/status combination). 

Changes will only be applied after confirming your selection by clicking Apply both 

in the Color classification and View properties windows.  

 Click this to filter the displayed users by the employee address filter field selected in 

the settings. Selecting multiple items will filter the view such that only users with all of 

these items will be displayed. For instance, if you filter users by language and select 

multiple languages, only users knowing all selected languages will be displayed. 

  Click this to select the users to display. 

8.2.5 Display in map 

Click on the map icon to display all appointments with a georeferenced primary address in 

the map view. 

 Click this to display the appointments of the team planning view in the map view. 

 On the right hand side, a list of the appointments is displayed. 

 Click on the location of one or more appointments to filter the list. 

 Click on the location again to display all appointments again. 

 Click on an appointment in the list to show its location on the map and other details. 

 For locations with only one appointment, details of that appointment will also be 

displayed when you hover over the location.  

 Use the toolbar to change the period or participants of the appointments to display. 
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8.2.6 Create appointment 

Click on the plus icon or select the desired period (see "8.2.1 Presentation and editing of 

appointments" on page 177) to create an appointment. 

 Click this to create an appointment. Initially, you will be entered as participant. If a 

planning resource is selected, it will initially be entered as participant instead. 

8.2.7 Collapse or expand user list 

Click on the left arrow button above the user list to collapse it. The list will be displayed 

with a smaller width, showing only the user images stored in the associated employee 

addresses. 

Click on the button again to display the user list with full width again, showing user 

images, names and descriptions. 

 Click this to collapse or expand the user list. 
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8.3 Timeline view in the Web Client 

The following sections briefly outline the availability, visualization and features of the 

Timeline view, which is available in CAS genesisWorld Web with Project. 

 8.3.1 Licensing (page 181) 

 8.3.2 General (page 181) 

 8.3.3 Options (page 182) 

 8.3.4 Interactions (page 183) 

8.3.1 Licensing 

When Report, Project or Helpdesk is licensed, the Timeline view is available in the Web 

Client (for Project and Helpdesk, activation in the Mangement Console isn’t required). 

8.3.2 General 

The Timeline view displays the chronological order of data records with a start and finish. 

 

With either of the associated licenses, you may open the view out of saved list views for 

any type of data records with a start and finish. 

Other than the standard data records type with a start and finish in CAS genesisWorld, the 

view will display any data record type with date fields named START_DT and END_DT. 

 To open a Timeline view for the data records displayed in a saved list view, click on the 

three horizontal bar at the top left to open the view menu and select Timeline view. 
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Notes 

This feature is only available for saved list views listed under Views in the associated 

app. It isn't available for combined list views, list views with a link filter or list views that 

are currently filtered via the Search... field. 

The opened view always includes all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

All settings will be restored when next opening the view. Configurations are saved per 

list view and user, such that other users can’t overwrite your view settings. 

 

8.3.3 Options 

In the Timeline view, you have the following options. 

 Interval: Days, Weeks or Months. 

 Start date: Today, selection in the calendar or via the time bar below the view. 

 Settings 

 Visibility of weekends (Visible/Not visible). 

 Working hours to be displayed (start and finish for each day). 

 Number of columns in day, week and month view. 

 Use field for the grouping. 

 Use field for the color classification and select colors for field values. 
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8.3.4 Interactions 

The Timeline view supports the following interactions. 

 Open data record via left-click on a bar. 

 Change start and/or finish via drag-and-drop. 

 Create data records with the plus button or by selecting a period with the mouse 

while holding the left mouse button. Not supported for all data record types. 
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8.4 Board view in the Web Client 

The following sections briefly outline the availability, visualization and features of the 

Board view, which is available in CAS genesisWorld Web with Project. 

 8.4.1 Licensing (page 184) 

 8.4.2General (page 184) 

 8.4.3 Settings (page 185) 

 8.4.4 Interactions (page 186) 

8.4.1 Licensing 

When Report, Project or Helpdesk is licensed, the Board view is available in the Web 

Client (for Project and Helpdesk, activation in the Mangement Console isn’t required). 

8.4.2 General 

The Board view displays the grouping of data records by input help items of a field.  

 

With either of the associated licenses, you may open the view out of saved list views for 

data records that have at least one field with input help items. 

The view is available for both standard and custom data record types. 

 To open a Board view for the data records displayed in a saved list view, click on the 

three horizontal bar at the top left to open the view menu and select Board view. 
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Notes 

This feature is only available for saved list views listed under Views in the associated 

app. It isn't available for combined list views, list views with a link filter or list views that 

are currently filtered via the Search... field. 

The opened view always includes all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

Only assignments of field values that are available as input help items will be displayed. 

Data records with field values which are not or no longer available as input help items 

will be displayed as Not assigned. 

All settings will be restored when next opening the view. Configurations are saved per 

list view and user, such that other users can’t overwrite your view settings. 

 

8.4.3 Settings 

The following Settings are available for the Board view. 

 Use the following field for grouping: Select here the field whose values will be 

displayed as columns for grouping the data records. 

 Use the following type for grouping by Status: If you select the Status field for 

grouping and the status depends on the type, status assignments will only be 

displayed for a specific type, which you select here in this case. 

Items with other values in the Type field will not be displayed in this case. 

 Display the following column values of the grouping: Display or hide columns for 

specific field values here. 
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 Use the following field for the sorting: Select here the sorting field for records within 

a column. In addition to fields of the displayed data record type, you may sort by the 

first or second row as defined for that data record type in the App Designer with the 1. 

row and 2. row items. 

Sorting by the second row is always supported regardless of whether it is actually 

displayed in the board view (see Also display the following field on the card). 

 Use the following field for the sum row: Select the number of cards or a field to 

display as sum in the header row here. 

 Offer currency fields in the base currency: When you select a currency field for the 

sum row (e.g., Total for opportunities), this option will be available for converting data 

records with foreign currencies to your base currency and summing up column totals. 

This requires entering conversion rates from the base currency to the currencies of all 

displayed data records in the Miscellaneous area of the Management Console under 

Currencies (see "9.2.1 Currencies" on page 189). 

Note 

This feature isn't supported for fields of the money data type. 

Such fields will always be displayed in the base currency. 

 

 Also display the following field on the card: The first row on each card can't be 

configured and is defined by the associated App Designer setting for the displayed 

data record type. For the second row, you may select between the App Designer 

configuration (default setting 2. row) and fields of the data record type. 

 Use the following field for the color classification: Select a color classification field 

here. This can be the grouping field or another field with input help items. Once you 

have selected a field, you can also select colors for individual field values. 

 Use the following field for the user picture: Select a user field here to display the 

associated picture on each card. 

8.4.4 Interactions 

The Board view supports the following interactions. 

 Open radial menu by right-clicking on a card. 

 Change field value (group) by dragging a card to another column and dropping it. 

 Create data records by clicking on the plus button. 
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9 Management Console settings 

The following sections describe the Management Console settings for the Project module.  

 9.1 Settings in the Easy Invoice area (page 187) 

 9.2 Settings in the Miscellaneous area (page 189) 

 9.3 Settings in the Project area (page 194) 

 9.4 Settings in the Time record area (page 210) 

 9.5 Settings in the User Management area (page 218) 

9.1 Settings in the Easy Invoice area 

Enter the following settings in the Easy Invoice area for orders (see "2.3.4 Assigning 

orders (with Easy Invoice)" on page 27) and vendor credit notes (see "7.8.8 Creating 

vendor credits (with Easy Invoice)" on page 159). 

 9.1.1 Receipt types for orders (page 187) 

 9.1.2 Vendor credit settings (page 188) 

9.1.1 Receipt types for orders 

Create one or more receipt types for orders. 

 Create the receipt types under General in the Overview of receipt types. 

 

 Select 0 as Statistic factor to enable the Receipt type is order option. 

 The receipt types will be available in the Desktop Client after assigning a number range 

to them under Number assignment. 
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9.1.2 Vendor credit settings 

Enter the following settings to create vendor credits. 

 In the Easy Invoice area of the Management Console under General > Overview of 

receipt types, you can create one or more receipt types for vendor credits: 

 

 Select -1 as Statistic factor to enable the Receipt type is a vendor credit option. 

 A separate print template is available for vendor credits. 

 Select one product each for time records and expenses in the lower section under 

Product default values for vendor credits (preparation for billing): 

 

 The feature for creating vendor credits will be available in the Desktop Client after 

assigning a number range to the receipt type under Number assignment. 
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9.2 Settings in the Miscellaneous area 

The following sections describe the Project module settings in the Micellaneous area: 

 9.2.1 Currencies (page 189) 

 9.2.2 Dashboards (page 190) 

 9.2.3 Documents (page 191) 

 9.2.4 Products (page 192) 

9.2.1 Currencies 

You may enter currencies in the Miscellaneous area, under Currencies.  

All list items will be available for selection in all currency fields in CAS genesisWorld. 

You also determine the system's Base currency here. 

This is the presetting for currency fields in CAS genesisWorld. 

To convert foreign currencies to the base currency in reports, in formula fields and in 

board views in CAS genesisWorld Web, enter conversion rates here. 

Enter the conversion rate from the base currency to any foreign currency to convert as 

Exchange ratio Euro to Currency, regardless of which currency you are using as base 

currency. For example, if you are using GBP as base currency and wish to convert CHF, edit 

CHF and enter the conversion rate for GBP to CHF (e.g., if 1 GBP = 1.2 CHF, enter 1.2). 

For the base currency itself, enter 1 as Exchange ratio Euro to Currency. 

 

Please consider the following regarding the Maintain different prices for products 

option under Miscellaneous > Products: 

 With this option, you can no longer change the Base currency. 

 With this option, you can assign a Default currency other than the base currency to 

individual users (see "9.5 Settings in the User Management area" on page 218).  
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9.2.2 Dashboards 

Use customer dashboard reports to process and clarify information from data records. 

You can find the associated configuration in the Miscellaneous area of the Management 

Console, under Dashboards > Customer dashboard. 

In the Definition tab, you create customer dashboard definitions. 

In the Assignment tab, you assign your definitions to the desired data record windows.  

 

For details about the possibilities and configuration of customer dashboards, see the 

Report module user guide. 
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9.2.3 Documents 

In the Miscellaneous area of the Management Console, under Documents, you enter 

settings for field variables available in Microsoft Word. 

 

 Document validity: When editing a document in Microsoft Word, the validity period 

entered here, added to the current date, yields the due date available as a field variable 

in the Microsoft Word add-in under Opportunity fields > Document validity. The due 

date will be postponed if it coincides with one of the days defined as exceptions. 

 Transfer offer items [...]: Select the document types for which project items should be 

available in Microsoft Word here (see "2.4 Creating documents for items" on page 33). 



Project   Management Console settings 

192 

9.2.4 Products 

In the Miscellaneous area, under Products, you enter settings for products, project item 

and projects. 

 

The following settings on this page relate to Project features: 

 Products for opportunities, items, product uses and tickets: Here you can see and 

change the product filter for opportunity product items, project items, receipt items 

(with Easy Invoice) as well as product uses and tickets (with Helpdesk). 

With the default filter, all products selected as Active will be available. 

 Maintain different prices for products: By default, you may only enter exactly one 

sales and purchase price in exactly one currency for each product. Here you activate or 

deactivate the entry of sales and purchase prices for products in different currencies. 

The price information you enter for a product and currency will automatically be 

adopted to opportunity, project and receipt items (with Easy Invoice) in which you 

select that product and currency.  

With this setting, you may also select a default currency for each user which will be 

used instead of the base currency (see "9.5 Settings in the User Management area" on 

page 218). 
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 Use alternative product description: Here you activate or deactivate the entry of 

alternative descriptions and quantity units for products. 

Each list item represents an additional description and quantity unit. Additionally, the 

Standard item (default description and quantity unit) is always available.  

When editing an opportunity, project or receipt item (with Easy Invoice), if you select a 

product for which alternative descriptions and quantity units have been entered, they 

will be available for selection in the item.  

With this setting, you may also select a default description and for each user (see "9.5 

Settings in the User Management area" on page 218). 

 Change set currency of the item at a later time: Here you determine whether the 

currency of an existing opportunity, project or receipt (with Easy Invoice) can be 

changed via the Tools menu. When changing the currency, you may retain prices, set 

the to zero or enter a conversion rate.  

 Product item groups: Here you can enter input helps for product item group names in 

all client languages. 

Whenever a user creates a product item group for an opportunity or for a receipt (with 

Easy Invoice), any group names entered here will be available for selection.  
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9.3 Settings in the Project area 

The following sections describe the settings in the Project area. 

 9.3.1 General (page 194) 

 9.3.2 Orders (page 197) 

 9.3.3 Expenses (page 200) 

 9.3.4 Resource planning (page 204) 

 9.3.5 Skills (page 208) 

9.3.1 General 

 Settings (page 194) 

 Price lists and Discount Lists (page 195) 

Settings 

 

 Job type for Milestones: Here you select the job type for milestones. 
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Price lists and Discount Lists 

In the Price lists and Discount lists tabs, you define price lists and discount lists. You 

assign them to customers in the Details tab of the data record window for addresses. 

 

 Price lists: In a price list, you enter reduced prices for certain products. The prices may 

be scaled by minimum amount. In a price list there may therefore be multiple prices 

with different minimum amounts for the same product. 

 Discount lists: In a discount list, you specify discount proportions for certain products. 

Like prices discounts may be scaled by minimum amount. 

 Create new price list or discount list: Create a new price list or discount list. Once you 

have named the list it will be selected and displayed. 

 Delete price list or discount list: Delete the price or discount list selected in the menu. 

 Create new price or discount: Create a new price or discount in the selected list. 
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For the price, you specify a product, minimum amount, price and currency. 

 

For the discount, you specify a product, minimum amount and discount in percent. 

  

Note 

Only products matching the associated filter will be found. 

By default, these are all products for which the Active option has been selected in the 

General tab. You can change the associated filter condition in the Management Console 

under Miscellaneous > Products (see "9.2.4 Products" on page 192). 
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9.3.2 Orders 

 Items for jobs (page 197) 

 Items for appointments (page 198) 

Items for jobs 

Here you configure the creation of jobs for items (see "Create" on page 23). 

 

You may assign multiple products to each job type and a different unit to each product. 

 The New creation setting determines whether jobs created for an item adopt its date 

as end or start date. The job's duration and time budget of associated resource plans 

both depend on the Quantity specified in the item and the Unit entered here for the 

associated product. With Hours, jobs will last one full day per started person day. 

 With the Add number to subject option, when a job is created for an item, the item's 

number is transferred along with its description to the job's subject. 

 Enter products: Here you select products in the Search window to assign them to the 

type. When you click Link & Close, all selected products will be entered, potentially 

overwriting the previous selection. Then select the Unit for the associated jobs and 

resource plans, Days or Hours. 

 Insert product row: Here you insert an empty product row. 

 Open product: Here you open the product's data record window. 

 Delete assignment: Here you remove the product assignment in this row. 
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Items for appointments 

Here you configure the creation of appointments for items (see "Create" on page 23). 

 

You may assign exactly one product to each appointment type. 

 Enter product: Here you assign a product to the type in the Search window 

Then select the Unit for the duration of associated appointments, Days or Hours. 

 Open product: Here you open the product's data record window. 

 Delete assignment: Here you remove the product assignment in this row. 

 With the Automatically create an item when saving [...] option, when an 

appointment of a type to which a product has been assigned here is saved, an item for 

the product will automatically be created in the appointment's primary project. 

If an appointment has no primary project or an item has already been assigned to it, it 

will not be affected by this setting. 

 If the On deleting objects delete linked item option is selected, the item associated 

with an appointment will be deleted automatically when you delete the appointment. 

 Under Refresh item automatically, you select fields and links of appointments that 

should automatically be updated in associated items. When an appointment is saved, 

you are first asked to confirm the transfer of the changes to the item. 

 With the Refresh date option, an item's date is updated when its associated 

appointment's start or end date is changed. 
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 With the Refresh duration option, an item's quantity of billable hours or days is 

updated when its associated appointment's duration is changed. 

 With the Refresh measurement option, an item's quantity unit is updated when a 

type with another quantity unit is selected in its associated appointment. 

 With the Refresh description option, an item's description is updated when its 

associated appointment's subject is changed. With the Add participants to the 

description of the item setting, the description is also updated when the 

appointment's participants change. 

 With the Refresh project link option, an item will be removed from its former 

primary project and entered in the new one when its associated appointment's 

primary project is changed. 

 With the Refresh product link option, an item's product link is updated when a 

type with another product is selected in its associated appointment. 

 The New creation setting determines whether, when an appointment is created for an 

item, the item's date will be adopted as the new appointment's start or end date. The 

appointment's duration depends on the Quantity specified in the item and the Unit 

entered here for the associated product. 

 With the Add number to subject option, when an appointment is created for an item 

in the Order tab of the data record window for projects, each item's number is 

transferred along with its description to the associated appointment's subject. 

 With the Add participants to the description of the item option, when items are 

manually or automatically created for an appointment, the appointment's participants 

are transferred to the description of the associated item. 
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9.3.3 Expenses 

 General (page 200) 

 License plate number (page 203) 

General 

 

 Select expenses types: Here you can see and change the types for per diem costs, 

lump sums and travel costs. When one of these types is selected in the data record 

window for expenses, that window displays the fields and features for the selected type. 

When another type is selected, the data record window for expenses displays the fields 

and features for expense receipts. 

 Costs per km (travel costs): Here you can see and change the presettings for the 

internal and external kilometer prices for travel cost billing. 

 Settings for per diem costs: Here you determine whether you wish to enter per diem 

costs manually or have them calculated automatically.  

Please note that the default automatic calculation without formulas only applies to the 

German rules and regulations. 

For per diem costs valid in other countries, we suggest you calculate them via formulas 

(Preallocate per diem costs, requires the Form Designer module) or enter them 

manually (Always manually enter per diem costs option). 

 Preallocate per diem costs (requires the Form Designer module): Per diem costs 

will be calculated via formulas. This enables the Subsistence allowance, Net costs 
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and Turnover fields as targets for formula fields in the Form Designer area of the 

Management Console. For per diem costs, each of these fields will then be read-only 

and will default to zero if you don't enter a formula for it. 

Please note that formulas for these fields will be valid for all expense types unless 

you restrict them to per diem costs using an IF junction. With NoChange in the 

ELSE branch, the default behavior applies for the other types. 

 

 Always manually enter per diem costs: Per diem costs won't be calculated 

automatically. The Overnight stay, Subsistence allowance, Net costs and 

Turnover fields may be edited manually. 

 Permit calculation per data record: Per diem costs will initally be calculated 

automatically based on the rules and rates valid in Germany. With the Calculate 

manually option selected in the associated data record window, you may edit the 

Overnight stay, Subsistence allowance, Net costs and Turnover fields manually. 

 Always automatically calculate per diem costs: Per diem costs will always be 

calculated automatically based on the rules and rates valid in Germany. They can't 

be edited manually. 

 Country settings for per diem costs: Specify here the default setting for the Country 

field in per diem costs (Default country for New). Additionally, you can view and 

modify here the rates for per diem costs by country or region. You may also specify 

different deduction rates for the breakfast here (20%) as well as for the lunch and 

dinner (40% each). The values follow the rates provided by the German legislator (see 

"Notes on the automatic calculation of per diem costs" on page 115). 

 In the default setting, the current expense rates are displayed here. Select the 

desired Year to edit earlier expense rates. 

 Select a Country or region to display and edit the associated values. 

 Add countries and regions via the input help for the Country field of expenses in the 

Database area. Countries must be spelled as entered in the input help for the 
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Country field of addresses. To update regions, the input help for the Country field 

of expenses must be international and provide German translations for all regions to 

update, spelled like in the xml file under Expenses in the client directory. New 

countries and regions will be created without initial expense rates. 

 Set the daily rates for all countries to default values: Select Germany under 

Default country for New and click on the button with the green arrow next to Year 

in order to enter the expense rates for the selected year for all countries and regions 

available as input helps for the Country expense field. 

The expense rates are taken from the associated xml file for the current year which 

must exist under Expenses in the client directory or it must already be available 

online and the application server must have an internet connection. 

After the update, you will receive a report about how many countries and regions 

were updated and, if applicable, which countries and regions could not be updated. 

 Add new year: Here you create expense rates for a new year. 

Expense rates will be added for all countries and regions available in the input help 

for the Country expense field. To update regions, the input assisstance for this field 

must be international and a German translation must be provided for each region 

that should be updated with the same spelling as used in the xml file under 

Expenses in the client directory. 

This file is updated with the current expense rates and supplied with the CAS 

genesisWorld client installation with the next software update as soon as new rates 

have been published by the legislator. The xml file with the current expense rates will 

also be made available online and can be accessed via the Management Console. To 

do this, the application server requires an internet connection. 

When clicking on the Add new year button, current expense rates will first be 

looked for under Expenses in the client directory. 

Use lump sum from file: If the current rates are already supplied as a client file, you 

can apply them here. 

Search online for current values: Here you check whether expense rates for the 

selected year are available online. In this case, you may apply them. 

Use lump sum from previous year: Here you copy the rates of the previous year 

for the selected year. 

Create without lump sum: Here you create zero rates for the selected year. 

When applying expense rates from an xml file or via the internet, you will receive a 

report about how many countries and regions were updated and, if applicable, 

which countries and regions could not be updated. 
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License plate number 

 

Here you assign vehicle license plate numbers to users or reset the assignment by 

selecting the empty option. 

When a user associated with a vehicle license number creates a new travel cost record, the 

license number selected here will be written in the Vehicle field of the data record window 

for expenses. 

You must first store the desired license numbers as input helps for the expenses field 

Vehicle in the Database area. 

Then associate the license plate numbers with the desired users here. 
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9.3.4 Resource planning 

 General (page 204) 

 Booking of time recordings (page 206) 

General 

 

 Resource planning jobs are marked as complete for status: Select here one or more 

status options to mark a resource planning job as complete, settting the completion 

grade to 100% and the remaining ETC in all associated resource plans to null. 

 Externally bill remaining time budget when completing a job: Here you specify 

whether remaining time budget will automatically be added to the Charged field in the 

last time record for the resource plan when completing a job. 

 Keep job participants synchronous with associated resources: With this setting, 

when a job with resource plans is saved, the job's participants will be overwritten with 

the resource plans' participants. 

 Distribution of working times: With the optional database update for version x11.1.7, 

in addition to the automatic distribution, a manual planning mode is now also available. 

In x12 and more recent versions, this feature is always available without an additional 

database update. Databases created with version x11.1.7 or a more recent version use 

the manual distribution by default. For existing customers, the automatic distribution is 

selected by default, such that nothing changes. 
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The manual mode is available in the Resource planning app in the Web Client after 

activating it in the Management Console and restarting the Application Server. 

The manual mode initially uses the same automatic distribution for workloads of new 

resource plans as the automatic mode. The manual planning is activated by entering 

values in the Resource planning app in the Web Client. 

Section „5.4 Resource planning basics“ on page 57 describes differences between the 

automatic and manual planning. 

Section „5.6 Resource planning in the Web Client“ on page 71 describes the manual 

planning in the Web Client. 

With the manual mode, the resource planning feature in the Desktop Client’s tree view 

(displaying and editing of ETC) is no longer available. 

Please note that switching to the automatic mode will delete any detailled planning you 

have already entered. The ETC total of each resource plan will still be retained.  

 Color marking of workload: In the automatic mode, you define here a lower limit and 

two upper limits for employees' workloads. They will be highlighted in the tree view 

and in the interactive planner view. 

The following ranges of values are admissible: 

 Lower workload limit: 0% – 100% 

 1st upper workload limit: 50% – 200% 

 2nd upper workload limit: 100% – 300% 
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Booking of time recordings 

 

 Time recording to job with resource plan 

 Time recording mask: The Display status and completion grade of the job and 

booking data of the resource plan in time record mask option controls whether 

data from the associated job and the resource plan will be displayed when time is 

recorded for a resource plan. 

 Overbooking of resource plan: Here you specify if and to what extent the 

overbooking of resource plans is permissible without requiring additional ETC to be 

cleared (see "The Overbooking check" on page 93). 

By default, the overbooking check is active with the overbooking degree set to 0%, 

not permitting overbooking. Enter a value above zero to allow limited overbooking. 

Select the Always permit overbooking option to disable the overbooking check. 

The overbooking degree specifies by how many percent of the Time budget a 

resource plan's Actual value may exceed the Time budget due to a time record in 

order to save that time record (e.g., time budget 4 hours, permissible overbooking 

50% => time records relevant for accounting are possible as long as the resource 

plan's Actual value doesn't exceed 150% of the Time budget, i.e., 6 hours).  

Regardless of the Actual and Time budget values in a resource plan, it is always 

possible to record at least the cleared remaining working time ETC for it. 
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 Display fields for ETC and comment in the time record and in the resource plan: 

When the overbooking check is active, you specify here whether employees may 

enter an estimate that differs from the ETC value and a reason for the deviation 

when recording time for a resource plan or in the resource plan itself. 

With the other right Resource planning, the employee's superior can adopt the 

estimate as the resource plan's ETC in the resource plan or in the Resources and 

items tab of the associated job. When he or she does, the ETC field's previous value 

will be overwritten. 

When the overbooking check is active and a resource plan is overbooked, the 

Actual value of any additional time records for this resource plan may not exceed 

the resource plan's ETC value. To raise the ETC value in a resource plan, clearing 

additional working time, the other right Resource planning is always required, even 

if the estimate has been deactivated. 

 Booking settings for all time recording types: Here you configure time recording for 

resource plans. You specify for each time record type whether time records of this type 

will be booked on resource plans. 

 Neutral for accounting: Time records that are neutral to accounting will not be 

considered in resource plans. This is the default setting for all time record types. 

 Relevant for accounting: Time records that are relevant for accounting will be 

considered in resource plans.  

 Only for resource planning: Time record types with this setting can only be created 

for jobs with a resource plan. 

They are also relevant for accounting and will be considered in resource plans.  

 Bill working time externally (automatically adopt Charged as Actual if Time 

budget remaing exists): Select this setting if the Actual value in a time record of 

this type should automatically be transferred to the time record's Charged field. 
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9.3.5 Skills 

Here you specify skills which will be available for selection in the Skills tab when editing 

employees' addresses. By categorizing them in sections and sub-sections you organize 

skills in a tree structure. 

If you are also working with CAS teamWorks, the skills defined there will be adopted and 

may be edited synchronously in CAS genesisWorld. 

 

 Define rating: By entering in the text window at the top you may name the options for 

rating the skills. 

In the default setting, little, good and very good are distinguished. 

Each row represents one level. You may distinguish as many levels as you wish. 

When skills are assigned to employees, a star is displayed for every level. Nine stars are 

displayed at most. Higher levels may be distinguished in the menu for selecting the 

desired level. 



Project   Management Console settings 

209 

 Enter sections: Select the Skills node to create a new section at root level or select 

another section to insert a sub-section there. 

 Click New to open the Create template window. 

 Enter the desired description. 

 Insert the section by clicking on Next or OK. 

 Click Next to select the new section. The Create template window will stay open to 

create more sections or a new skill. 

 Click OK to close the Create template window. 

 Click Previous to select the superordinate section. 

 Enter skills: Select the Skills node to insert a new skill at root level or select a section 

or sub-section. 

 Click New to open the Create template window. 

 Enter the desired description. 

 Insert the skill by clicking on OK. 

 Click Previous to select the superordinate section. 

 Rename section or skill: Select the section or skill to rename and click Edit or double-

click on the selected entry. 

 Delete section or skill: Select the section or skill to delete and click Delete. You will be 

prompted to confirm the deletion. 

When you delete a section, all sub-sections and skills it contains will also be deleted. 

When you delete a skill, all assignments of the skill to employees will also be deleted. 
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9.4 Settings in the Time record area 

The following sections describe the settings in the Time record area: 

 9.4.1 General (page 210) 

 9.4.2 Mandatory links (page 212) 

 9.4.3 Calendar (page 213) 

 9.4.4 Hourly rates (page 214) 

 9.4.5 Working hours (page 216) 

9.4.1 General 

 

 Duration of a person day: Here you specify how many hours and minutes should be 

subsumed under one person day. The default setting is 8 hours. 

 Granularity: Here you select the smallest recordable interval for the Actual and 

Charged fields. No smaller interval may be selected for Charged than for Actual. 

 1 second, 1 minute, 5 minutes, 10 minutes, 15 minutes, 30 minutes, 1 hour 

 Overlap check: Here you enable or disable the overlap check for time records. 

 Bill externally: Here you specify whether users may edit the external billing date. In 

this case, users are prompted to enter the desired billing date when externally billing 

time records via the context menu of the time record list. 

 Time window for the creation and editing of time records 

 Maximum to be recorded for future: Time records whose end time is further in 

the future than specified here may not be saved. 

 Maximum to be recorded for past: If the start of a time record to create is further 

in the past than specified here, it may not be saved. 
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 Change time records of the past: If the start of an existing time record is further in 

the past than specified here, changes made to it may not be saved. 

 No restriction for: Select here users to exempt from the specified restrictions. 

 Calculate total: Here you specify whether the total work time for a project, job or 

service agreement is calculated whenever time is recorded for it. Time records for 

associated tickets are considered for service agreements. The actual work time will be 

written in the Actual time field. The order value will be written in the Charged field. 

Note 

The fields are updated whenever time records for projects, jobs or tickets belonging to a 

service agreement are created or deleted. The fields are not updated when the link for 

an associated data record is changed (e.g., when a ticket is removed from a service 

agreement by resetting the service agreement selection in the ticket). 

With the Form Designer module, you can define business ratio fields that are updated 

automatically whenever the associated data record is opened. 

Additionally, you can create new project, job and/or service agreement fields of the float 

type as target fields in the Database area of the Management Console and enter them 

as target fields for the business ratio fields. If you do, you can use scheduled updates to 

update these fields regularly automatically (e.g., nightly or hourly) or update them 

manually via the context menu (requires the Actions: execute other right). 

Create the following business ratio fields for projects and/or jobs respectively: 

1. Linked data record type: Time records / Calculation: Actual / Sum 

2. Linked data record type: Time records / Calculation: Charged / Sum 

To save the results in target fields you have created for projects and/or jobs, select them 

under Save result in field for the respective business ratio fields. 

Under Data records, select the Only primary links link type. 

Under Formatting, select the Duration (person days) or Duration (24h/day) format. 

For service agreements, you need a two level business ratio field. First, create Actual/ 

Target business ratio fields with associated target fiels of the float type for jobs as 

described above. Then, create the following business ratio fields for service agreements: 

1. Linked data record type: Jobs / Calculation: (Actual target field) / Sum 

2. Linked data record type: Jobs / Calculation: (Charged target field) / Sum 

Then, enter the same settings as described above for projects and jobs (Save result in 

field, link type and format). 

 

 Time record type for travel time: Select here the time record type for recording the 

trips to and from the destination for appointments in CAS genesisWorld Web and CAS 

genesisWorld Desktop. 
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9.4.2 Mandatory links 

Here you define mandatory links for time record types. 

 

 Mandatory link: Select here the desired data record type. 

 Specify filter condition: Click on the filter icon to specify filter conditions. 

 Participant: If you select the P option, the time record's participant must also be a 

participant of the linked data record to save the time record. 

Groups are not resolved here. Only if a user has directly been entered as the 

participant of a data record, he or she can record time for it. 

 Information: Enter here a message to display when a user tries saving a time record 

which is not linked as specified here. 

Here you enter the message in different languages. 
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9.4.3 Calendar 

Here you configure the time record calendar's multiple recording feature. 

 

 Automatic time recording for appointments, phone calls and holiday: Here you 

select appointment, holiday and phone call types for which time should automatically 

be recorded when clicking on the associated button in the calendar. With teamWorks, 

holidays are distinguished by the Holiday type field, if there are no types for holidays. 

To lock the recording of certain types or holiday types, select the data record type for 

which you wish to modify the setting. Then carry over the entries for which time should 

not automatically be recorded to the right list. 

 Time record type and projects by participant […]: Select here projects in which 

leaves taken by their respective participants will be recorded. When a participant of a 

project selected here records a leave in the calendar, the time records will be booked 

on the project. 

 Search project: Here you select a project in the Search window. Via the list you may 

open, view and edit it. 

 Remove: Here you remove a project from the selection. 

 Time record type for holiday: Specify the type for holiday records here. 



Project   Management Console settings 

214 

9.4.4 Hourly rates 

Here you specify global hourly rates. They are valid for all customers and projects for 

which you do not specify different hourly rates. 

Entering different hourly rates for specific customers and projects is described in section 

"7.1.6 Defining hourly rates for addresses and projects" on page 103. 

 

 Allow to enter internal hourly rates for addresses and projects: By default, you may 

only enter different external hourly rates for addresses and projects. Select this option 

in order to also enter different internal hourly rates for addresses and projects. 

 Save: Here you save changes made to the hourly rates in the database. 

Close the view without saving to revert changes. 

 Transfer hourly rates: Here you overwrite the displayed hourly rates, Internal or 

External (see below), with the hourly rates from the other view. This includes emptying 

fields that are empty in the other view. 

 After confirmation, the changes will be displayed in the view. 

 The changes will only be applied to the database when they are saved. 

 Close the view without saving to revert changes. 

 Select participants: Here you select the users and resources to display. Users and 

resources for which internal or external hourly rates have already been entered will 

automatically be selected when you open the view. When a user or resource is 

removed, associated hourly rates will be retained. 

  Internal and External: The Internal and External tabs are structured identically. 

 Internal: Here you specify internal hourly rates. Billing a time record internally will 

determine the internal hourly rate for the user/resource and activity (time record 

type) and multiply it with the Actual work time to calculate the Actual costs. 
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 External: Here you specify external hourly rates. Billing a time record externally will 

determine the external hourly rate for the user/resource and activity (time record 

type) and multiply it with the Charged order value to calculate the Actual turnover. 

 Entering hourly rates: The white table fields are provided for entering hourly rates 

valid for exactly one user or resource and one activity (time record type). The yellow 

fields are provided for entering hourly rates valid for users, resources and activities for 

which no other hourly rate was specified. 

 General hourly rate: Enter the general hourly rate in the first field of the table in the 

top left corner. It will be valid for all table fields and thereby for all users, resources 

and activities (time record types) for which no other hourly rate is specified. 

The general hourly rate will show up in all of these fields in italics. 

 Hourly rates for users and resources: Enter hourly rates for users and resources in 

the first column. Each of these will be valid for all table fields of the associated row 

and thereby for all activities (time record types) for which no other hourly rate is 

specified. 

The hourly rate will show up in all of these fields in italics.  

Internal hourly rates for users and resources take precedence over internal hourly 

rates for activities (time record types). 

External hourly rates for users and resources are only valid for activities (time record 

types) for which no other hourly rate was specified. 

 Hourly rates for activities (time record types): Enter hourly rates for activities 

(time record types) in the first row. Each of these hourly rates is valid for all table 

fields of the associated column and thereby for all users and resources for which you 

have not specified another hourly rate. The hourly rate for the type will show up in 

all of these fields in italics. 

The hourly rate will show up in all of these fields in italics.  

Internal hourly rates for activities (time record types) are only valid for users and 

resources for which no other hourly rate was specified. 

External hourly rates for activities (time record types) take precedence over external 

hourly rates for users and resources. 

 Hourly rates for a user/resource and activity (time record type): Enter hourly 

rates for specific users or resources and for specific activities (time record types) into 

the respective white table field in which the row for the user or resource and the 

column for the activity (time record type) intersect. 

Such hourly rates in white table fields take precedence over any other hourly rates. 
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9.4.5 Working hours 

Here you record a log of working hours for employees and a log of availability hours for 

resources. 

 

 Views and Features for logged working hours: The following features consider the 

working hours you enter here. For employees for which you do not enter working hours 

here, the working hours you enter in your user settings in the Calendar tab are used 

instead. 

 Planner (interactive): This view displays working hours entered here in its Gantt 

view and in its workload view, and calculates the workload based on them. You must 

enter Resource availability hours here to display them in the view. 

 Time recording: In the time record calendar and in the data record window for time 

records, the working hours you enter here are considered. 

 Resource planning in the tree view: The tree view's resource planning view 

displays working hours entered here and calculates the workload based on them. 

 Report [Report module]: In Report views for time records, for which you have 

activated working hours calculation in the User data tab in the view's properties, the 

working hours you enter here are used. 

Note 

For users and resources for which you enter working hours here, the interactive planner 

view, the time record calendar, the tree view's resource planning view and report views 

will display no working hours before the first working hours period you enter. 

 

 Select user or resource: Select a user or resource in the menu to the top left to view 

the working or availability hours. 
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 Create working hours period: Here you create a new working hours period. You will 

be prompted to enter the desired start date for the new working hours period. The day 

before the start date of the following working hours period will be automatically 

entered as end date. If no working hours period follows, the end date is left blank. Enter 

the working hours in the view's lower half (see "Edit working hours" below). 

 Change start date: Here you change the start date of the selected working hours 

period. Alternatively, you may change the start date by double-clicking on a list entry. 

 Delete working hours period: Here you delete the selected working hours period. You 

will be prompted to confirm the deletion. 

 Edit working hours: In the view's lower half, you enter the desired working or 

availability hours. 

 Granularity: Select the granularity in the menu at the top right of the lower toolbar 

(Hour, Half hour, Quarter hour, 5 minutes or Minute). 

 Working hours: Using your mouse, select the desired working hours in the week 

view and click Working hours to enter them. 

 Free time: To remove working hours you have already entered, select them using 

your mouse and click Free time. 

Please note that working hours entered for public holidays will only be applied when 

the public holiday is on a week day with working hours. For example, if no working 

hours are entered for Sundays, public holidays on a Sunday are also considered free, 

even if working hours have been entered for public holidays. 

The working hours you enter will be transferred directly to the list of working hours 

periods and saved. 

 Save working hours template: Here you save the working hours you have entered in a 

template to transfer them to other users or resources. 

 Select working hours template: In the left menu of the lower toolbar, you may select 

a template to transfer the working hours stored in it to the list entry you have selected 

in the upper list. Changes made to the displayed working hours will be saved in the 

user's working hours as well as in the template. 

 Delete working hours template: Here you delete the selected working hours 

template. You will be prompted to confirm the deletion. Deleting a working hours 

template has no effect on working hours created from that template. 
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9.5 Settings in the User Management area 

If you are working with differing product prices or alternative descriptions for products 

(see "9.2.4 Products" on page 192), you may select defaults for the currency and product 

description for users in the User Management area. 

Double-click a user and select the desired defaults in the General tab: 

 

 Default currency: The selected default currency will automatically be selected in new 

opportunity, project and receipt items (with Easy Invoice) created by this user.  

The setting is available when the Maintain different prices for products option is 

selected in the Miscellaneous area of the Management Console under Products. 

 The system base currency is the default setting for all users. 

 The setting will only be applied to the first item of an opportunity, project or receipt. 

This determines the currency for the data record and all additional associated items. 

 It is not possible to create individual items with a different currency. 

 Product description (Standard): The selected default description will automatically be 

selected in new opportunity, project and receipt items (with Easy Invoice) created by 

this user. 
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The setting is available when the Use alternative product description option is 

selected in the Miscellaneous area of the Management Console under Products.  

 In addition to the product description, the quantity unit will also be entered. 

 The preselection "–" is the default setting for all users and represents the Standard 

item in the selection of the product description and quantity unit 

 The setting will only be applied to the first item of an opportunity, project or receipt. 

This then determines the description and quantity unit for all additional associated 

items. 
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10 Changes in version x5 and newer 

The range of features of the Project module was revised for version x5: 

 Overlaps with opportunities and the associated CAS genesisWorld standard features for 

covering the sales side were cleared up. In order to integrate the transition from the 

quote phase to the order phase, you can now create projects for opportunities. Also, 

handling project items now more closely resembles handling opportunity items. 

 The Analysis view and associated Budget planning is replaced by report views for 

time records, resource plans, expenses and external services, providing a subset of 

features of the Report module requiring no extra license. 

If you've been using Project with its previous range of features, you can switch to the new 

functionality via the Project area of the Management Console. Please note that features 

listed in "10.2 Discontinued features in Project x5" on page 221 will no longer be available 

after switching. If you don't switch, you can keep using the previous functionality.  

New customers can only use the new version. 

10.1 Database changes (also applies to existing customers) 

The following fields will be renamed or created when updating to the current version. 

 Item: New fields will only be displayed in the data record window when using the new 

range of features. However, the fields will always be written when a project item is 

saved with sufficient permissions. They will also be available everywhere else (list, filters, 

Report module, Form Designer module). 

 Product (new field, will adopt the linked product's subject) 

 Product => Product number (only changed in the data record window; the new 

name was already used in the list and in filter conditions) 

 Unit price => Price 

 Quoted price (new field, Price less discount per piece. When you update to CAS 

genesisWorld x5, this field will be calculated and entered for any existing items). 

 Absolute contribution margin => Contribution margin 

 Volume => Sum 

 Project 

 Planned volume => Total 

 Project/Job 

 Locked for time recording => Lock for time recording 
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10.2 Discontinued features in Project x5 

The following features will no longer be available for new customers in version x5 as well 

as for customers switching to the new range of features. 

Fields listed here will stay available in the list as well as the Report and Form Designer 

modules (formula editor) for existing customers even after switching to the new range of 

features. You can still filter by these fields. 

 Discontinued sales features 

 Project > Sales with the Order scheduled for, Deputy (comm.), Customer 

budget, Source, Achieved volume, Probability (%), Weighted volume and CM 

relative total fields, the Planning type (Top down/Bottom up; the Bottom up field 

will now always be set to true for new projects) and Payment deadlines 

(absolute/relative) settings as well as the Decision criteria. 

Note 

Please note that Form Designer modifications of the Sales tab will no longer be visible, 

even in the Form Designer area of the Management Console, once you have switched 

to the new range of features. 

The Sales tab is substituted with the new Order tab. It can be extended with Form 

Designer as the Sales tab previously could. Fields and other controls inserted with Form 

Designer will appear above the item list. 

 

 Item: Probability (%), Weighted volume and Weighted contribution margin 

fields. 

 Analysis of items view (Creation and existing views) 

 Analysis and budget planning 

 Address/Project/Job: Analysis tab 

 Project/Job: Budget planning tab 

 Project details: Time record (cumulated values). The Lock for time recording 

option will stay available in the project details. 

 Project list > context menu: Update calculation option 

 Analysis of time records view (Creation and existing views) 

 Discontinued project fields (previously "Details" and "Analysis"): Budget, 

Completion, Actual costs, Actual turnover, Remain and Nominal 

 Discontinued job fields (previously "Analysis"): Budget, Completion, Actual 

costs, Actual turnover, Remain and Nominal 
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10.3 New features in Project x5 

The following features will additionally be available for new customers in version x5 as well 

as for existing customers switching to the new range of features. 

 New features with opportunity integration 

 Opportunity > Product items: Create project (a new project as well as an item per 

product item of the opportunity will be created.) 

 Project > Order: Replaces the Sales tab. The upper section is dropped. The item list 

is retained with all associated features. 

Form Designer modifications entered for the Sales tab will no longer be visible, even 

in the Form Designer area of the Management Console, once you have switched to 

the new range of features.  

The new Order tab can be extended with Form Designer as the Sales tab previously 

could. Fields and other controls inserted with Form Designer will appear above the 

item list. 

 Item: Was adapted to more closely resemble the opportunities' product items. New 

features here are the storing of the product subject, the Quoted price field which 

includes the discount as well as the currency. All items for a project must share the 

same currency. A mixed currency is not supported. 

 Reports for resource plans, time records, expenses and external services 

 Address: External services, Expenses, Time records 

 Project: Comparison nominal/Actual, External services, Expenses, Time records, 

Resource planning 

 Job: Time records 

 Extension of the reports (selected fields, etc. can be changed. The data record 

types to be analyzed can not be changed.) 

Extended features are available for these reports with the Project license, even without the 

Report license (see "7.7.4 Working with reports" and "7.7.5 Editing reports" on page 141). 

10.4 Discontinued database fields in Project x7 

The Total and Contribution margin database fields are no longer available in version x7 

for new customers and for existing customers switching to the new range of features. 

The fields are no longer displayed in project lists and are no longer available for filter 

conditions as well as in the formula editor of the Form Designer and Report modules. 

The figures are still displayed in the Order tab of a project based on selected project 

items. 
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10.5 New features and fields in Project x11.1.7 

The manual resource planning mode in the Web Client is only available in version x11.1.7 

or a more recent version and requires a database update which is optional in version x11. 

Please note that, if your database was created with a version prior to x11.1.7, you must 

first activate this feature in the Management Console (see „Distribution of working times“ 

in section „9.3.4 Resource planning“ on page 204). 

If your database version is less recent than x11.1.7, you will also need to update your 

database to x11.1.7 or a more recent version first. 

Please remember to make a backup of your database before you do this. 

The update to version x12 includes the update required for manual resource planning (it is 

no longer optional in version x12 and more recent versions). 

Databases created with version x11.1.7 or a more recent version will use the manual 

distribution by default. For existing customers, the automatic distribution is selected by 

default, such that nothing changes. 

 New resource plan fields available with the update (available for resource plans in 

the Desktop Client and Web Client as well as in the Project planning and Resource 

planning Web Client apps) 

 Planned working time: Originally planned working time.  

 Deviating working time: Originally Planned working time minus the current Total 

estimate. Differences are due to time records exceeding values planned for the 

associated week or month or additionally cleared workload (ETC).  

 New features available with the update 

 Manual resource planning in the Web Client (see section „5.6 Resource planning 

in the Web Client“ on page 71) 

 Manual resource planning reports (see Report user guide) 

 Features no longer available after switching to manual planning mode 

 Resource planning in the tree view and associated settings (Desktop Client) 
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